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CHAPTER – I 
 

KNOWING COMPUTER 
 

1.0 Introduction  
A Computer is an electronic device, which is used for a number of applications ranging 

from writing letters to reserve a ticket in a train. A Computer has several components like 
Keyboard, Mouse, Processor, Memory, Monitor and printer etc. Computer requires 
instructions to perform a particular task. A series of instructions is normally known as a 
program. Hardware and Software are the two terms we frequently use with reference to 
Computer. CPU, memory and peripheral devices (input and output devices) are generally 
referred to as Hardware whereas compiler. Interpreter and operating system are examples of 
software. 

 
1.1 Objectives 

In this chapter you will be learn about 
1. Describe the various components of a Computer 
2. Distinguish between Hardware and Software 
3. Describe Applications of Computer 
4. Connect Accessories to Computer 

 
1.2 What is Computer? 

Computer derives its name from the word Compute that means calculation. It can be 
said that Computer is a device used for calculation. Nowadays Computer is not only limited 
to computation, but also used for making phone calls, maintaining databases, listening songs, 
viewing movies etc, so a more formal definition of Computer is required. Computer is an 
electronic device that processes or transforms data into useful information by executing a 
series of predefined instructions. 

 
 

 

      

 

Figure 1- organization of computer 

1.2.1 Basic application of Computer 

Word Processing: 

Word Processing software automatically corrects spelling and grammar mistakes. If 
the content of a document repeats you don’t have to type it each time. You can use the copy 
and paste features. You can printout documents and make several copies. It is easier to read a 
word-processed document than a handwritten one. You can add images to your document. 

 
 

INPUT OUTPUTPROCESSING UNIT 

MEMORY 
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Internet  
It is a network of almost all the computers in the world. You can browse through 

much more information than you could do in a library. That is because computers can store 
enormous amounts of information. You also have very fast and convenient access to 
information. Through E-Mail you can communicate with a person sitting thousands of miles 
away in seconds. There is chat software that enables one to chat with another person on a 
real-time basis. Video conferencing tools are becoming readily available to the common man. 

 
Digital video or audio composition: 

 Audio or video composition and editing have been made much easier by computers. 
It no longer costs thousands of dollars of equipment to compose music or make a film. 
Graphics engineers can use computers to generate short or full-length films or even to create 
three-dimensional models. Anybody owning a computer can now enter the field of media 
production. Special effects in science fiction and action movies are created using computers. 

 
Desktop publishing: 

With desktop publishing, you can create page layouts for entire books on your 
personal computer. 

 
Computers in Medicine: 

 You can diagnose diseases. You can learn the cures. Software is used in magnetic 
resonance imaging to examine the internal organs of the human body. Software is used for 
performing surgery. Computers are used to store patient data. 

 
Mathematical Calculations: 

Thanks to computers, which have computing speeds of over a million calculations per 
second we can perform the biggest of mathematical calculations. 

 
Banks: 

 All financial transactions are done by computer software. They provide security, 
speed and convenience. 

 
Travel: 

One can book air tickets or railway tickets and make hotel reservations online. It 
reduced the time wastage and travel time for everyone. 

 
Telecommunications: 

Software is widely used here. Also all mobile phones have software embedded in 
them for maintaining customer details and also sending message, audio and video through the 
mobile software. Now a day's internet is available in the mobile phone itself. 

 
Defence: 

There is software embedded in almost every weapon. Software is used for controlling 
the flight and targeting in ballistic missiles. Software is used to control access to atomic 
bombs. 

 
E-Learning: 

Instead of a book it is easier to learn from E-learning software. It not only contains 
text also contain image and animation so it is very easy to understand everything. 
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Gambling: 
We can gamble online instead of going to a casino. 
 

Examinations: 
We can give online exams and get instant results. You can check your examination 

results online. 
 

Computers in Business: 
 Shops and supermarkets use software, which calculate the bills. Taxes can be 

calculated and paid online. Accounting is done using computers. One can predict future 
trends of business using artificial intelligence software. Software is used in major stock 
markets. One can do trading online. There are fully automated factories running on software. 

 
Certificates: 

 Different types of certificates can be generated. It is very easy to create and change 
layouts. 

 
ATM machines: 

The computer software authenticates the user and dispenses cash. 
 

Marriage: 
 There are matrimonial sites through which one can search for a suitable groom or 

bride. 
 

News: 
There are many websites through which you can read the latest or old news. 
 

Classmates: 
There are many alumni websites through which you can regain contact with your 

classmates. 
 

Robotics: 
 Robots are controlled by software. 
 

Washing Machines: 
 They operate using software. 
 

Microwave Oven: 
 They are operated by software. 
 

Planning and Scheduling: 
Software can be used to store contact information, generating plans, scheduling 

appointments and deadlines. 
 

Plagiarism: 
Software can examine content for plagiarism. 
 

Greeting Cards: 
 You can send and receive greetings pertaining to different occasions. 
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Sports: 

Software is used for making umpiring decisions. There are simulation software using 
which a sportsperson can practice his skills. Computers are also to identify flaws in 
technique. 

Aeroplanes: 
 Pilots train on software, which simulates flying. 
 

Weather analysis: 
 Supercomputers are used to analyze and predict weather. 
 

1.3 Components of Computer System 
Computer system is made up of a number of components. These are  
1. Input devices 
2. Memory unit  
3. Central processing unit 
4. Output devices 

 
Figure 2 shows different components of Computer system. 

 
1.3.1 Central Processing Unit (CPU)  

The central processing unit (CPU) is where the actual processing takes place. This is 
where the calculations are performed and logical functions are carried out. The CPU retrieves 
its data and instructions from the main memory, processes the data according to the 
instructions and then stores the results back into the main memory or sends the processed 
information to the output subsystem. There are broadly three parts of Central 
Processing Unit. Control Unit controls all the operations in computer. All the 
arithmetic and logic operations are performed in Arithmetic and logic unit 
(ALU). A set of registers is used for temporarily storing data or instructions in 
CPU. It is to be noted that the central processor is controlled by the instructions 
it gets from main memory. The CPU retrieves and executes these instructions 
one by one until it completes a given task. Each instruction tells the CPU what 
to do (add, divide, move, and compare) and also tells it where to find the data to 
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be processed. CPU, memory all other components are connected through buses on 
Motherboard and are housed in a cabinet or system unit. The bus interconnects the different 
parts of the Computer so that information can move from one part of the Computer to 
another. In effects, the bus is a "highway'' over which electrical signals can travel. For 
example when the CPU retrieves an instruction from the main memory the electrical pulses 
representing that instructions are carried over the bus that connects the CPU and main 
memory. There are three different types of Buses used in Computer. These are Address bus, 
Data Bus and Control Bus. 

 
1.3.2 Keyboard, Mouse and VDU 

To solve a problem it is necessary to give data and instructions to the Computer. This 
can be done through input device. The keyboard is an example of an input device that accepts 
data and translates it into electronic signals. Both program (instructions) and data can be 
keyed in through it. In addition, certain commands to software can be given from the 
keyboard. 

The keyboard consists of a set of keys. There is one key switch for each letter, 
number, symbol etc, much like a typewriter. Most common keyboard is called QWERTY 
keyboard as the alphabets in the first row are placed like commonly used typewriters. When a 
key is pressed, the key switch is activated. The keyboard has an electronic circuit to 
determine which key has been pressed. A code is then generated and sent to the computer. 
For example when you press the alphabet A on the keyboard, it is translated into the 
electronic code 0100001, which is sent to the Computer. Similarly, the number 0 is translated 
into the electronic code 00111001. So keyboard is one way to get data into the Computer. 
Detecting which key is pressed and generating the corresponding code is known as encoding. 
ASCII (American Symbolic Code for Information Interchange) is one such commonly used 
code. 

 
Mouse 

Mouse is a pointing device which can be moved on a smooth surface to 
simulate the movement of cursor that is desired on the display screen. Mouse 
could be optical; offering quite and reliable operation, or mechanical which is 
cheaper. User can move the mouse; stop it at a point where the pointer is to be 
located and, with the help of buttons, and make selection of choices. 

The mouse is not an alternative to the keyboard for entering data. Text and numbers 
still have to be keyed in, but selection from menus and drawings are easier with a mouse. 
There are 2 keys, 3 keys and scrolling facilities available in mouse. 

 
VDU 

One need to see which key is pressed, and makes changes in case of any mistakes. 
Whatever one has keyed in gets displayed on the screen of the monitor also known as video 
display unit (VDU). It is also used to show the Information produced by the computer. Most 
display screens of a monitor work under the same principle as a television, using a cathode 
ray tube (CRT). Consequently, the term CRT is often used in place of display screen. 

There are many ways to classify monitors. The most basic are in terms of colour, its 
screen size and the resolution. First two types are very explicit. The resolution of a monitor 
indicates how densely packed the pixel (often expressed in dots per inch) are. In general, the 
more pixels mean the sharper the image. VGA (video graphics array) or SVGA (Super VGA) 
monitors are most frequently used Monitors today. Both these terms generally refer to the 
resolution capabilities of the monitor. Most modern monitor’s can display 1024 by 768 
pixels, the SVGA standard. Some high-end models can display 1280 by 1024, or even 1600 
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by 1200. The older Monitor types were MDA (monochrome display adapter), CGA (colour 
graphics adapter), and EGA (enhanced graphics adapter). These are now outdated and do not 
work with newer versions of Windows operating system, 

 
1.3.3 Other Input Devices 

Data can be fed into a Computer through input devices. Input devices accept data in 
its original format and translate the data into electronic signals the Computer can process. 

 
Pointing Devices 

While working with display based packages, we are mostly pointing to some area in 
the display to select an option and move across on the screen to select subsequent options. 
For such cases pointing devices are very useful. There are several pointing devices, some of 
them are light pen, track balls and joysticks. 

 
 Light Pen 

This is a pen shaped device allowing natural movement on the 
screen. The pen contains the Light receptor and is activated by pressing the 
pen against the display screen. Receptor is the scanning beam, which helps 
in locating the pen's position. Suitable system software is provided to 
initiate necessary action when we locate an area on the display surface with 
the help of the light pen. There are other pointing devices such as track balls and joysticks, 
which are used more for entertainment applications like games. 

 
Voice / Speech Input 

One of the most exciting areas of research is in recognizing human voices / speech so 
that this could form input to computer directly. This approach will eliminate the need for 
keying in data and will facilitate casual users to use the computer very easily. There are 
several problem areas for research since speech recognition system should be able to identify 
who is speaking and what the message is. Voice recognition techniques along with several 
other techniques to convert the voice signals to appropriate words and derive the correct 
meaning of words are required for a commercially viable comprehensive speech recognition 
system. We have found limited success in this area and today devices are available 
commercially to recognize and interpret human voices within limited scope of operation. 

 
Scanners 

Scanners facilitate capturing of the information (an image, text 
document, a drawing or a photograph) and storing them in graphic format for 
displaying back on the graphical screen. Scanner illuminates the page that is 
to be scanned so that optical image transforms into digital format for stored 
in computer. The graphic image scanned can now be seen and processed 
directly by the computer. Scanners come in handheld, feed-in and flat bed 
types and for scanning black and white only or colour. 

 
Source Data Automation 

We can also collect data directly from different sources rather than typing with the 
help of different devices. This is called source data automation. Most recent trends for data 
input are towards source data automation. The equipment used for source data automation 
captures data as a by product of a business activity thereby completely eliminating manual 
input of data. 
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Some examples are: 
1.Magnetic Ink Character Recognition (MICR): These devices are 
generally used by the banking industry to read the account numbers on 
cheques directly and do the necessary processing. 

 
2.Optical Mark Recognition (OMR): These devices can sense marks on 
computer readable papers. Academic and testing institutions to grade aptitude 
tests where candidates mark the correct alternatives on a special sheet of paper 
use this kind of device. The optical mark recognition devices then directly read 
these answers sheets and the information sent to a computer for processing. The 
entrance tests and some of the assignments are being marked by OMR. 
 
3.Optical Bar Code Reader (OBR): These scans a set of vertical bars of               
different widths for specific data and are used to read tags and merchandise in 
stores, medical records, library books, etc. These are available as hand held 
devices. 
 
1.3.4 Other Output Devices 

An output device is a part of the computer system which is used to show results. 
Output devices convert information from the electronic form used by the Computer into a 
form that people can easily work with. Output normally can be produced in two ways; either 
on a display unit or on a paper. Other kinds of output such as speech output, mechanical 
output are also being used in certain applications. Printer receives data from the Computer 
and translates the data into a printed document. The same data could also be displayed on the 
video display unit. The method of output used depends often on whether the user wants the 
output to be permanent and on paper or not. Let us discuss some of the common output 
devices. 
 
Display Devices 

One of the most important peripherals in computer is the display device. Graphic 
display is made up of a series of dots called 'pixels' (picture elements) whose pattern produces 
the image. Each dot on the screen is defined as a separate unit, which can be directly 
addressed. Since each dot can be controlled individually there is much greater flexibility in 
drawing pictures. There are three categories of display screen technology; 
1. Cathode Ray Tube (CRT) 
2. Liquid Crystal Display (LCD) 
3. Projection Displays 
 
CRT Displays 

The CRT (Cathode Ray Tube) monitor receives video signals from 
the computer and displays the video information as dots on the CRT 
screen. The main unit to the CRT monitor is the CRT itself; it is usually 
called a picture tube. The CRT is an evacuated glass tube with a 
fluorescent(phosphor) coating on the inner front surface, called screen. An 
electron gun at one end (neck) emits an electron beam. This beam is 
directed towards the screen. When the beam strikes the screen, the 
phosphor coating on the screen produces Illumination at the spot where the 
electron beam strikes. 
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The electron beam is deflected by an electromagnetic deflection in order to produce 
illumination at various spots on the screen. Horizontal deflection coils deflect the beam in the 
horizontal direction and the vertical deflection coils deflect the beam in the vertical direction. 
The illumination caused on the screen exists for a few milliseconds due to the persistence of 
the phosphor. To create a permanent image on the screen, it is necessary to cause 
illuminations repeatedly. This is done by scanning the CRT screen with the electron beam.  
 
There are two types of CRT displays: 
 
1. Vector CRT displays in which the electron beam is directed only to the places where the 
image is to be created. 
 
2. Raster Scan displays in which the image is projected on to the screen by directing the 
electron beam across each row of picture elements from the top to the bottom of the screen, 
This type of display provides a high dynamic capability since image is continuously refreshed 
and it allows for continual user input and output. It offers full colour display at a relatively 
low cost and is becoming very popular. 
 
Liquid Crystal Displays (LCD) 

First introduced in watches and clocks in 1970s, LCD is now applied 
to display devices of a computer. The major advantage of LCD is the low 
energy consumption. The CRT is replaced by liquid crystal to produce the 
image. These also have colour capability but the image quality is relatively 
poor. First introduced in watched and clocks in1970s, LCD is now applied to 
display devices of a computer. The major advantage of LCD is the low energy consumption. 
The CRT is replaced by liquid crystal to produce the image. These also have colour capability 
but the image quality is relatively poor. 

 
Projection Displays 

A large screen upon which images are projected replaces the 
personal size screen of the previous displays. These are normally used for 
large group presentation. These systems can be connected to computer 
and whatever appears on the computer terminal gets enlarged and 
projected on e large screen. Another popular method is to connect computer to 
an LCD flat screen and to project the LCD image using Overhead Projector. These are 
popularly used for seminars, classrooms, marketing presentations, etc. 

 
Terminals 

Terminal is a combination of Input unit and Output unit like VDU and 
keyboard. Terminals have become very popular interactive input and output 
units. With the help of a terminal data and instructions can directly be sent into 
the computer. Terminals can be classified into two types, namely hard copy 
terminals and soft copy terminals. A hard copy terminal provides a printout 
on paper where a soft copy terminal provides a visual display on screen. A 
soft copy terminal is also known as a CRT (Cathode Ray Tube) terminal. Terminals are also 
classified as dumb terminals or intelligent terminals depending upon provision for any 
intelligence or otherwise as the terminal. Current technology has brought about a low price 
differential between intelligent and dumb terminals. This encourages use of intelligent 
terminals. 
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Printers 
Printer is a very common and popular output device. It accepts text and graphic output 

from a computer and transfers the information to paper, usually to standard size sheet of 
paper. Printed output provides permanent record and is easy to copy and distribute. Familiar, 
computer printed documents include pay slips, Familiar, computer printed documents include 
pay slips, bank statements electricity bills, etc. Different types of printers with different brand 
names are available in the market. They vary in size, speed, sophistication, and cost.  
Generally we divide printers into two categories: impact and non-impact. 

 
Impact Printers 

Impact printers are printers that create characters by striking a print page with a print 
hammer (like in typewriter). The impact printers developed for use with computers work in 
much the same way as typewriters. 

 
1. Dot Matrix Printer 

This is also a character printer. In the dot-matrix printer, an 
arrangement of tiny hammers strikes to produce the desired characters. Each 
hammer prints a small dot on the paper. 
 
2. Line Printer 

It prints a line at a time. In the line printer, raised characters extend the length of the 
drum. There are as many bands of type as there are printing positions.. Each band contains all 
the possible characters. The drum rotates rapidly, and one revolution is required to print each 
line. A fast acting hammer opposite each band strikes the paper against the proper character 
as its passes. Thus, in one rotation, hammers of several positions may “fire” when the A row 
appears, several others may strike to imprint D's, etc. At the end of the rotation, the line has 
been printed. 

 
Non Impact Printers 

As their name implies, non-impact printer employ some process other than hammers 
or similar"percussion type'' mechanisms to form characters on a print page. It uses techniques 
such as ink spray, heat, Xerography or laser to form printed copy, i.e., characters are not 
formed by mechanical impact. Usually, non-impact printers are quieter than impact printer. 
 
1. Inkjet Printer 

It is a non-impact character printer. It fires a fine jet of dots of 
quick drying ink onto the paper to form character or dot graphics by 
using an electrostatic field. When Continuous stream inkjet printers are 
used, droplets of ink are electronically charged after leaving a nozzle.  
The droplets are then guided to the proper position on the paper by 
electrically charged deflection plates.  The print quality is good because 
the character is formed by dozens of tiny dots. 
 
2. Laser Printers 

They are page printers, i.e., print a whole page at a time. Laser 
printers write the desired output image on a copier drum with a light beam 
that operates under computer control. A difference in a electric charge is 
created on those parts of the drum surface exposed to the laser beam. These 
laser-exposed areas attract a toner that attaches itself to the laser generated 
charges on the drum. The toner is then permanently fused on the paper with heat or pressure.  
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1.3.5 Computer Memory 
There are different types of memories, which are used in computer. Primary memory 

has other names as Main memory or Random Access Memory (RAM), CPU uses it to store 
or retrieve data and instructions for processing. Secondary Memory or Auxiliary memory is 
used to store the data and instructions permanently. Hard disk and (floppy disk are the 
example of secondary memory.  Compact Disk Read Only Memory (CD ROM) is also used 
to store the data permanently but St requires CD writer to store data into it. Cache memory is 
used to enhance the performance of Computer system. 

 
Main Memory 

Data and instructions are required to be stored in main memory from where it can be 
retrieved by central processing unit for processing results. Main memory serves as a 
temporary storage area for data and instructions. It is made up of a large number of cells, with 
each cell capable of storing one bit. The cells may be organized as a set of addressable words, 
each word storing a sequence of bits. The time to store and retrieve a word is independent of 
the address of the word. This organization is also called RAM or Random Access Memory. 
The main memory is very fast. Its storage capacity is in megabytes. Nowadays most of the 
Computers have minimum of 128 Mbytes of RAM. All the modern computers are now built 
with semiconductor main memory because of its fast access time, low cost, small physical 
size and low power consumption. RAM is further classified as either dynamic RAM (DRAM) 
or static RAM (SRAM) 

 
The larger capacity chips are normally constructed as dynamic RAM because the 

dynamic RAM requires less number of transistors than the static RAM and hence can be 
packed more densely on a single chip. Thus dynamic RAM can achieve higher storage 
density. DRAM is implemented using capacitors which tend to loose their charge with time 
and need periodic refreshing. So, it needs extra control circuitry. This refreshing process 
slows down memory access speed slightly. SRAM, on the other hand, does not need any such 
refreshing circuitry. Thus a SRAM is faster than a DRAM. DRAM is cheaper than SRAM 
and consumes less power than SRAM. 

 
Secondary Memory 

The programs & data that are required to be used again & again are kept in auxiliary 
or secondary memory. Floppy disk, Hard disk are the examples of it. The present day 
capacity of Hard disk is 300 Giga bytes. Because of its relatively slow speed auxiliary storage 
is used for storing programs and data not immediately needed by the Computer. The 
programs and data are then copied into faster main memory when the Computer is ready to 
process them. Secondary storage devices are online to the processor. They accept data or 
program instructions from the processor, retain them, and then write them back to the 
processor as needed to complete processing tasks. Examples of Secondary memory are 
floppy disk, hard disk, magnetic tapes, charge-coupled devices, magnetic bubble memories, 
optical memories etc. 

 
Floppy Disk 

The floppy disk gets its name from the fact that it is made out of a flexible plastic 
material. The plastic base is coated with an iron-oxide recording 
substance that's similar to the material applied to the plastic ribbon of a 
magnetic tape. Data are recorded as tiny invisible magnetic spots on this 
coating. The disk is loaded and rotated inside its envelope tiny 
electromagnetic heads in the disk reader access the data through the slot 
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in the jacket. A floppy disk is divided into tracks (these are a series of concentre rings on the 
surface of the disk) and each track is further divided into sectors. The number of tracks that a 
disk can hold is measured in tracks per inch (tpi) and it is always mentioned on any floppy 
disk you buy. A diskette is inexpensive and can be erased and reused many times. 

 
Hard Disk 

The disk described so far is the type of disks which can be removed 
from the disk drive and carried from place to place. Some disks however, 
are built into the computer or a special disk drive. These are fixed disks. 
They are used in just the same way as removable disks, but tend to be used 
for storing programs or data which have to be permanently available. Hard 
disks can store anywhere from 20 MB to more than 40GB. Hard disks are also from 10 to 100 
times faster than floppy disk. 
 
Magnetic Tapes 

Magnetic tapes are mounted on reels or a cartridge or a cassette of 
tape to store large volumes or backup data. These are cheaper and since 
these are removable from the drive, they provide unlimited storage 
capacity. Since the recording is like that in a tape recorder used in audio 
systems, information retrieval will be only sequential and not random as 
in the case of a disk. These are not suitable for online retrieval of data, 
since sequential searching will take long time. These are convenient for archival storage for 
backup. 

 
CD-ROM 

The CD-ROM (Compact Disk Read Only Memory) is a direct 
extension of audio CD. CD-ROM players are more rugged and have error-
correction facility. This ensures proper data transfer from CD-ROM to the 
RAM of the computer. CD-ROM is written using a CD writer. Information 
is retrieved from a CD-ROM using a low power laser, which ingenerate in 
an on optical disk drive unit. In CD-ROMs the information is stored evenly 
across the disk in segments of the same size. Therefore, in CD-ROMs data 
stored on a track increases as we go towards outer surface of disk. Thus, 
the CD-ROMs are rotated at variable speeds for the reading process. 

 
Cache Memory 

CPU speed is quite high as compared to the access time of main 
memory. In many situations, the performance of the processor suffers 
because of the low speed of the main memory. This problem is solved by placing small fast 
memory called cache memory between the processor and the main memory whose access 
time is close to the processing speed of the CPU. Cache memory is faster than the main 
memory. The cache memories although are fast yet are very expensive memories and are 
used in only small size. Thus, small cache memories are intended to provide fast speed of 
memory retrieval without sacrificing the size of memory. 

 
Cache memory stores a copy of the instructions and data to be immediately used of 

main memory. The memory reads or writes operation is first checked with cache memory and 
if the desired location data is available in cache memory then used by the CPU directly.  
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1.4 Concept of Hardware and Software 
In this section we shall distinguish between hardware and software used in a 

Computer. There are different types of software and there are several generations. 
 

1.4.1 Hardware 
The electronic circuits and mechanical components of a Computer such as hard disk, 

printers, central processing unit, keyboard, mouse, motherboard and other peripheral devices, 
which ere tangible in nature, or which can be felt, touched are known as hardware. 

 
1.4.2 Software 

Programs namely the list of instructions to be executed by Computer is known as the 
software of the Computer. There are different: types of software depending on the 
requirement of user or Computers. Software fails into two general categories: 
a) System Software 
b) Application Software 
 
1.4.2.1 Application software 

Refers to the programs, which allow the Computer to carry out specific tasks related 
to the users such as payroll processing, inventory control, or word processing. Application 
software may be supplied by the Computer manufacture or software vendors, or may be 
written by programmers. 

 
1.4.2.2 System software 

Controls and coordinates Computer operations, and unifies all of the Computer 
components into a functional and smooth running system. System software also provides the 
Computer users with a means of gaining access to the system and its resources. The task of 
translating instructions into machine code is done by a special set of software called the 
Compiler. Operating system prepares the computer for use and also controls the different 
devices attached to the computer. Operating system & Compilers are the example of system 
software. 
 
1.5 Concept of Computing, Data and Information 
Data: 
 Data is a collection of facts, such as values or measurements. It can be numbers, 
words, measurements, observations or even just descriptions of things in simple words data is 
a raw fact example (28, 52, 65, Kumar, Vijay, Raj) 
 
 Representing Data in the Computer: 

Basic component of Computer like CPU, RAM etc are transistors. These are made of 
a number of Integrated circuits (ICs), which contain transistors. These transistors set like a 
two-way switch which can be either on or off. These transistors have just two operating 
states; either on or off. When a transistor is switched on, it is said to represent the value 1. 
Conversely, when the transistor is switched off, it is said to represent the value 0. The values 
0 and 1 are the only two digits with which Computer works. 

 
Thus all data to be stored and processed in Computers are transformed or represented 

as sequence of two symbols, one symbol to represent each state. The digits 0 and 1 are 
represented inside the computer as electrical voltages. The electrical voltages have just two 
states, or levels, referred to as high and low. Usually the Low voltage represents a value of 0, 
while the high voltage represents a value of 1. 
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Bits and Bytes 
The term Bit is an acronym for Binary digit. The bit is the smallest piece of 

information that the Computer can work with. The values 0 and 1 are called Bits. Bits are 
grouped together to form a larger chunk of information called a Byte. A byte consists of eight 
bits that the Computer stores and processes as a single entry. A byte represents one character 
of data (either a letter of the alphabet, decimal digit, or symbol). The Computer can store 
individual bytes in its memory and later retrieve them. 

 
Representing Data in Computer 
1 Byte  - 8 Bits 
1 Kilobyte - 1024 Bytes 
1 Megabyte - 1024 Kilobytes  
1 Gigabyte - 1024 Terabyte  
 
Information: 

 Information mean processed data for example ( Kumar’s age is 28 , Vijay’s age is 52, 
Raj's age is 65) 

 
Computing:  

Computing is the process of making data in to meaningful information,  
Figure 2 show the relationship between this three 
 
        Data Computing                                        Information 
 
 
 
 
 
 Figure 2 Data/computation/Information.  
 
The following events take place when s Computer processes the data. 
1. The program and the necessary data are entered into the Computer system from an input 

device, and are stored in main memory where they can be accessed as needed. 
 

2. Now, the CPU retrieves the instructions from the main memory, one by one, and decodes 
each instruction to determine what operation to be performed. 

 
3. When required by instruction, the CPU also retrieves the necessary data from main 

memory. 
 
4. The CPU then performs the operation required by the instruction, which might be 

arithmetic or logical operation. As each instruction is performed, the results are either 
temporarily saved by the CPU or are stored in main memory. 

 
5. The processing cycle (retrieve instruction, decode and execute instruction, save results) is 

repeated until all the program instructions have been carried out by the CPU. The final 
results are then either stored in main memory, or are sent to an output device such as a 
printer. 

 
 

28, 52, 65, 
Kumar, Vijay, Raj 

Programming Language Kumar's age is 28, 
Vijay's age is 52, and 

raj's age is 65 
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1.6 Applications of IECT 
IECT or Information, Electronics and Communication Technology is used in various 

sectors. IECT can be used to generate quality manpower.  Example of some of the sectors is 
given below. 

 
1.6.1 e -governance 

e Governance is one of the applications of IECT. With the help of e 
Governance various Government Services can be delivered to people, 
Information can be transmitted. Network of several stand alone systems can be 
created or any system can be added as a member of this group. Here 
transmission of information can be taken place between Government and 
Citizen also Government and Business. Also all the transactions taken place 
in back office and in entire network are available to process simultaneously. 

IECT Technology can be used to improve capabilities, transparency and interaction of 
people.  It will also help the smooth working in Government Sector, also it will increase 
reliability. Awareness and Capabilities of people can be increased. It will result in 
improvement in peoples benefit and nations economic development. 

 
1.6.2 Entertainment 

Now a day, people use multimedia in various sectors like business, education, 
research, entertainment etc. Therefore we can define multimedia as 
follows – it is an interface used to present information in various 
formats like characters, numbers, symbols, audio, video, graphic and 
animation.  

 
While using IECT Applications we can define multimedia in 

some different way.  Here we can define multimedia as a 
combination of more than one media.  These media are various software and hardware which 
are used for communication. Here computers and used to provide interface to users which 
help to find or search particular information, transmit the information. It will also help to 
work in simple way and play various games. 

 
Multimedia is used to improve the lifestyle in various sectors.  Also multimedia can 

be used to develop applications which can be shared by various people simultaneously.  e.g. 
various Encyclopaedias, Directories, Dictionaries, e books , newspaper etc. 

 
Multimedia can also be used in the powerfully in the fields of education and training. 

Learning can be made more interesting and impressive with the help of e learning.  
 
Multimedia is also used in the field of research.  All the sectors like space, medical 

and industries are using the multimedia applications. 
 
Besides all the sectors described multimedia is mainly used in the field of 

entertainment. Various computers can be developed here. Various animation and cartoon 
effects can also be applied. Various effects on audio and video can also be given.  

 
1.7 Bringing Computer to Life  
  A computer needs Proper connections to its peripherals to use it. The 
following are the procedure to connect peripherals to computer 
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1.7.1 Connection Keyboard, Mouse, Monitor And Printer To CPU    
The Figure 3 shows the rear view of a typical desktop computer and its ports for peripherals 

     
 
 
 
 

 
 
 
 

Figure 3 Rear View of Typical Desktop Computer 
 
Connecting mouse:  

Mouse has three model of connectors depends on our need they are  ps/2 mouse , 
serial mouse, USB mouse we can connect the mouse to any one of the three port depends on 
its model. 

 
Connecting keyboard:  

Keyboard has two model of connectors depends on our need they are ps/2 keyboard, 
USB keyboard we can connect the mouse to any one of the two port depends on its model. 

 
Connection monitor: 

 Monitors are connected to the video port of the CPU this port is also called VGA port 
typically they will be in blue colour and has 15 pin female end. 

 
Printers:  

Printer has two models of connectors depends of our need they are parallel port 
printer, USB printer we can connect the printer to any one of the two port depends on its 
model. 
 
1.7.2 Checking Power Supply  
 The computer gets its power from the external power supply to system through SMPS 
(Switch Mode Power Supply) which acts as a AC to DC converter and step down the volts to 
3 - 12 DC. The external power card is to be connected to the power supply plug in system and 

Power Supply Fan 

Power On/Off Switch 

Power Supply Plug 

Ps/2  Key Board Port 

Ps/2 Mouse Port 

           Serial Port 

 Video Port  

USB Port 

Network Port 

Parallel Port 

Audio Port 
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once the power supply on/off switch is switched on and the power switch in the front side of 
the system is also switched on then the power supply fan must run, if it is not running then 
there may be a problem of power supply, if it runs properly then we can assure that we got 
power to our system. 
 
1.8 Summary 
 
Computer is a electronic device 
Computer has five units 
Input device is used for getting input from user. 
Computer is used in banking, e-goverence etc 
 
Check Yourself: 

1. ALU present in.............. 
2. Which device is used to store the device 
3. Example for input device 
4. What is the abbreviation of RAM 
5. one  megabytes equal to 
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Chapter 2 
 

OPERATING COMPUTER USING GUI BASED OPERATING SYSTEM 
 
2.0 Introduction 
2.1 Objectives 
2.2 Basics of Operating System 
2.3 The User Interface 
2.4 Operating System Simple Setting 
2.5 File and Directory Management 
2.6 Common Utilities 
2.7 Summary 
2.8 model Answers 
 
2.0 Introduction 

In the previous chapter you learnt about basic concepts of computer. We will now 
discuss various user friendly features of windows operating system. Microsoft has produced a 
number of Operating Systems. Windows 95/98/ME, Windows NT, Windows 2000 
Professional / Advance server, Windows XP, Windows Vista are some of them. The 
Operating System which we have selected as reference is Windows XP Professional and we 
will focus our studies on it. 

 
2.1 Objectives 

In this chapter you will be learn about 
1. Define Operating System 
2. List various features of Windows Operating System, 
3. Familiarize yourself with the Windows XP Interface, 
4. Use Windows Operating System in managing files and folders, 
5. Explain how multiple Windows work, 
6. Work on Windows accessories like Notepad, Paint 

 
2.2 Basics of Operating System  

An operating system plays an important role in the use of Computer. It prepares a bare 
machine for use by the user. In other words an operating system works as an interface 
between Compute and user. The operating system enables the user to effectively use the 
system resources and access several other programs. Windows operating system offers a new 
graphic based interface to the users and they can use mouse to perform a number of 
operations. It is also possible to work on multiple windows at a time. 
 
2.2.1 Operating System 

An operating system is a set of system programs, which provides a number of facilities to 
the user for easy use of the Computer. An operating system, 

1. Controls and coordinates the operation of a Computer 
2. Easy interaction between user and Computer 
3. Starts the Computer automatically when power is turned on 
4. Controls input and output 
5. Controls program execution 
6. Manages use of main memory 
7. Manages and manipulates files 
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2.2.2 Basics of popular Operating System (LINUX, WINDOWS) 
Linux 

Linux is an operating system that was initially created as a hobby by a young student, 
Linus Torvalds, in 1991. In 1994 the first version of Linux Kernel was released on Internet.  
At the end of 2004, 50 % Linux has been adopted worldwide primarily as a server platform.  
From 2007 various well known computer manufactures have started delivering some of the 
models they are manufacturing with Linux preloaded.  

 
Linux is a example of Open Source Code Operating System. It is having nearby all the 

features present in Unix Operating System. Linux also supports TCP/IP protocol, and we can 
access Local Area Network and Internet. 

 
Linux is generally provided with two types of Graphical User Interface one is KDE and 

other is Gnome. Other interfaces are also available. Command interpreter is also available. 
The programs developed for Windows do not run on Linux and similarly programs developed 
for Linux do not run on Windows. In Windows we can start and use windows by skipping the 
username, password field but in Linux we cannot start the work without entering the 
username and password in the operating system. The Plug and Play feature available in 
Windows Operating System is very helpful for installing new hardware but most of the 
hardware manufactures do not write programs for their hardware in Linux, therefore most of 
the devices does not detect in Linux and not available for use. 

 
Today Linux is used in nearby every field as Government and Private Offices, 

Education, Various Trainings, Homes, Businesses and other. Linux was primarily written for 
386 microcomputers but presently it is used on various types of computers ranging from 
Micro to Super. Linux can also be embedded on microchips and therefore it is used in 
embedded type of electronic devices as mobile and other.  Presently companies as IBM, HP 
etc and developing Linux. 

 
Now most of the versions of Linux are available at very reasonable cost or sometime 

totally free of cost. Also Linux provides more security compared to Windows. Due to all 
these features of Linux it is overriding the Unix and Windows Operating Systems. Various 
Computer based organizations are now using Linux Operating System for their PCs. 
 
Windows 

Windows family of operating systems are based on Graphic User Interface (GUI) and 
can be used on a desktop Computer or as operating system for a node in a Network. 
 
Windows-9x 
 The term Windows 9x refers to three operating systems viz. Windows-95, Windows-
98 and Windows-me. As the names indicate, Windows-95 was released in the year 1995. It 
was plain and simple operating system, mainly developed for stand-alone computers. It did 
not have Internet features and utilities in it. For Internet operations, add-on software had to be 
installed on top of it. Windows-95 is now obsolete. 
 
 Windows-98 was released in the year 1998. In was enhanced version of Windows-95. 
Internet related aspects were included in it and Internet Explorer, the web browser, was made 
part of it. It became very popular within short span of time. There are many people who are 
still using Windows-98 today. 
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 Another version of Windows, called Windows-me was released in the year 2000. Me 
stands for MillEnnium. It was released as enhanced version of Windows-98 but had many 
internal problems, due to which it used to frequently crash. Windows-me had improved 
multimedia capabilities, video editing features and enhanced Internet facilities. 
 
Windows XP 

Yet another improved version of Windows, called Windows-XP was released in the year 
2001. It is 32-bit operating system that is quite popular on personal computers and laptops. It 
is quite stable product and is being continuously used till date. Many variations of Windows 
XP are there. They are named as Windows XP Professional, Windows XP Home, Windows 
XP Media center Editing and Windows-XP Embedded. The Microsoft has created 64-bit 
version of Windows-XP to run on them. Some of the existing features of Windows XP are 
given below: 
1. Built on the Windows-NT Engine: It is built on the field proven code of Windows-

NT and Windows 2000, which are 32-bit operating systems and support fully 
protected memory model. Due to this feature, Windows XP is quite stable and 
provides secure working environment. 

 
2. Enhanced Device Driver Verification: When you install a new service on the 

system, Window, XP tests its driver rigorously. If the driver passes the test, its 
stability is ensured. This feature makes sure that system remains stable in most of the 
odd situations.  

 
3. Windows File Protection Mechanism: This feature protects core system files from 

being overwritten by the installation applications. If a file is over written, “Windows 
file protection" feature will restore the correct version of the file. 

 
4. Primitive Multitasking Architecture: Due to this feature, multi-tasking mechanism 

has been improved in Windows-XP. It now ensures better response and better 
stability. 

 
5. Scalable Memory and Processor Support: Due to this feature, memory up to 4GB 

and two symmetric microprocessors can be supported in the system. 
 
6. Improvised Protection Mechanism: Protection mechanisms have been improved at 

encryption and decryption level and at communication and transportation level also. 
Thus XP protects the information from hackers to a large extent. 

 
7. Smart Card Support: Smart card capabilities have been included in the operating 

system. It builds faster and easier working environment. 
 
8. Firewall Enhancements: To reduce the network risk and build tight security zone, 

lot of firewall features have been included within the operating system. 
 
9. Fresh Visual Design: Although the working environment in Windows XP is quite 

similar to that of its elder brothers, Windows-9x, but it has a free look. 
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10.  Rich Digital Media Support: Windows-XP provides rich digital media support.  
Its digital media player version 9 is quite powerful and provides facilities for, 
 
 View rich media information. 
 Receive best possible audio/video quality. 
 Tune to at least 3,000 internet radio stations. 
 Create custom CDs that are very fast. 
 View DVD movies. 

 
11. Integrated CD burring support: Utilities for writing on CD-R and CD-RW have 

been incorporated in Windows Explorer of Windows-XP. Now the user need not buy 
third party software for it. 
 

12.  Dual view: In Windows-XP, a single computer desktop can be displayed on two 
monitors. 
 

13.  Enhanced Customization Features: Rich customization facilities have been 
incorporated in Windows-XP. Using these utilities, users and administrators can 
configure, customize and troubleshoot numerous Windows-XP functions. 

 
Windows-NT 

Windows-NT is a 32 bit operating system that supports preemptive multitasking. 
Preemptive in respect to operating system means the ability of operating system to pre-empt 
or stop a currently scheduled task in favour of higher priority task. 
Windows-NT is basically a network operating system. There are two versions of NT: 

1. Windows NT Server. 
2. Windows NT workstation. 
A brief description of both is given below. 
 

Windows NT Server 
Windows NT Server, as the name suggests, is designed to act as a server in network. It is 

multipurpose network operating system that integrates variety of network services in it. Its 
software tool named, Microsoft management tool, helps in managing network and Internet 
operations. It supports high security features to safeguard the system from unauthorized 
users. Strong file protection mechanisms have been built into the operating system to 
safeguard users’ files and folders from others. System policy editor and user profile features 
allow managing and maintaining user's desktops. System policies can be used to standardize 
desktop configuration, enforce behaviour and control user work environment and actions. 

 
Windows-NT Server's Network Monitor tool enables network administrators to examine 

network traffic and control it. Strong authentication certificate verification facilities have 
been built in the operating system so as to make it suitable for digital certificate related 
operations. Note that such operations are very much required in e-commerce functions. File 
related, powerful, features are part of Windows-NT Server operating system. This features 
enables large data storage and on-line backup facility. The data written on one disk is also 
written on other disk (data redundancy), so that in the event of one-disk-crash, it could be 
retrieved from other disk On the whole, Windows-NT server is a robust operating system. It 
enjoyed populating for quite long but now other operating systems from the same 
manufacturer have replaced it. 
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Windows-NT Workstation 
Windows-NT, as you know is a network operating system. In client server architecture 

mode of networking, Windows-NT Workstation operating system is for all those computers, 
which are connected to the network in client mode. In it looks, it resembles Windows-95 or 
Windows-98 but is an entirely different operating system. Being part of Network 
environment, it has tight security features and network features incorporated in it. It promotes 
distribute data processing as well as standalone mode of operations. Note that with the advent 
of Windows-2000, Windows-NT server and Windows-Workstation operating systems, both 
are almost obsolete now. 
 
WINDOWS-2000 

Windows-2000 operating system came as replacement of Windows-NT. It is basically 
GUI based network operating system. It has been designed for uniprocessor and symmetric 
multi-processors based computers. It is 32-bit operating system. Its working in it environment 
looks like its elder brothers, Windows-NT, Windows 9x etc. As the name indicates, it was 
released in the year 2000. Its four versions are: 

1. Windows-2000 Professional. 
2. Windows-2000 Server standard edition. 
3. Windows-2000 Advanced server edition. 
4. Windows-2000 Data center server. 
 

Windows-2000 Professional is Microsoft's mainstream desktop operating system for 
business of all sizes. It provides high level of security, state-of-the-art features for mobile 
users and enhanced throughputs. In its capabilities, it falls a bit lower than Windows-2000 
server edition. Windows-2000 Server standard edition is an operating system for network 
servers. It suits well for business of average size and the computers with maximum 2 
processors. Windows-2000 advanced server edition is a powerful operating system. It has 
been designed for multiprocessor computers, which have up to 4 microprocessors in them. It 
provides enhanced memory support and more rigorous printing facilities for great print load 
operations. Additional features for network balancing have been incorporated in this version. 
Windows-2000 Data Center server is the most powerful operating system of this series. It has 
been designed and developed for high-end voluminous data handling operations. It is capable 
of handling up to 32 processor based computers. Windows-2000 is known as hybrid kernel 
operating system.  

 
Architecturally it is divided into 2 modes 
1. User mode 
2. Kernel mode 
 
Kernel mode provides unlimited access to system resources and facilities, while user 

mode is heavily restricted mode. All the versions of Windows-2000 look alike in their looks 
and provide common functionality. They also support Windows-NT file system, called NTFS 
5. It is a robots operating system and is quite popular. 
 
Windows 7 

Windows 7 is a latest OS from Microsoft, it is a series of operating systems produced by 
Microsoft for use on personal computers, including home and business desktops, laptops, net 
books, tablet PCs, and media center PCs. 
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It have more additional feature than Windows XP .It have a following future 
 
Everyday tasks are simpler: 

Scan all your open windows with Live Taskbar Previews. Find a file, connect to a 
network, or use Snap to arrange a couple windows side by side. All with two or three clicks. 

 
Your PC will work the way you want: 

Make it yours with personalization and be ready to go with fast Sleep and Resume. 
Use more of your older programs with Windows XP Mode. Protect your data and be more 
secure with less effort. 

 
Hard Ware: 

Use a touch-screen instead of a mouse. Connect to printers fast with Location Aware 
Printing Share music, photos, and videos throughout your home with Play To. Use your PC 
to record live TV and watch Internet TV 
The entire GUI based computers have following properties. 
 

 
 
Title Bar 

Displays the name of the program running within the window, Double clicking on the 
title bars toggles between maximizing and restore position and single click on the title bar 
activates it. Control menu buttons are located on the right hand corner of the title bar. They 
are minimized, maximize and close buttons respectively. Minimize button reduces a window 
to the smallest size, maximize button expands. 

 
Tool Bar 

Displays shortcuts in the form of icons for specific tasks. They are segregated into 
different groups as per the nature of the work undertaken by them. 

 
Status bar 

Displays messages alerts and status messages regarding the Windows. 
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Scroll Bars 
There are two scroll bars present in a window. They are horizontal and vertical 

scrollbars respectively. Scroll bars help in viewing the contents if they are more than one 
screen full. 

 
Using Different Mouse Operations 
Click 
Hold down the left mouse button and press to activate certain programs through icon. 
 
Double Click 
Click the left mouse button in quick succession to run any program or application. 
 
Drag and Drop 
Select the required text area or picture or object, press the left mouse button and drag it to 
another area by holding the left mouse button. It moves the selected contents from the 
original place and drops them at the place where mouse button was released. Working with 
Multiple Windows 
 
Working with Multiple Windows 
To minimize all open windows: 

1. Right-click a blank area on the taskbar. 
2. Click on Show the Desktop option. 

 
To Switch Between Running Programs: 
Click the programs button on the taskbar or press the alt + tab button to switch between 
applications.  
 
To change the position of the magnification window: 

1. Place the mouse pointer inside the window. 
2. Drag the window, by click on the title bar, to the desired area on your desktop. 

 
To change the size of the window: 

1. Move the mouse pointer over the edge of the window. The cursor becomes a double-
pointed arrow. 

2. Drag the window border to resize the window. 
 

To display all open windows 
1. Right-click a blank area on the taskbar. 
2. Click Cascade Windows, Tile Windows Horizontally or Tile Window vertically. 

 
Windows XP Professional 

Windows XP professional has new improved interface that is simple and more effective 
to use: 

 Easier and Simpler interface 
 Single click on start button opens programs, finds documents and allows using 

systems tools. 
 Task bar helps in switching between programs easily. 
 Using longer files names, which enables the user to find the organise files easily.  
 Additional browse button in every window. 
 Support of online website. 
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 Built in Internet Explorer 
 Regular testing of internal memory and system files. 
 My document folder on the desktop to store all your files. 
 Common address book which can be accessed from all different programs 

 
2.3 User Interface 

In Windows, Graphical User Interface is used to give commands to computer instead of 
using text based commands.  In DOS, text based user interface is provided to inter the 
commands. It is essential to remember all the commands while using this operating system. 
Here each and every work needs to be done by entering the text command. But in Graphical 
based operating systems, Graphical Icons are provided. With the help of various input 
devices these icons can be used to quickly give instructions to computer and also to start 
various programs.  

In the Graphical User Interface, various Windows and their contents like Minus, Icons, 
Radio Button, Check Boxes etc are included. To perform various tasks mouse and other 
pointing devices are used. 

Microsoft Windows, Macintosh, Linux etc are popular examples of Graphical User 
Interface based Operating Systems. 

 
2.3.1 Task Bar 

If you consider a Hard Disk as a Cabinet in which you can store all the information like 
files, folders present on the Computer; then you can consider Desktop as a desk. While 
working people use desk to keep the things, in the same way while working on Computers 
you are actually working on desktop. Any work which has been started is called as task or 
anything on desktop which is running can be called as a task. Windows based operating 
systems support Multi Tasking; it means we can perform various tasks simultaneously. While 
one program is on and you want to start another program it is not necessary to close the first 
program. You can simply minimize the first program and work in other program. The icons 
of running programs are shown in the taskbar. You can move between applications using 
icons present on the taskbar. If number of applications are running and there is no enough 
space present to keep all the icons on the taskbar then similar type of icons are grouped 
together. If you want to stack all the running programs you can use various options like 
cascade, tile etc. 

 

 
 
Taskbar is generally displayed at the bottom of the window but you can change its 

position, also its size can be changed. If you lock the taskbar then it is not possible to change 
its size and position. When the taskbar is hidden, it appears only when the mouse cursor is 
pointing on the taskbar’s position, when the mouse is moved from that position the taskbar is 
automatically hided. Various Quick Launch, Date and Time are also displayed on the taskbar.   
 
2.3.2 Icons 

When you start the Computer, it gets booted. While the computer is in booting process 
we can’t work on it. After completion of the booting process the first screen displayed is 
called as Desktop. Various Items including Icons are present on this Desktop. With the help 
of these icons we can quickly access various programs, files and folders. Various shortcuts 
for programs, files, folders, disks etc are provided with the help of icons. Icons are special 
types of buttons which include image and label given to that button.  



25 
 

 
2.3.3 Menu 

Start menu or Start button provides list of commands to perform various jobs and 
applications. In various versions of Windows Start menu is displayed with the start label. In 
Windows Vista Start menu is displayed with the start button. In Start menu various programs 
installed on computer are shown using nested structure. With the help of link provided here 
you can quickly access desired program or perform any task. Thus you need not to remember 
the difficult commands and complicated file paths. 

 
With the help of Start Menu you can turn off of log off the computer also you can switch 

between users. Various hardware and software setting can be changed with the help of 
control panel provided in the Start Menu. If you need any help while working in Windows, it 
is available on the start menu. You can use various accessories and other system tools 
provided with Windows with the help of Start Menu. 

 
2.3.4 Running Applications 

Some Accessories like are provided with Windows Operating System. e.g. Notepad is 
used to create and edit simple text documents. Paint is used to create and edit drawings and 
images. Calculator is used to perform simple and scientific calculations. But when you need 
documents with lot of formatting, tough and complicated Calculations of high quality 
graphics then these accessories are not helpful to perform these works. You need to install 
special type of software to perform such tasks.  With the Running an Applications Feature of 
Operating System, such programs can be installed and used on Computer. Whenever we 
install any program its files are inserted in the Windows files, Windows Operating System 
performs all the tasks need to run the installed application as proving the shortcut for these 
programs, storing the work done on hard disk using this software, reopening the files of any 
software etc. 

 
2.4 Operating System Simple Setting 

Windows Operating System offers a powerful option called Control Panel through which 
windows settings can be changed. Control panel holds a group of tools that help to change the 
software and hardware settings. 
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2.4.1 Changing System Date and Time 
 
In Windows XP and Vista right click on the clock in your task bar and click on Adjust 

Date/Time. Ignore the time for now. Instead, click on the Time Zone tab (or in Windows 
Vista, click on the Change time zone. Button to get a somewhat similar dialog) Make sure 
that your time zone is set correctly, selecting from the dropdown list. Also make sure that 
automatically adjust clock for daylight saving changes is checked. Make sure that 
automatically synchronize with an Internet time server is checked. The default time server is 
typically time.windows.com which should be sufficient. The dropdown list will also include 
alternatives, typically time.nist.gov in the United States, which is also a fine alternative. (In 
Windows Vista you'll have to click a Change settings button to make changes.) You can also 
select another time server by typing its name in as well. 

As you can see, the dialog lets you know when the last time update was performed, 
and when the next one will be. Alternately, you can always click on the Update Now button 
to force an immediate update. 

 

 
 
2.4.2 Changing Display Properties 

Win XP offers variety of options that enable you to change the way the graphical user 
interface or desktop behaves. Double Click Display icon in Control Panel. Following screen 
appears. 
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To Change the background screen 

You can change the background screen of the window with the help of options available 
in the background tab of display properties. Select the wallpaper and the display option from 
it and click on OK. 

 
 
To change the screen saver 

With the help of screen saver tab one can set the desired screen saver, set the timing; 
assign a password for the screen saver to protect your files. To change the settings of the 
screen saver you can use the settings options. 

 
To change windows appearance style  

One can change all the windows default settings with the help of appearance tab. 
Choosing a proper scheme places a representation of that scheme in appearances box. One 
can also define his own scheme and all it to the existing list 
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.  
To change the desktop effects: 

Effects option present in Appearance tab is meant to set the icons for system objects on 
your desktop. Effects also include some window display attributes.  

 

 
 
Customize Desktop 
Following steps can be used to vary the icons for system objects on the desktop. 

1. In the General tab select the particular desktop icon you want to change. 
2. Click the change icon button. The change icon dialog box appears. The file name text 

box displays the particular file containing the icons. Select an icon and then choose 
Ok. 

3. If you want to use an icon from elsewhere, click on the browse button and search for 
other files containing that icons. 
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2.4.3 To add or remove a windows component 
You can open the Add / Remove Programs Properties dialog box at the Windows Setup 

tab by clicking Start, pointing to Settings, click Control Panel, double clicking Add / Remove 
programs, and then clicking on the Add / Remove Windows Components tab. 
Under Components, click the component you want to add or remove. 

 Select which software want to remove and click uninstall 
 The OS uninstall the program finally click the finish button. 
 When check in the control panel uninstall program not displayed  

 

 
 
2.4.4 Changing Mouse Properties 
Double click mouse icon in Control Panel. Following screen appears. This option change 
settings for mouse. 

 
 
Button Tab 

Select Buttons Tab, present in the mouse properties window. With the help of this tab 
you can swap the mouse buttons and adjust the double click speed. 



30 
 

 
Pointer tab 

Pointers tab is used to change the default mouse pointers. Select the pointer shape you 
want to change and then click on browse button. It will display you a list of pointer shapes. 
Select a particular shape and then click on open button to open the file. In the default dialog 
box click on apply button followed by OK.  

 
Motion Tab 

In the motion tab of the mouse properties dialog box one can change the pointer speed 
and add a pointer trail to the pointer. 

 
 
2.4.5 Adding and Removing Printers 

Double click Printers Icon in Control Panel or click on Start, pointing to settings, click 
Printers. Following screen appears. It is used to add, remove and change settings for printers. 

 
To change printer settings 

Right – click the icon for the printer you are using, and then click Properties. The 
settings you can change depend on the type of printer you have. Click the different tabs to see 
all of the options you can set. 
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To Set up a printer 
1. Double click on Add printer. 
2. Follow the instructions given on the screen. 

 
2.5 File and Directory Management 

With the click of mouse button user can create, delete, rename a file or folder. Folders 
can be shared so that these are used by others. Moving a file is simple drag and drop 
operation of mouse in Windows Explorer. For the text processing requirements of the users 
Notepad and Word Pad are given. Utilities like Games and multimedia can be used to 
entertain the users. System performance can be increased with system tools. 

In Windows Explorer or my computer, one can see both hierarchy of folders on the 
computers and all the files and folders in each selected folder. This is especially useful for 
copying and moving files. 

 
2.5.1 Creating and renaming of files and directories 
To create a new folder 

1. In the windows explorer, if you want to create a new folder then select new option 
form file menu. 

2. Select folder option from the submenu. 
3. Type a name for the new folder and then press enter. 

 
To delete a file or folder 

1. In windows explorer, locate the file or folder you want to delete. 
2. Click the file or folder. 
3. On the file menu, click Delete. 

 
If you want to retrieve a file you have deleted, look in the Recycle Bin. The deleted files 

remains in the Recycle Bin until you empty it. You can also drag file or folder icons onto the 
Recycle Bin icon. If you press shift while dragging, the item will be deleted from the 
computer without being stored in the Recycle Bin. 
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To Change the Name of the File or Folder 
1. In Windows Explorer, click the file or folder you want to rename. You do not need to 

open it. 
2. On the File menu, Click Rename. 
3. Type the new name, and then press Enter. 

A filename can contain up to 255 characters, including spaces. But it cannot contain any of 
the following characters: * ? “ 
 

To view a file or folder 
1. Double click the drive that contains the file. 
2. To View a file or folder, double click on it. 

 
Copying and moving of files 

You can open the folder that contains the file you want to move and drag it to the 
folder you want to put it in. To copy a file hold down the control key and to move a file, hold 
down the shift key while dragging.(or) 

1. Locate the file or files you want to move or copy. 
2. Select the files. 
3. Choose copy or cut from the edit menu, the toolbar or right click the context menu. 
4. Locate the place to which you want to move or copy the objects. Click on it. 
5. Choose paste from the toolbar, the edit menu, or the right click context menu. 

 
To select Multiple Files and Folders follow given steps: 

1. In the folder window, hold down the Ctrl key, and then click each item to be selected. 
2. To select all the files and folders in the window, click the edit menu, and then click 

Select All. 
3. To select a group of files that are next to each other, hold down the mouse button and 

drag a rectangle around the files you want to select. 
4. To change the appearance of items in a folder in windows explorer, click the View 

menu, and then click one of the following commands: Large Icons, Small Icons, List 
or Details. 
 

To Change the Appearance of items in a folder 
In my computer or explorer click the view menu, and then click one of the following 

commands: Large icons, Small icons, List, Details. You can also sort the items by name, size, 
date and type depending on the view. 
 
To Print a Document 

1. If the document is open, on the File menu, click Print. 
2. If the document is not open, drag the document from My Computer or Windows 

Explorer to your printer in the Printers folder, 
3. While a document is printing, a printer icon appears next to the clock on the taskbar. 

When this icon disappears, it means that your document had finished printing. 
4. For easy access to your printer, you can create a shortcut to it on the desktop. 

 
To send files to another place: 

1. Select the file in the explorer and then choose send to option from file menu to 
explorer. 

2. Or Click the right mouse button and select Send to option form the shortcut menu. 
3. You can select the destination type from the submenu under Send to option. 
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To share a Folder with others 
1. Click the folder you want to share. 
2. From the file menu select sharing and security option. 
3. Select the Sharing Tab from the dialog box, choose the shared as option and the 

corresponding details required. 
4. You can also share Disk Drives by using above mentioned procedure. 

 
To Change File or Folder Properties 

In the Windows Explorer, click the file or folder whose properties you want to change 
and then select Properties  option from the file menu (Or)When you want to view or change 
information about any item, such as a document, program, folder disk drive, or printer, you 
can look at its properties. Use the right mouse button to click the item, and then click 
properties on the menu. 
 
2.6 Common Utilities 

Instead of using the standard menus to find the command you need, use the right mouse 
button to click a file or folder. 

The menu that appears shows the most frequently used commands for that file or folder. 
You can put a shortcut to any program, document, or printer on the desktop or in any folder. 
Shortcuts are quick ways to get the items you use often. For example you can create shortcuts 
to the printer by using the right mouse button to drag its icon to the desktop. Then to print a 
file, just drag its icon to the printer icon. 

 
To Create a shortcut in a Folder 

In Windows Explorer, open the folder you want to create the shortcut in. On the file 
menu, point to new, and then click Shortcut. That time new short cut created and use that 
short cut instead of selecting from menu. 
 
Windows Accessories 

1. Click the folder you want to share. 
2. From the file menu select sharing option. 
3. Select the sharing tab from the dialog box, choose the shared as option and the 

corresponding details required.  
4. You can also share Disk Drives by using above mentioned procedure. 

 
Notepad 

You can use Notepad to create or edit text files that do not require formatting and are 
smaller than 64K. Notepad opens and saves text in ASCII (text-only) format only. To run 
Notepad, click on Start and point to Programs, take mouse pointer to Accessories and click 
on Notepad. You can also type Notepad in the Run option of Start Menu. Then following 
screen appears. User can type the letters in the given area and click on save option in File 
menu to save the contents. 
 
To Open a Document 

1. On the File menu, click Open 
2. In Look In, click the drive that contains the documents you want to open. 
3. Double-click the folder that contains the document you want to open. 
4. Click the document name, and then click Open. 
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To delete text 

1. Select the text you want to delete. 
2. To remove text so that you can place it in another part of the document, click Edit, 

and then click Cut. 
3. Or to remove text entirely from the document, press Delete. 

 
To find specific characters or words the following steps are used: 

1. On the Edit menu, click Find 
2. In the Find what box, type the characters or words you want to find. 
3. Click Find Next. 

 
 
To delete, cut, copy and paste text 

1. To delete characters to the left of the insertion point, press the Backspace Key. 
2. To delete characters to the right of the insertion point, press the Delete Key. 
3. To delete words, select them, and them press the Backspace or Delete Key. 
4. To cut text so you can move it to another location, select the text. Then, on the Edit 

menu, click Cut. 
5. To copy text so you can paste a copy of it in another location, select the text. Then, on 

the Edit menu, click Copy. 
6. To paste text you have cut or copied, place the insertion point where you want to 

paste the text. Then, on the Edit menu, click Paste. 
 
To wrap text to the window size 

1. On the Edit menu, click Word Wrap. 
2. Wrapping text enables you to see all the text on the line, but it doesn’t affect the way 

text appears when it is printed. 
 
To insert the time and date in a document 

1. Move the insertion point to where you want to add the time and date. 
2. On the edit menu, click Time/Date. 
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To keep a log by using Notepad 
1. On the first line of Notepad document, type the following at the left margin, making 

sure you include the period: .LOG 
2. Save the document. 

Every time you open this document, Notepad will append the current time and date, as 
specified by your computer’s clock, to the end of it. 
 
Paint 

You can use Paint to create, edit and view pictures. You can paste a Paint picture into 
another document you’ve created, or use it as your desktop background. You can even Paint 
to view and edit scanned photos. 

 
To run Paint, click on Start and point to Programs, take mouse pointer to Accessories 

and click on Paint. You can also type Paint in the Run option of Start Menu. The following 
screen appears. User can type the letters or create images or graphics in the given area and 
click on save option in File menu to save the contents. 

To draw a straight line         
1. Click the required button in the toolbox. 
2. To draw the line, drag the mouse pointer. 

To draw a curve                    
1. Click the curve tool in the toolbox. 
2. To choose the width the curve will be, click a line width at the bottom of the toolbox. 
3. To choose the color the curve will be, click a color. 
4. Draw a straight line by dragging the moue pointer. 
5. Click where you want one arc of the curve to be, and then drag the mouse pointer to 

adjust the curve. 
6. Each curve must have at least one arc but no more than two. Repeat this step for a 

second arc. 

To draw an ellipse or circle    
1. Click the ellipse tool in the toolbox. 
2. Drag the tool in the drawing area to draw the ellipse. 
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To Create an airbrush effect   
1. Click in the toolbox. 
2. To change the size of the spray area, click a size from the bottom of the toolbox. 
3. To choose the spray colour, click a colour. 
4. To spray drag the mouse pointer. Use the left mouse button to spray with the 

foreground colour, or use the right mouse button to spray with the background colour. 
 

To create custom colours    
1. In the colour box, click the colour you want to change. 
2. On the Options menu, click Edit Colours. 
3. Click Define Custom Colours, and then enter new values in either the RGB (red, 

green, blue) or HLS( hue, saturation and luminescence) and colour models. 
4. Click Add to Custom Colours. 

 
To use black and white instead of colour 

1. On the Image menu, click Attributes. 
2. Click Black and White 

 
To invert all the colors in a picture 
On the Image menu, click Invert Colors. 

To Change the color of an existing line   
Click in the toolbox. 
Click a different color in the color box. 
Position the paint cursor so that it is touching the line, and then click. 
 
To copy part of a picture 

1. Select the area you want to copy by click or in the toolbox and then dragging the 
cursor to define the area. 

2. On the Edit menu, click Copy. 
3. On the Edit menu, click Paste. 
4. Drag the selection where you want it. 
5. To remove the selection box, click outside it. 

 
To save part of a picture into another bitmap file 

 Select an are you want to save by clicking select     or regular   select in the 
toolbox and then dragging the cursor to define the area. 

 On the Edit menu, click Copy to. 
 Specify a file name and location. 

 
Calculator 

To run Calculator, click on Start and point to Programs, take mouse pointer to 
Accessories and click on Calculator. You can also type Calc in the Run option of Start Menu. 
The following screen appears. 
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1. To perform a simple calculation 
2. Enter the first number in the calculation. 
3. Click + to add, - to subtract, * to multiply or / to divide. 
4. Enter the next number in the calculation. 
5. Enter any remaining operators and numbers 
6. Click = 

 
To perform a scientific calculation 

1. On the view menu, click Scientific. 
2. Click a number system. 
3. Enter the first number. 
4. Click an operator. 
5. Enter the next number in the calculation. 
6. Enter any remaining operators and numbers. 
7. Click = 

 
To convert a value to another number system 

On the View menu, click Scientific. 
Enter the number you want to convert. 
Click the number system you want to convert to. 

 
System Tools 

These system tools can be used to enhance the performance of the Computer. Backup 
is used to take back up of files present in hard disk. You can back up files to floppy disks, a 
tape drive or another computer on the network.  
 
Using Disk Defragmenter to speed up the hard disk 

You can use Disk Defragmenter to rearrange files and unused space on the hard disk 
so that programs run faster. 
 
Character Map 

You can use Character Map to insert special characters into a document. To run 
Character Map, click on Start and point to Programs, take moue point to Accessories and 
click on Character Map. The following screen appears. 
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To add a special character to a document 

1. Open Character Map 
2. In Font, click a font. 
3. Double-click each character you want to insert. 
4. Click Copy. 
5. In your document, click where you want the characters to appear. 
6. On the Edit menu, click Paste. 
7. Select the inserted characters, and then click the arrow on the font list to change to the 

same font you used in Character Map. 
List to change to the same font you used in Character Map. 
 
Communications 

Utilities which are helpful in making communication are grouped here. 
 
Using Dial –up Networking to connect to a Compute or Network 

1. Select Programs from Start menu. 
2. Go to Accessories and then select Communication option. 
3. From the submenu select Dial-up Networking. 
With Dial-up Networking, you can gain across to shared information on another 

computer, even if the computer is not on a network. The computer you are dialing in to must 
be set up as a network server for you to use it’s shared resources. For example, if you have a 
computer at home, you can dial in an connect to the work computer and network through a 
network server. Both the home computer and the network server must have modems 
installed. To start the dial-up networking setup wizard, double click My Computer, and then 
double-click Dial-up Networking and follow the instructions. 
 
Check Your Progress 
Q1 What is the use of a control panel? 
Q2 What do you understand by the term recycle bin? 
Q3 How screen saver is changed? 
Q.4 How to create a folder? 
Q.5 What is the use of Character map? 
Q.6 What is the use of Disk Defragmenter? 
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2.7 Summary 

 various components of Windows 2000 professional like Desktop, Start Button, 
Start menu, My Documents, My computer, Recycle Bin and their 
functionalities.  

 Some of the tools available in control panel were used to show how display 
settings, date and time  

 Windows are GUI based designed for easy interaction 
 Windows contain different Package like MS Word,Paint,Calculator and 

Games etc 
 Computers are connected remote computer using network  
 We can change the properties of different hardware in the system like mouse, 

printer etc. 
 Depending the need of user select the operating system. 
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Chapter-03 
 

Understanding word processing 
 
3.0  Introduction  
3.1 Objectives 
3.2 Word Processing Basics 
3.3 Opening and Closing Documents  
3.4 Text Creation and Manipulation  
3.5 Formatting the Text 
3.6 Table Manipulation  
3.7 Summary 
3.8 Model Answers 
 
3.0 INTRODUCTION:  

MS Word is a software package offering features for sharing data and documents, 
communication tools, Internet access and publishing capabilities. You can create letters, 
memos, reports, term papers with the help of MS Word. It can also help you to send 
documents to a group of people for feedback.  
 
3.1OBJECTIVES:  

After going through this chapter you should be able to: 
 Understand Different bars and icons in MS Word. 
 Open, print and close documents. 
 Scroll the documents. 
 Change font size, alignment. 
 Format the document. 
 Create and manage Tables. 

 
3.2 Word Processing basics: 

MS Word is a software tool used for creating documents. It offers a number of 
features that are related to text processing. The interface of the MS word is similar to other 
windows products. It has several toolbars that can be viewed based on the requirements of the 
user. It also offers formatting of text etc. we shall be discussing the features that are required 
by a common person to create documents.  
 
3.2.1 Opening word processing package  

1. Click on star button at the bottom left corner of the Win2K Professional or any other 
Windows Operating system 
 

2. Select the Programs option of the Start menu. 
 

3. Select the Microsoft Word option from the Programs submenu. This invokes 
Microsoft Word and starts a new document. 

 
4. A new document window is displayed each time you start word. The document 

window contains individual Word files. This window differs from an application 
window, which is displayed even if no documents are open as long as Word is 
running. Word document window is shown below: 
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The document window contains a number of parts that are described below. 
 
Title Bar: 
 Displays the name of the program, the name of currently active Word document, 
the Control menu icon, Maximize button, Minimize button a Restore and Close buttons. 
Double-clicking on the title bar can alter the size of the Word window: 

 
 
Ruler Bar:   
 It enables to format the vertical alignment of text in a document and is also used 
to set tab stops on a line of text. You can select the Ruler option from the View menu to 
display or hide the ruler bar. 

 
 
Status Bar: 
 It displays the information about the active document on which you are currently 
working. This includes the page number , the column and line number on which you have 
positioned you cursor. Apart from these, there are four labels which are REC, TRK, EXT and 
OVR 

 
  
REC indicates macro recorder. 
 
EXT indicates extent selection 
 
OVR Indicates overstrike mode 
 
Workspace: 
 It is a working space of MS-word.we can create the document,create table and 
include images etc.Depending our interest we can the document data with different types of 
menu available in the word package. 
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Task Bar: 
 It consists of Start button that is used to start and switch between applications 
that have been launched.  

 
 
View Buttons: 
 The Word document window consists of five View buttons - Normal view, Web 
Layout View, Print Layout View, Outline view and Reading Layout view at the bottom left 
of the horizontal scroll bar: 

 
 
Insertion Point: 
 It is a tall blinking vertical cursor that indicates the place where the text or 
graphics will be placed when you insert them. 

Mouse Pointer:  
 It resembles an I-beam. The pointer charges shape when it passes over certain 
parts of the Word document window. 
 
Office Assistant: 
 It enables you to type a request and select form a list of 
possible responses. It also displays context-sensitive help about he 
current operation. To invoke the office Assistant, click on Show the 
Office Assistance. To close the Office Assistant, right-click on the Office 
Assistant, from the shortcut menu click on Hide option. 
 
Scroll Bars 
 The Word document window consists of two scroll bars-
vertical scroll bar and horizontal scroll bar. The vertical scroll bar is used to move a 
document vertically while the horizontal scroll bar is used to move the document 
horizontally. 
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3.2.2 MENU BAR: 
 It is positioned below the title bar; it contains nine options- File, Edit, View, 
Insert, Format, Tools, Table, Window and Help. Each of these menu bar items has drop-down 
menus. 
 
File Menu: 

 
 

 
 

 

New - Opens a new document. If you use the keyboard combination indicated on the right a 
blank document opens immediately. Selecting the New menu item with your cursor gives 
the opportunity to open a large number of types of documents. 

Open - Opens a previously saved document. 
Close - Closes the active document but does not quit the application. 

Save - Saves the active document with its current file name, location and format. 
Save As - Saves by opening a window which gives the opportunity to change the file name, 
location or format. 
Page Setup - Sets margins, paper size, orientation and other layout options. 

Print Preview - Shows how the file will look when you print it. 
Print - Prints the active file, also gives the opportunity to change print options 

Quit - Closes Microsoft Word. 

Edit menu: 
Undo - The actual entry of this item will depend on what you did last.This selection 
be repeated several times. 

 Repeat - After an action has been undone, it can be reinstated in the document. 
Cut - Removes the selection from the active document and places it on the clipboard.
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Copy - Copies the selection to the clipboard 
Paste - Inserts the contents of the clipboard at the insertion point (cursor) or 
whatever is selected. 
Clear - Deletes the selected object or text, but does not place it on the clipboard. 

Select All - Selects all text and graphics in the active window. 
Find - Searches for specified text in the active document 

Replace - Searches for and replaces specified text and formatting. 

View menu: 

 

Normal - The default document view for most word 
processing tasks. 

Page Layout - An editing view that displays your document 
as it will look when printed. This view takes more system 
memory and scrolling may be slow. 
Toolbars - Displays or hides toolbars. The right pointing 
arrow indicates a list of toolbars. To add one slide down to 
the name of the toolbar and click to select. 

Ruler - Displays or hides horizontal and vertical rulers at the 
top and left side of the document. 
Header and Footer - Adds or changes the text that is 
displayed at the top or bottom of every page of the document 
Full Screen - Hides most screen elements so you can see 
more of your document 
Zoom - Controls how large, or small, the current document 
appears on the screen. 

Insert menu: 
Page Break - Use this command to send your cursor to the top of the next 
page even though the text does not extend to the bottom of the previous page 
Table - Create a table around selected text. If no text is selected you will be 
asked to choose the number of rows and columns needed in your table. 
Footnote - Place a footnote at the bottom of the page or the end of the 
document. 
Date and Time - Choose from seventeen formats for displaying date, time, or 
date and time. 
Symbol - Insert a symbol from each of your symbol fonts, or any standard font which 
includes symbols. There are more than you might think! 
Bullet - Place a bullet. New bullets are added following carriage returns. Want 
to change the bullets? Wait for the next menu. 
Text Box (Frame) - Use this to place captions near tables or drawings, or to 
set off text at the beginning of a page. Click and draw the box after making this 
selection. 
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File - Insert a saved document into the active document at the cursor. 
Picture - Insert pictures from clip art or a file. You can also insert auto shapes, 
word art, or a chart. 
Drop Cap - Make the first letter of a paragraph or chapter large enough to 
span several lines. 
Object - Insert an object such as clip art, word art, an equation or much more. 

Hyperlink - An interesting use of hyperlinks is to place a link to any document 
stored on your computer. You can later open that document by clicking on the 
link. Neat? 

Format menu: 

Character - Change font style, size, color and a large number of other features. You can 
also change the spacing between letters here. 

Paragraph - Indent a paragraph using either margin or place some chosen amount of space 
before or after the paragraph. 

Document - If you need to change page margins, or the size of the header or footer, do it 
from this sub-menu. 

Bullets and Numbering - As promised in the Insert menu, if you wish to change the bullet, 
it can be done here. Your bullets can be literally any symbol you wish them to be 

Border - Create borders around blocks of text, or around the entire document. On the Page 
Border tab, under the Art pull down menu you can find a huge selection of graphic borders; 
hearts, stars, planets and much more. 

Style - If you prefer not to use the Formatting toolbar, document style can be changed here. 

Background - Another task which can be handled in the Formatting toolbar, you can 
choose the color to highlight selected text in your document. 

Change Case - DO YOU EVER FORGET THE CAPS LOCK? If so, some to this sub-
menu and change the case of the highlighted text. This is a cool feature! 

Bold, Italic, Underline - Format selected text; Bold, Italic, or Underlined. 

Object - Make changes to any selected object; image, word art, auto shape or any other 
object inserted into the document. 
 
Font menu 

 

Go to the Font menu to select a new font, or change highlighted text to a new font. 
One convenient feature of this menu is that the name of the font is displayed in that 
font. This is to help you make your selection. 

Caution: The number of fonts available on your computer can slow the speed with 
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this an application opens. Any application which allows the use of text (quick-
name one that does not) must build a list of those fonts as it is launched. Too many 
fonts will slow your computer down. Unused fonts should be removed. However, 
you must be sure that the font you remove is not one which is required by an 
application. Adobe Acrobat Reader is an example of an application that requires 
certain fonts. 

 

Tools menu 

 

Speak Selection - That's right, Word will speak whatever text you have selected. 
Macintosh only 

Pick Voice - If your computer can read a selection, why not choose the voice it uses? 
Macintosh only 

Spelling and Grammar - Choose either sub-menu and the same window opens. 
Questioned spelling is in red, grammar in green. 

Thesaurus - Have you used the word "like" too many times? Highlight the word, 
select Thesaurus and get suggestions like similar and analogous. 

Word Count - Need to know how many words are in your document? Select Word 
Count and find out how many pages, words, characters, paragraphs, and lines. 

Auto Summarize - Exactly what it sounds like, Word summarizes the document, 
reducing the length of the document, keeping the meaning. 

Auto Correct - Word will automatically correct some things. If this feature is 
irritating to you, come here to change what is corrected. 

Preferences - Modify Word settings here. Modify print, editing, spelling and other 
options from this sub-menu. 

Customize - Opens the same window that you get by going to the View menu and 
selecting Toolbar/Customize. 

Window menu: 

New Window - This opens another window with a copy of the active document. 

Arrange All - Displays all open files in the window. This makes dragging and dropping 
from one document to another much easier. 

Show Clipboard - This is a valuable feature. If you do not remember the last item copied 
select this sub-menu to see text or images in the clipboard. 
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Open Document List - There is no need to drag windows to the side so you can see other 
documents open in Word. Come to the bottom of this window for a listing of all open 
documents. The active document has a check mark beside it. 

 

Help menu: 

Show Balloons - If you are not sure what a menu does, turn on Balloons, put your cursor on 
the menu item and get a short explanation. 

Microsoft Word Help - Open Word's Assistant and get a search box to type in. Word 
displays possible matches for you to read about. 

Contents and Index - See an index of all topics available in Word's Help documentation. 

Help on the Web - That's right! It is exactly what it sounds like. Select a link and a 
Microsoft help page is opened in your browser. If you are not online, Word will make the 
connection and then display the page. 

Online Registration - If you have ever installed any software application on your computer 
you have seen those reminders to register the product online. 

Commonly used keyboard combinations 
    To use one of these combinations Hold the Command key down and strike the letter key 
Hint: The command key is the one that people often call "open apple" and is found on either 
side of the space bar.  

 

Open a new word document 
quickly.  

Cut- Removes the selection from the 
active document and places it on the 
clipboard. 

 

Opens a previously saved 
document.  

Copies the selection to the clipboard 

 

Closes the active window but does 
not quit Word.  

Paste - Inserts the contents of the 
clipboard at the insertion point (cursor) 
or whatever is selected. 

 

Saves the active document with its 
current file name, location and 
format. 

 

Selects all text and graphics in the active 
window. 

 

Prints the active file, also gives the 
opportunity to change print options  

Find - Searches for specified text in the 
active document 
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Quit - Closes Microsoft Word. 
 

Bold - Formats selected text; make text 
bold, or remove bold formatting 

 

Undo the last action. This selection 
can be repeated several times.  

Italic - Formats selected text; make text 
italic or remove italic 

 

Redo - After an action has been 
undone, it can be reinstated in the 
document. 

 

Underline - Formats selected text; make 
text underlined or remove underline 

Less commonly used keyboard combinations  

 

Increase selected text two 
points  

Apply superscript formatting 

 

Decrease selected text 
two points  

Apply subscript formatting 

 

Increase selected text one 
point  

Copy formats 

 

Decrease selected text 
one point  

Paste formats 

 

Change case of the letters 
 

Single space lines 

 

Underline words but not 
spaces  

Set 1.5 line spacing 

 

Double underline text 
 

Double space lines 

 

Center a paragraph 
 

Delete one word to the left 

 

Justify a paragraph 
 

Delete one word to the right 

 

Left align a paragraph 
 

Cut 

 

Right align a paragraph 
 

Paste 

 

Indent a paragraph from 
the left  

Insert a line break 

 

Create a hanging indent 
 

Reduce a hanging indent 

If text is already selected and you want to extend the selection area  

 

Extend selection one 
character to the left  

Extend selection one character to 
the right 

 

Extend selection to the 
end of a word  

Extend selection to the 
beginning of a word 

If you want to move the cursor  

 

One character to the right 
 

One character to the left 

 

One word to the right 
 

One word to the left 

 

To the end of a document 
 

To the beginning of a document 
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3.2.3 USING THE HELP: 
Word has following online help: 

1. Microsoft Office Word Help 
2. Office Assistance 
3. Online Help 

 
Microsoft office Word Help 

1. Click on Microsoft Office Word Help option form the Microsoft Word Help menu. 
2. Type the word you want to search. 
3. To find out the available options click of Start Searching option. 
4. Click on desired option. 

 
Office Assistant  

To open the office Assistant dialog box: 
1. Click on Show the Office Assistance form the Help menu. 
2. Type the word you want to search. 
3. To find out the available options click of Start Searching option. 
4. Click on desired option. 

 
 

 
 
Online Help 

This option provides the online help. 
 
3.2.4 USING THE ICONS BELOW MENU BAR: 

There are a number of Icons below menu bar which can be used to work fast. These 
icons have been grouped in the form of toolbars. Toolbar contain bottoms, menus and other 
controls that help you after the appearance and arrangement of documents by executing a 
variety of Word commands. Word provides 20 toolbars that help you perform tasks faster and 
with ease. The most commonly used toolbars are standard and standard and formatting 
toolbars. 
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Icons is Standard Toolbar 
The standard toolbar is the one nearest to the top of the Document: window and below 

the menu bar. Standard toolbar provides shortcut for menu commands. The left slide of the 
toolbar enables you to perform tasks common to many Windows-based programs, such as 
opening a new or existing file, saving or printing a file cutting and pasting text and objects, 
and undoing and redoing the most recent actins. The right of the standard toolbar offers some 
functions more specific to word application. 

 
 
Icons in Formatting Toolbar: 

The formatting toolbar contains icons that are common to many Windows programs 
and related to formatting of text in documents. This includes changing documents changing 
documents styles, font, font styles, type styles, paragraph alignments, listing formats, 
indenting levels and borders. Following Table gives the names and functions of the tools of 
the formatting toolbar: 
 
Display Other Icons: 

To display or hide toolbars, select the Toolbars option from the View menu of the 
menu bar as displayed in Figure below: 
 

 
 
3.3 Opening and Closing Documents: 

Documents like letters, memo and reports that have already been created can be 
opened, previewed, and printed with the defined margins. These documents can be saved 
with modification at different location. MS Word can automatically save the contents of 
documents at defined intervals. 
 
3.3.1 OPENING DOCUMENTS: 

To open an existing document, follow these steps:  
 

1. Select the Open option from the File menu. An open dialog box will be displayed as 
shown below.  
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2. Select the appropriate drive and folder. 
 

3. Double-click on the desired filename to load the document. Alternatively, click on the 
Open button on the standard toolbar or press Ctr+O. 

 
4. Select the Window menu. Notice that document names are displayed and the active 

documents has a check mark by it. 
 

5. Press Esc to release the Window menu. 
 
To load non-word documents, follow these steps:  

1. Select the Open option from the File menu. The open dialog box gets invoked as 
displayed in above figure.  

 
2. Select the appropriate dive and folder in which the document is located. 

 
3. From the Files of Type option select All Files option. 

 
4. Select the type of the file you want to view from the Files of type list box. 

 
5. Double-click on the desired File name to Load the document. 

 
To open a document as read-only, the steps are:  

1. Select the Open option from the File menu. The open dialog box gets invoked as 
displayed in Figure. 

2. Select the appropriate drive and folder in which the document is located. 
3. Select the type of file you want to view from the Files of type box. 
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4. Click on the down arrow of open button and Select the Open Read-only option from 
this drop-down menu. 

 
3.3.2 Save & Save as  

When your key in the document is stored in the internal memory of the computer, in 
order to preserve the document for future use, you must save it on the disk, to do so. 
 
 Select the save option from the File menu. The Save as  dialog box gets invoked as 
displayed in figure below: 
 

 
 
 Enter a filename in the File name box and click on the Save button. By default the new 
document is saved Word document with an extension.doc.   
  

Alternatively, you can click on the Save button on the standard toolbar or press Ctr+S 
to open the Save as dialog box. 
 
Saving a File in a Specific Location: 

To save a file in directory other than the default directory, which is the directory that 
is highlighted in the directory list of the Save as dialog box, select the name of the directory 
in which you want the document saved and click on the OK button. 
 
To specify a different drive on which to save your file, follow these steps: 
 

 Click on the Save in the text box in the Save as dialog box. 
 A list of available drives will be displayed Selected the drive on which you want to 

save your file by clicking on it.  
 Click on the Save button to complete the process. 

 
Auto save feature: 

Word has an Auto Save feature which saves your documents after every 10 minutes 
automatically. To utilize Auto Save for the document more often than every 10 minutes, the 
steps are: 
 

1. Click on the Tools Option in the Save as Dialog box and click on Save Options. Save 
dialog box is displayed as shown in figure below: 
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2. Select the Save tab and select the Save Auto Recover into every option. 
3. Decrease the number of minutes by suing the decrement / increment button or by 

typing different number in the text box. 
4. Click on OK. 

 

 
 
3.3.3 Page Setup  

Page setup can be used to change page orientation, set left, top, bottom margins, pages 
sizes etc. To change page size and orientation 
 

1. Select the Page Setup option of the File menu. The page setup dialog box gets 
invoked as displayed in the figure. 

 

 
 



54 
 

2. Select the Margins tab. 
3. In the orientation area, select Portrait of Landscape. After selecting, see the preview 

area to get an idea of the appearance of page with the text. Figure above shows page 
orientation as Portrait. 

4. To close the Page Setup Box Click on OK button. 
 
Setting Margins  

1. Select the Page Setup option of the File menu. The Page Setup dialog box gets 
invoked as displayed in figure below. 

2. Select the margins lab. 
3. Enter the measurement in the Top, Bottom, Left and Right boxes. 

 

 
 
4. Click on the OK button to close the dialog box. When you set margins, Word applies the 
measurements to all the pages in a document unless your select text or divide the document 
into sections. 

 
3.3.4 Print Preview: 

Previewing a document means viewing a screen representation of one or more pages 
before you print them. To print preview a document, the steps are:  
 

1. Select the Print Preview option from the File menu. Alternatively, click on the Print 
Preview button on the standard toolbar. The Print preview window gets invoked as 
displayed in the given figure. 

2. Use the Magnifier button or select the Zoom option from the view menu to enlarge 
the document.  

3. By default, the ruler bar is not displayed in the Print preview, to adjust margins and 
indents by using the ruler bar. 

4. In the print Preview select the Ruler option from the view menu. 
5. Click the Magnifier button on the toolbar to close the Zooming. 
6. Position the Mouse pointer on the Margin. 
7. Move the mouse pointer until it changes to a black double headed arrow.  
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8. Click and drag the arrow left to right (in the horizontal ruler) or up to down (in the 
vertical ruler)  

 

 
 

9. Click on the Close button of the Print Preview toolbar to close the Print preview 
window. 
 

3.3.5 Printing of Documents: 
 To print a document, follow these steps: 
 

1. Select the Print option from the File 
menu. Alternatively, click on the 
Print toolbar button of the standard 
toolbar. If printer is installed on the 
computer, Print dialog box gets 
invoked as displayed in the given 
figure. 

2. In the Name box, selected the printer 
on which your document gets printed. 
If printer you use has options you can 
access them by clicking on the Properties option from the File menu. 

3. Click on the Print to file check box to print the document to a file on the disk. 
4. Enter the Number of copies to be printed in the Copies area.  
5. To print a range of pages, specify the portion of the document you want to print in the 

Page Range box. 
6. Click on the Pages radio button to include the page numbers or the page range, or the 

page numbers or the page range, or both.  
7. To print a complete copy of he document copy of the document before the first page 

of the next copy is printed, click on the Collate check box. 
8. If you want to print all the copies of the first page and then print all the copies of 

subsequent pages, clear the Collate check box. 
9. Click on the OK button to send the copies to the printer. 
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To Print in the Reverse Order: 
1. Select the Options tab from the Print Dialog Box. 
2. Print tab in the Options dialog box will be displayed. 
3. Click on the Reverse Check box under printing options area. Word prints the 

document in the reverse order, beginning with the last page. Do not select this option 
when you are printing an envelope. 

4. Select the Draft output check box in the Options dialog box to print a document in 
draft quality. 

 
3.4  Text Creation and Manipulation: 
 There are several types of Word documents you can start from like blank document, web 
page and template. Blank document should be used when you want to create a traditional 
printed document. Use a template when you want to reuse text custom toolbars, macros, 
shortcut keys, styles and AutoText entries. The text can be copied, moved to a different 
location. Basic cut, copy and paste features of windows can be used here. Text can be aligned 
in different ways. 
 
3.4.1  Document Creation  
 MS Word allows you to create a document from the keyboard and save it on the disk. 
Follow these steps to create a document. 
 

1. Select the new option from the file menu of the menu bar. Task Pane with various 
options will be displayed as shown below. 

2. You can create Blank Document, XML, Web Page and e-mail message or template. 
 

 
 
3. Click on the Blank Document Icon. 
4. A blank new document is displayed. 

 
3.4.2 EDITING TEXT: 
 This section includes how to insert, delete, modify and copy text. You can undo or redo 
the edits in a Word document by using the Undo or Redo options. Before you can start 
editing, the cursor must be moved to the location where the changes have to be made. 
Following Table lists the arrow keys used to move around in a document  
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WORD-WRAP FEATURE: 
Consider the following paragraph: 
 When the end of the lines is reached, word automatically wrap text, eliminating the need 
to press the Enter key until you want to start a new paragraph. 
 
Inserting Text: 
 Word is normally in the insert mode. The insertion point always stays with the text area. 
As you type in the text, it is pushed to the right and down. Pres insert from the keyboard to 
put Word back into the insert mode. A character is deleted by pressing either the Backspace 
or Del key. The del key removes a character from the current cursor position, the backspace 
key removes the character to the left of the cursor one position to the left. To insert a line, 
position the cursor at eh beginning of the liner or at the end of the line and press the Enter 
key.  
 
Undoing Edits: 
 The undo command is used to reverse actions. Suppose you have drawn a circle of radlus 
4 cm and you decide to delete it. Select the Undo option from the Edit menu, or click on the 
Undo button of the standard toolbar to do so.  
Alternatively, press Ctr+Z . 
 
Redoing Edits: 
 The Redo option is used to reverse the last Undo. To redo a change, select the redo 
option from the Edit menu, or click on the Redo button of the Standard toolbar.  
Alternatively, press Ctr+Y. 
 
3.4.3. TEXT SELECTION: 
 Text can be selected by using the mouse, the keyboard, or both 
 
To select one word: 
 Place the insertion point on the word and double-click on it. 
 
To select a sentence: 
 Hold down the Ctrl key while clicking anywhere in the sentence. 

Arrow Key( Short Cut keys) Functions 

Up arrow, Down arrow, Left arrow, Right arrow  One character up, down left and right  

Ctr+Right arrow  Next word 
Ctr+Left arrow Previous word 

Home Beginning of the line 
End End of the line 
Ctr+Home Begging of the Document  

Ctrl+End End of Document 
Ctr+Page up Previous page 
Ctr+Page Down Next page 
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To select a paragraph: 
 Place the mouse pointer in the selection bar and double-click on it. 
 
To select specific text: 
 Click and drag the I-beam pointer over one character, one word or the entire screen as 
desired. 
 
3.4.4 CUT, COPY AND PASTE: 
 These tools of word are most extensively, used to copy move text from one place to 
other. To use them text must first be selected the Cut option from the Edi menu, or click one 
the Cut button of the standard toolbar. Alternatively, select the text and press Ctr+X. 
 
Moving Text: 
 To move text from one point to another, the steps are: 
 

1. Select the text to be moved. 
2. Select the Cut option from the Edit Menu. 
3. Position the insertion point where you want the text to appear. 
4. To paste the text to the required position select the paste option from the Edit menu, 

or click on the Paste the text to the required position. 
 
Copying Text: 

It is possible to copy text to another part of the same document of in a different document.  
 

1. Select the text to be copied 
2. Right-click on the highlighted text. A shortcut menu appears near the highlighted text 

as shown in figure below: 
 

 
 

3. Select the copy option from shortcut menu. 
4. Move the insertion point to the location where you want to paste the next. 
5. Select the paste option from the Edit menu to paste the selected text in the desired 

location. 
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3.4.5 Spell Check  

Word checks your spelling and grammar as you type. Spelling errors display with a 
red wavy line under the word. Grammar errors display with a green wavy line under the error. 

If you want to spell check your entire document, press F7 and click the spelling icon , or 
choose Tools > Spelling and Grammar from the menu. If you want to spell check part of your 
document  highlight the area you want to spell check. Then press F7 and click the spelling 

icon , or choose Tools > Spelling and Grammar from the menu 
 
3.4.6 Thesaurus 

The Thesaurus is used to find meaning of the word from different dictionary.If you want 
look up words in the thesaurus of another language. If, for example, your document is in 
French and you want synonyms, click Research options in the Research task pane, and then 
under Reference Books, select the thesaurus options you want 

 
1. On the Tools menu, click Research. 
2. In the Search for list, select Thesaurus. 
3. Press ALT and click the word you want to look up. 
4. Results appear in the Research task pane. 
5. To use one of the words in the list of results or to search for more words, do one of 

the following:  
a. To use one of the words, point to it, click the down arrow, and then click 

Insert or Copy. 
b. To look up additional related words, click a word in the list of results. 

3.5  Formatting the Text  
 Text that has been written can now be made elegant with the help of 
formatting. Bullets and numbers highlight the portions that you want to highlight. 

 
3.5.1 Font & Size selection: 

Font refers to the manner or style in which text is displayed in the document. 
Different fonts contain different collection of characters and symbols. Word offers many 
ways to change fonts and font styles. The text to be formatted needs to be selected first. 
Follow these steps to change fonts and font styles.  
 
 Use the drop-down font list on the format toolbar as displayed in the figure below or 

type the name of the desired font name box on the toolbar and press the Enter key. 
 
 Use Bold(B), italics(I), Underline(U) buttons on the format toolbar. 

 
 To add bold formatting to the text, follow these steps: 

 
 Select the text and click on the Bold button. 

 
 Alternatively, click on the bold button and type the text. Similarly, the characters can 

be underlined and italicized.  
 



60 
 

 
 

 
Changing Font Size: 
 Font size is measured in points and picas are used for measuring spacing, line 
thickness, and so on. There are 12 points to a pica and six picas to an inch; therefore, there 
are 72 points to an inch. Normal template the font size, follow these steps: 
 

Use the drop-down front size on the formatting toolbars, type the font size, in 
the font size box on the format toolbar and press the Enter key. 
 
Use any of these keyboard shortcuts to increase or decrease the font size. 
 To increase the Font size select the matter and press Ctrl+Shift+> keys. To 
decrease the font size select the matter and press Ctrl+Shift+< keys. Alternatively 
you can use Ctrl+] or Ctrl+[ to increase or decrease the font size. 
 
Use the font dialog box: 
 Font dialog box contains most comprehensive collection of formatting options. 
To open the font dialog box, follow these steps: 
 

1. Select the font option from the format menu. A font dialog box gets invoked as 
displayed in figure given below. 

2. Select any option from the Font Style scroll list. You can apply one or more of 
these styles to the selected characters and to the subsequently typed text. Click 
on the Regular option to remove the effects. More than one style can be 
combined. 

3. In the Effect area, a black check mark on an option in indicates that all the selected text 
exhibits that particular attribute. A completely clear box for an option indicates that the 
selected text does not have the specific attribute and a grey check mark indicates that 
some of the text does not some of the text does not exhibit the character formatting 
option. 
 

 
3.5.2 Alignment of Text  
 Alignment is a way of organizing the text. It refers to the position of the text relative 
to the margins. Word enables you to left-align, right-align, centre-align and justify the text in 
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your document in order to enhance it. Certain lines, like the main heading, might need to be 
center aligned; subheadings might need to be aligned left. You can do this by using the four 
formatting toolbar buttons as displayed in the figure below; word’s default alignment is left 
alignment. It is a good policy not be use space to center your text. Type the text at left 
margin and press the Center button to center your text.    
 

 
 
Right-Aligned Text: 
 Text is said to be right-aligned with the right margin of the page. This is the default 
mode of alignment. To left-align a paragraph, position the cursor on any line within the 
paragraph and click on the Align Right button on the Formatting toolbar. 
 
Left-aligned Text: 
 Text is said to be left-aligned if it is aligned with the margin of page. This is the 
default mode of alignment. To left-align a paragraph, position the cursor on any line with the 
paragraph, and click on the Align Left button on the formatting toolbar as displayed in the 
figure of Aligning Text paragraph. 
 
Centered Text: 
 The center option is normally used to center the heading and text; to center a line of 
text position the cursor on the line and click on the Center button on the formatting toolbar. 
 
Justified Text: 
 This feature aligns a paragraph 
with both the left and the right 
margins. Inter-word spacing is 
adjusted such that each line of text 
begins at the left margin and ends at 
the right margin. To justify a line of 
text, position the cursor on the line 
and click on the justify button on the 
formatting toolbar. Figure below 
illustrates different alignments.  
 
 
3.5.3 Paragraph Indenting: 
 In word, each time you press the Enter key you create a new paragraph. Word 
paragraph always end with a paragraph mark when you open a new document, the default 
paragraph setting stored as style (Normal) is applied. You can press Shift+Enter combination 
of keys to force new lines without starting a new paragraph.   

  
Line Spacing: 
 Spacing can be used to design your document and make it more readable. The default 
spacing is single. Word enables you to change the line spacing in your can set spacing to 
single, double or one and half lines. 
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To set the line spacing, follow these steps.  
1. Select the paragraph option on the Format menu. The paragraph dialog box gets 

invoked as displayed in given figure.  
 

2. Select the Indents and Spacing tab. 
 

3. Select an option from the Line spacing drop-down list. 
 

4. Select a value from the At box. 
 

5. Click on the OK button of the dialog box. The preview area for getting an idea of 
formatted text will be displayed. 

  

 
 
Paragraph Spacing: 
 You can define the amount of white space placed before and after paragraphs by 
giving values in the spacing area of paragraph dialog box. 
 
Indenting Text: 
 Indenting is making your text look more eye-catching. Indents are added to margins, 
thereby increasing the white space and decreasing the text area for specific paragraphs, to set 
the indents for text by using the dialog box. 
 
  Enter the specification for left, right and/or first line indents in the indentation area of 
paragraph dialog box. 
 
 Select an option from the Special drop-down list. Click on the OK button. Every paragraph in 
the document will shave the same indentation settings. 
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Hanging Indents: 
  When you create a bulleted list, numbered paragraphs or bibliography, you want the 
first line of every paragraph to stick out. The first line in an hanging indent is called a 
hanging indent is called a hanging indent. The subsequent lines beneath are called turnover 
lines. Word can also create hanging indents for bulleted and numbered lists. 
 
Creating Hanging Indents Using a Ruler: 
 To create hanging indents by using the ruler, you need to follow the steps listed hereunder: 
 

1. Place the insertion point in the paragraph you need to format, or select multiple 
paragraphs.  

 
2. Drag the button half of the left indent marker to the right. This will set the position of 

the left (indented) edge of the turnover lines. 
 

3. Drag the top half of the left indent marker to the left past the turnover indent. 
 

4. Release the mouse button when you reach the desired point for creating the hanging 
indent. The hanging indent is created. Figure illustrates the hanging indents. 

 

 
 
Creating Hanging Indents Using Keyboard Shortcuts: 
 There are keyboard shortcuts for moving the left indent. Movements in the increments 
are used for default tab settings (usually 0.5 inch). Press Ctrl+M to move the left tab marker 
to the right margin. Press Ctrl+Shift+N to move the marker to the left margin. 
 
3.5.4 Bullets and Numbering: 
 You can use bullets and numbers to make the lists in your document attractive and 
easy to read. You can bullet or number your lists by using either the formatting toolbar  
 
To get Bullets or numbers automatically as you type your list: 

1. Type an asterisk (*) and a space or a tab. 
2. Enter Text and press the Enter key.  
3. Word turns the asterisk into a bullet and sets the spacing.  

 
In the same way you can do for numbered lists. You can also bullet a paragraph by clicking 
on the bullet list button. 
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To Change the bullet style, follow these steps   
1. Type a list of your favourite authors.  

 
2. Select the Bullets and Numbering option of the format menu. The bullets and 

numbering dialog box gets invoked as displayed in figure below.  
 

 
3. Click on the Bullets tab in the Bullets and Numbering dialog box. 

 
4. Click to select a style of your choice. 

 
5. Click on the OK button. 

 
 

 
 
 
 
To Specify Custom Bullets, follow these Steps:  
 

1. Click on the Customize button in the Bullets and Numbering dialog box. The 
customize bulleted list dialog box is displayed as shown in figure below. 

2. Change the bullet and text position according to your requirement.  
 

3. Select the bullet from the bullet character list.  
 

4. To use bullets not shown in the bullet character box, click on the Font button. 
 

5. Click on the OK button to close the customize bulleted list dialog box. 
 

6. Click on the OK button to close the bullets and numbering dialog box. 
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3.5.5 Changing Case: 
 
To convert the case of the text you shave inserted followed these steps: 

1. Selected the text you want to change. 
 
2. Select the Change case option from the format menu  
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A change case dialog box is displayed on the screen below: 
 

 
 
 
The change case dialog box has the following options: 
 

1. Sentence case  : Capitalize only the first letter in the selected sentences. 
 

2. lower case  : Converts all selected text to lowercase letters. 
 

3. UPPER CASE  : Converts all selected text to uppercase letters. 
 

4. Title Case  : Converts first character of each word to uppercase letter. 
 

5. tOGGLE cASE : Changes uppercase to lowercase and lowercase to uppercase 
in all    

 selected text. 
 

3.6 Table Manipulation: 
 
Tables help you to organize complex columnar 

information. You can use tables to create divers 
documents and forms, television scripts, financial 
reports, catalogs and resumes tables are made up of rows 
and columns. Rows are the horizontal lines, columns are 
vertical lines and their intersection makes a cell the 
content of cell can be formatted with the same methods 
as are used to format any text. 
 
3.6.1 Draw table  
To crate a table, follow these steps: 
 

1. Place the insertion point where you want to place 
the table. 

 
2. Select the Insert table option from the table 

menu. Alternatively, click on the insert table 
button of the standard toolbar and drag the mouse 
over the palette to create a table with the 
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highlighted number of rows and columns.  
 

3. The insert table dialog box is invoked which is shown below. 
 

 In the Number of Column box, type the desired number. 
 In the Number of Rows box, type in the desired number. 
 Click on the Auto format button. A table auto format dialog box gets invoked as 

displayed in the figure below:  
The table auto format dialog box lets you select the style of the table you want to create. 
Alternatively, follow these steps. 
 

1. Position the insertion point in the table. 
 

2. Select the table auto format option from the table menu the table auto format dialog 
box gets invoked as displayed above. 
 

 
3. From the Table styles scroll box, any predefined border and shading style can be 

selected. 
 

4. Select the auto-fit check box to automatically adjust the size of the table to fit its 
contents. To automatically fit the contents the options given are fit to content, fit to 
width and fit to window. 

 

 
 

5. With the Modify option you can change the Borders, Shading, Font or Color in the 
selected table. 

 
6. In the apply special formats to area, select the corresponding check box to apply the 

special formats. The table is formatted as per requirements.  
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3.6.2 Changing Cell width and Height: 
 Cell width and height can be changed in several ways. 
 
To Change the column /row width / height in a table 

Rest the pointer on the column / row boundary you want to move until it becomes, 
and then drag the boundary until the column / row is the width/height you want. 
 
To change a column / row with / height to a specific measurement: 
  Click a cell in the column / row. 
  On the table menu, click Table Properties and then click the Column / row tab. 
  Choose the options you want. 
 
To make the columns / row in a table automatically fit the contents: 
  Click a table 
  Point to Auto-fit on the table menu. 
  Click Auto fit to contents. 
 
3.6.3 Alignment of Text in Cell: 
  The text in the cell can also be aligned with the same process as normal text. First of 
all select the text in table and then click on the desired alignment icon. Selecting text in a 
table in similar to selecting text in a document. You can drag the I-beam pointer over the text 
to select it, or click on the selection bar to select an entire row. 
 
Some specified techniques to select text in a table are as follows: 
  To select one cell, triple-click on that cell, or click on the left inside edge of the cell.  
Select an entire row by clicking on the selection bar to the left of the table; drag up or down 
to select more than one row.   
To select an entire column, place the mouse at the top of the column. The pointer changes to 
a black down arrow. Click on it to select the column. 
To select the entire table, place the insertion point in the table and select the select table 
option from the table menu. 
 
3.6.4 DELETE / INSERTION OF ROW & COLUMN: 
  The table’s format can be changed to fit the data that is to be displayed in the table. 
You can add or delete rows and columns in a table as per you requirements. 
 
To delete cells  

1. Select the cells to be deleted. 
2. Select the Delete cells option from the table menu. The Delete cells. 
3. Select one of the following options in the Delete cells dialog box 

 
Table – To delete the entire table. 
Column – To delete entire column in which cursor is present. 
Rows - To delete entire row in which cursor is present. 
Cells – To delete selected cell. 
 
To delete a row: 

 Select the row to be deleted. 
 Select the Delete rows option from the table menu. 
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To delete a column: 

 Select the column to be deleted. 
 Select the Deleted columns option from the table menu. 

 
Inserting Rows and Columns: 
To insert a row in the table, follow these steps: 

1. Place the insertion point in the row below where you want the new row. 
2. Select the insert rows option from the table menu. Alternatively, click on the Insert 

Rows button of the standard toolbar. 
 

You can also either of the following methods to add a row or column: 
1. With the insertion point in the last cell, press tab to add another row at the end of a 

table. 
2. Select the right side of the column and select the insert column option from the 

shortcut menu (Right-click on the mouse button to invoke the shortcut menu) as 
displayed in the figure given below: 

 

 
 
3.6.5 Borders & Shading: 

By default, table borders are inserted when you insert a table in a document. They get 
printed with the document. If the default is removed, the table’s gridlines are displayed. 
Gridlines option from the table menu to toggle the display of gridlines in a table on the 
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screen. Word has many paragraph and border shading features. You can apply borders and 
shading to single paragraphs or to a group of paragraphs. 
 
To change border to a specific type, 

1. Click a cell in the column/row. 
2. On the table menu, click table, properties and click the Border and shading tab. 
3. Choose the options you want. 

 
Check your Progress: 
Q.1 How to start Ms-Word? 
Q.2 What is the use of thesaurus 
Q.3 What does Standard Toolbar Provides?  
Q.4 How do you create documents? 
Q.5 How do you save document? 
 
3.7 Summary: 
 

 Microsoft office is a software package that offers new features for sharing data and 
documents, better-than-ever communication tools, internet/ intranet access and 
publishing capabilities. 

 
 There are many ways to start Microsoft Word. The most common are the Win2K start 

Menu or the Office shortcut bar. 
 

 There basic components of the default word screen are: 
o Title bar, Menu bar, Ruler bar, Status bar, Workspace, Taskbar, View buttons, 

Insertion point. 
 Word’s file finding utility helps you to locate, list, sort, examine, open and print 

documents on simple and complex criteria. 
 Word has three kinds of Online help 

o Office Assistant, Topic-specific Help, Point and shoot Help 
 Word automatically wraps the text, eliminating the need to press the Enter key until 

you want to start a new paragraph. 
 

 Select the Paste option from the Edit menu to move the text from one point to another. 
 

 Select the Change case option from the Format menu to change the text case. 
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Chapter-04 
 

Using Spread sheet 
 
 4.0 Introduction  
4.1 Objectives 
4.2 Elements of Electronic spared Sheet 
4.3 Manipulation of Cells  
4.4 Formulas and Function  
4.5 Summary 
4.6 Model Answers 
 
4.0 INTRODUCTION: 

MS-Excel is an electronic spreadsheet. A spread sheet is a generic term for the 
software package that simulates a paper worksheet often used by people in management. 
Most spreadsheets started as electronic versions of hard copy accounting worksheets with one 
major purpose- simple row and column arithmetic. It has various features to offer namely, 
fast calculations, what if analysis, charts (also called graphs), automatic recalculations, and 
many more. 
 

A variety of applications for which MS-Excel can be used include automating 
financial statements. Excel comes across as a powerful and flexible graphical presentation 
tool. Data stored in database formats can be accessed through MS-Excel. Graphs or charts 
can be created based on data for quick assessment of a situation.  
 
4.1 OBJECTIVES: 
After going through this unit, you will be able to: 

 Understand the features of Excel 
 Navigate worksheets  
 Make different types of entries in a worksheet 
 Create text, numbers & data series 
 Manipulate cells 
 Create small budgets/ sales reports 

 
4.2 Elements of Electronics Spread Sheet: 

When you start Excel, workbook is displayed. It is here that Excel stores all its data 
and allows manipulation. A workbook is a collection of individual worksheets, each of which 
can hold data. All actions and operations of Excel take place in the worksheet. Excel has 
65536 rows and 256 columns in its worksheets. 
 
4.2.1 Opening of Spread Sheet 
Microsoft Excel can be started in following way: 

1. Click on Start button in the Windows environment. 
2. Select Programs option from the Start menu. 
3. Select Microsoft Excel option from the Programs submenu. The following screen is 

displayed. 
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It has user interface features common to other Microsoft Office Application. Each 
worksheetis made up of cells that are the basic units for storing data. 
 
Naming the Sheets: 

Excel has its worksheets named as sheet1, sheet2, sheet3 and on. Sheets can be given 
other names which may prove to be more convenient for task identifications; for example, 
workbook1 may contain sheets called Student, Mark sheet, Attendance and so on. 
 
To name a sheet, follow the steps 

Double-click the sheet tab to which you want to give a new name. 
The rename dialog box gets invoked where the new name can be specified.  
Or  

1. You could go to the sheet tab and click on the right mouse button. 
2. Select rename.  

Once the dialog box is displayed, give the new name and click on the OK button. 
 
4.2.2 Addressing Of Cells 

Each worksheet is made up of cells, and cells are a result of intersection of rows and 
columns. They are the basic units for storing data. Each cell gets its name from this 
intersection. The address of a cell that is in column A and has its row number as 4 is referred 
to as cell A4. A group of contiguous cells is called a range. An example of a cell range would 
be G1:G3. 
 
Cell A1, A2 contains the table Chandan, Yashpal. 
Cells B4 and C4 contain the value 400 and 800 respectively. 
Cell G4 contains the formula = C4-B4. 
Pressing the Enter key will result in G4 holding the result of the formula = (C4-B4). 
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All formula entries should begin with an = (equal to) sign. 
You can make a cell active by clicking on it. Files created by a spreadsheet package are 
known as worksheets. Automatic recalculation feature hastens the calculation tasks. If data in 
cell C4 is changed from 800 to 900, then the formula in cell G4 would calculate the result 
based on the new C4 cell content. This is due to the fact that, once the formula is created with 
cell references in it, it establishes a relationship with the specified cell references or address. 
You can move around in a worksheet with the aid of a mouse or the keyboard, or by using the 
menu bars. You can use the arrow keys, page up, page down and a host of other keys in 
combination, to move around in the worksheet. 
 

 
 
To move in the worksheet by using the menu bar:  

Select the Go to option from the Edit menu or press the F5 function key to open up 
the Go to dialog box and E2, type the reference of the cell, click on the OK button of the go 
to dialog box. The cell pointer moves to cell E2 immediately. 
 
To move in the worksheet using the Mouse:  

Select the cell you want to activate. Place the mouse pointer on it. Click to activate it. 
Several cells can be grouped to from a cell range, cell ranges are required to be selected for 
calculation and clicking on each one of them becomes a very tedious task. Cells can be 
selected using keyboard, mouse. To select a cell range for an instance, you can do the 
following: 
 
Using Keyboard: 

1. Move the cell pointer at the corner of the cell range which you want to select. 
2. Click on the starting cell of the range 
3. Press and hold down the shift key and then press the arrow keys to select the range. 

 
Using Mouse: 
 

1. Click on a corner of the range you want to select.  
2. Drag the mouse over the range. 
3. When you reach the end of the range, release the mouse button (refer figure) 
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4.2.3 Printing of Spread Sheet: 

Excel offers you various printing options for your worksheets. It enables you to have 
a preview of worksheet data with the aid of the Print preview option. You can set margins, 
fonts, headers and footers to enhance you worksheets.  
 
Printing an Area  

By default, Excel prints the current worksheet when the Print command is selected from 
the file menu. However, if you require a particular area of the worksheet to be printed, then 
you are offered this facility also. To dos, you can follow these steps: 
 

1. Select the range that you want to print. 
2. Select the print option from the file menu. 
3. The print dialog box gets invoked as shown in figure below. 
4. In the Print what section of the dialog box, choose the selection option. 
5. Select the OK option to complete the procedure. 

 
Defining and Deleting a Print Area 

There may be situations where you need to print the same range repeatedly. To avoid the 
tedium of specifying the same range for printing several times, you can conveniently define 
ranges as the print area. 

1. Select the area you want to specify. 
2. Select the Print area option from the file menu. 
3. Select the Set print area from the Print area submenu as shown in the figure below. 
4. Select the Print option from the file menu. 
5. Click on the OK button. 
6. You can select Clear Print area when you want to remove the defined Print Area.  

 
To print worksheets, the steps are: 

1. Select the Print option from the file menu. This invokes the print dialog box. 
2. This dialog box is very similar as you used in the Ms-Word Print dialog box. The only 

difference is the three extra button which are given below: 
 
Selection – prints selected cells: 
Active sheet(s) – prints only selected worksheets. 
Entire workbook – prints open workbook. 
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Printing Worksheets: 
Worksheets can be very conveniently printed by the use of the Print command that 

sends your worksheet pages to the printer immediately. 
 
Device Options:  

Controls the print quality and allows you to adjust printer memory tracking (this 
affects how the driver tracks printer memory usage). 
 
4.2.4 Saving Workbooks: 
 

Whenever workbooks are created, they are named, by default as workbook1, 
Workbook2 and so on. Saving the worksheets of these workbooks makes them permanent. To 
save the work on you worksheets, you should follow the steps: 
 

 
 

1. Select the Save option from the file menu to save it the disk. 
2. You can also click on the save button on the standard toolbar. 
3. Name the file you have saved and specify the location at which the workbook should 

be placed. 
 
Saving Multiple Files 
 When you have a number of files that are open, you very convenient save them all. 
You can select the Exit option from the File menu and click on the Yes to all button in the 
Save as dialog box that is displayed. 

 
Saving as an Html File: 

Excel allows you to publish you workbook data on the web and even move to other 
files by using hyperlinks. 
You can also save an excel worksheets as an HTML file for publishing on the World Wide 
Web. To do so, you can select the Save as HTML option. 

 
4.3 Manipulation of Cells 

Active cell is indicated by a rectangle boundary over that cell. Data entry is 
accomplished by feeding the data in the active cell. A1 is always the active cell in a new 
worksheet by default, but if you want to move on to another cell for data entry, then you can 
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make that cell active by moving the mouse pointer on it and clicking on it. As you type, the 
data is displayed in the active cell as well as in the formula bar. 
 
4.3.1 Entering Text, Numbers & Dates: 
Entering Text: 

Text entries can be numbers, letters or symbols. Numbers can also be treated as text, 
especially in cases where calculations are not required; for example, telephone numbers, 
record numbers, zip codes, roll numbers and so on.  
 

Excel studies the entered data to determine the type. If you type an address which is 
alpha-numeric in nature, it is automatically taken as a text entry, for example, Electronics 
Niketan, 6 CGO Complex, New Delhi-110003.   
Numeric entries that are to be treated as text should be preceded with an apostrophe; for 
example, 64. it is them considered as text entry. 
 
Entering Numbers: 

Data and time entries can also be made in Excel worksheets. Excel allows calculation 
on dates because it converts the entry to a serial date number; for example, you can find out 
the age of a person by reducing the current date from his date of birth. Excel recognizes date 
and time only when they are specified in the right formats. 
 
Valid Date Format Valid Time 
6/10/,6-OCT, 6-OCT, OCT-612:30:20 am 
 
4.3.2 Creating Text, Number and date series: 

You may sometimes find yourself in a situation where you need to key in a series of 
text, dates, time or numbers. A time series, for example, can include increments of days, 
weeks or months. It can include repeating sequences such as weekdays, month or quarters. In 
such cases, specifying the initial time selections and the last value of the series would result 
in the entire series being generated automatically by Excel. A few examples of time series 
have been given below: 
 
Initial Selection  Extend Series  
1,2    10:00, 11:00, 12:00 
Mon    Tue, Wed, Thursday 
Jan     Feb, Mar, Apr 
 

You can also generate liner series and growth series by selecting the initial values for 
the series and positioning them in the first two cells of the range of cells of the range of cells 
to be generated. Examples of linear and growth series are given below  
 
Initial Solution    Extended Linear Series 
1, 2    3,4,5 
100, 95    95, 85 
1, 3    5, 7, 9 
 

 Auto-fill feature (Auto-fill handle is the small plus sign at the bottom right corner of 
the active cell) 

 Menu bar 
 Shortcut menu 
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Creating Text Series 
 

To fill a range of cells with text entries, such as days months, and so on or fill a range of 
cells with text using the Auto-fill feature, follow the steps: 
 

1. Enter the first value in the cell which would be at the beginning of the series, and 
select the cell. 

2. Drag the Auto-fill handle across the cell that you want to fill. 
3. Release the mouse button. 
4. Excel files the range of selected cells with the appropriate text entries. 

 
Use the menu bar to perform the same task by following these steps:  

1. Enter the first value and select the range to be filled. 
2. Select the fill option from the Edit menu. 
3. Select the series option from the fill submenu. 
4. Indicate whether you want to fill you series in rows or columns. 
5. Specify the type of series you want you create – Liner, Growth, Date or Auto-fill  
6. You can now specify the step and the stop values. 
7. You can create series such as: 

 
4:00, 5:00, 6:00, 7:00 
Redg100, Redg101, Redg102 
Jan, Feb, Mar 
Sun, Mon, Tue 
North, South East, West 
 

The method for entering series of dates, series of numbers is same as given above. 
You can enter a series of numbers or series of dates where increments and decrements of 
numbers is by a specific value. Suppose you want to generate a list of even numbers. You can 
do it in the following ways: 
 
Using the Auto-fill Feature 
 

1. Enter the number 2 or any date in the first cell and the number 4 or any other date in 
the second cell. 

2. Select both the cells. 
3. Drag the Auto-fill handle over the range of cells you want to fill. 
4. Release the mouse button. 

 
Excel fills the range of cells with the appropriate entries. 
You can also use the series option from the fill submenu of the Edit menu for generating a 
series of numbers. 
 
4.3.3 Editing Worksheet Data: 

 
The data that exists in cells may require some editing, such as moving data from one 

location to the other, clearing cell contents and so on. You can edit the contents of the cell by 
using the formula bar or the In-cell editing option as described below: 
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Formula bar Method: 
1. Select the cell you want to edit. 
2. Click on the formula bar or press the F2 function key. 

 
In-Cell Editing: 
To edit the contents of cell: 
The insertion point appears at the end of the cell which can be moved to he required position 
for editing. 
 
Clearing a Cell: 

To clear a cell is to erase the cell content but it is not similar to deleting a cell. 
Deleting a cell or cells causes the other cells on the right or bottom to shift positions. Clearing 
cells, on the other hand, does not cause the other cells to shift. There are different ways of 
clearing cell contents. 
 
(i) To clear a cell using shortcut menu: 

1. Highlight the cell or range of cells to be cleared. 
2. Click on the right mouse button. 
3. Select the Clear Contents from the shortcut menu. 

 

 
(ii) To clear the cell contents by using the Delete key, follow the steps: 
 

1. Select the cell and use the Delete key to clear a cell. 
2. Excel clears all the data from the cell, but does not change cell formatting. 

 
(iii) To clear the contents of a cell using menu bar, follow the steps: 
 

1. Select the cell option from the Edit menu. 
2. Select the Clear option from the Edit menu. 
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 Contents-clears the cell contents 
 Comments- clears the cell comments in the cell 
 All – to clear everything from the cell, including formatting and cell Notes. 
 Formats – to clear only cell formatting form the cell. 

 
Copying Data 

To create multiple copies of worksheet data, you use the copy and paste feature of 
Excel. This makes it easier to copy the contents of the cells than typing the data all over 
again. The task can be accomplished in several ways. 
 
(i)   Using the menu bar, you need to: 

1. Select the cell or range of cells having the cell contents that are to be copied  
2. Select the copy option from the Edit menu. 
3. Select the cells in which you want to paste a copy of the data. 
4. select the past option fro the Edit menu or press Ctrl + V 

 
 

 
 
(ii) You can use the shortcut menu to copy and paste by following the steps: 

1. Select the range of data that you want copy. 
2. Click on the right mouse button 
3. Select copy from the shortcut menu. 
4. Select the cells in which you want to paste your data.  
5. Click on the right mouse button again and select the paste option from the shortcut 

menu.    
 
Drag and Drop Method: 
(iii) To use the drag and drop method to copy and paste data, follow these steps: 

1. Select the cells or range of cells that contains the data you want to copy 
2. Position the mouse pointer on the Fill handle. 
3. Drag the fill handle over the adjacent cells. 
4. The cell contents would be copied in the adjacent cells. 

 
(iv) To Auto-full Command enables you to copy to adjacent cells. To do so, you can 
follow these steps: 

1. Select the cell or range of cells that contains the data you want to copy. 
2. Position the mouse pointer on the Fill handle. 
3. Drag the Fill handle over the adjacent cells. 
4. The cell contents would be copied in the adjacent cells. 
5. Release the mouse button. 
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Cut and Paste 
When you select the cut command to move the data, a copy of the data is stored in the 

window clipboard. Later when you use the paste option, the data is placed in another are of 
the worksheet. The method for performing cut & paste is similar to copy except the fact that 
instead of copy, cut is selected from menu. 
 
4.3.4   Inserting and Deleting Rows, Column: 

You can insert rows, columns, and cell if required. Insertion of rows, columns and cell 
ranges always cause the data already in the worksheet to shift position to accommodate the 
insert object. The method for deleting/inserting rows/ columns similar to deletion/ Insertion 
of cell except that new cell is to be selected. 
 
1a) To insert a column using the main menu, the: 
 Position the cell pointer on the column where you want the new column should be 
inserted Select the column option from the insert menu.  

Excel inserts a new column and the existing columns shift to right  
 
1b) To Insert a column using the shortcut menu, the steps are: 

Position the cell pointer in the column where you want your new column should be 
inserted. 

Click on the right mouse button on the column header and select the insert option 
from the shortcut menu as shown in Figure 5.10 
 
2a) To delete a column using the main menu, the steps are: 
 Click the letter of the column you want to delete. Select the delete option from the 
Edit menu. 

 
2b) To delete a column using the shortcut method, the steps are: 
 Select the letter of the column you want to delete. Click on the right mouse button and 
select the delete option from the shortcut menu. 

 
3a) To insert a row using the main menu, the steps are: 
 Select a cell in the row below the location where the new row should appear. Select 
the now option from the insert menu. 

 
3b) To insert a row using the shortcut menu, the steps are: 
 Select a cell in the row below where the new row should appear. Click the right 
mouse button on the row header and then select insert option from the shortcut menu. 

 
4a) To delete a row using the main menu, the steps are: 
 Select the row which you want to delete. Select the delete option from the Edit menu. 

 
4b) To delete a row using the shortcut menu, the steps are:  

Select the row which you want to delete. Click the right mouse button and 
select the delete option from the shortcut menu. 

 
4.3.5 Changing Cell Height & Width: 

The data that you enter in the cells is sometimes too long for the column width to 
accommodate. You can increase the column width and row height to display the entire cell 
entry. 
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Changing Column Width 
Column width can be changed by using the mouse or the menu commands. 

1. Position the mouse pointer on the right border of the heading of the column that has 
the width to be changed  

2. Press the mouse button and drag it to the right to increase the column width or 
towards the left to decrease the width. 

3. Once the right width has been selected, release the mouse button. 
 
(ii)   To change the column width using the menu bar, the steps are: 

1. Click on the heading of the column that has the width you want to change 
2. Select the column option from the format menu. 
3. Select the width option from the column submenu. 
4. Enter the column width in the column width text box. 
5. Select the OK option 

 
Changing Row Height : 
Change the row height by using the mouse and the menu bar. 
(i)  To change the row height by using the mouse, the steps are 

1. Position the mouse pointer on the heading of the row (where the row numbers are 
specified) having the height you want to change. 

2. Press the mouse button. A double headed arrow is displayed. 
3. Drag the arrow down or up to increase or decrease the row height. 
4. Release the  mouse button when the appropriate height is selected  

 
(ii)  To change the row height by using the menu bar, the steps are  

1. Click on the heading of the row whose height you want to change. 
2. Select the row option from the row submenu  
3. Select the height option from the row submenu 
4. Enter the row height in the row height text box. 
5. Select the OK option. 
 

 
 

A sample of increased column width and row height has been shown in the figure.  
 
4.4 Formulas and Function: 

Excel user’s formulas for calculations. Formulas can be simple as well as complex in 
nature. Charts are introduced in worksheets to make analysis tasks easier. Charts are 
introduced in presentation aid. They not only enhance the worksheet but also allow a user to 
gather a lot of information in much lesser time. 
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4.4.1 Using Formulas: 
Using a formula, expressions can be calculated by typing the formula in the 

appropriate cell: for example, = B4+C5 is a formula that adds the cell content of cell B4 to 
the cell contents of cell C5. The formula must be preceded by an equal to (=) sign. 
 
= 35 * 44 
= 23 ^ 2 
= C5 – C3 
= C1 + C2 + C3 + C4 + C5 
= 53 – D6 * 44/3 
 
Formulas can also contain named cells or cell ranges. Excel formula a functionalities lie in 
the fact that it can relate the formula to the cells referred in it and if the contents of these cells 
change, a new result is calculated with the aid of the automatic recalculation feature. The 
formula entered in an active cell, press the enter key. It is to observe that the cell displays the 
result, and the formula bar displays the formula or expression. 
 
4.4.2 Function: 

Functions are predefined formulas that perform calculations by using specified values 
called arguments is a particular order, called the syntax; for example, the SUM function adds 
the values or ranges of cell 
 
To enter formula that contains a function, follow the steps: 

1. Click on the cell in which you want to enter the formula  
2. To type the formula with the help of function, click on Auto Sum button on the 

Standard Tool bar.      
3. Click on the down arrow, head right next to the Functions box to invoke a drop-down 

list of available functions, which included SUM, COUNT, AVERAGE, MAX and so 
on. 

4. Click on the function you want you want to add to the formula. If the function does 
not appear in the list, click on more Functions. 

5. Enter the arguments for the function 
6. When you complete the formula, press the Enter key. 
7. The other convenient way of choosing functions is by using the Insert function that 

appears on the standard toolbar as fx symbol. 
 

You can also select a function option from the insert menu to select an Excel function. 
Both the actions invoke the paste function dialog box. 
 

The function category list displays Excel’s built-in functions. Select the required function 
from the list. If you are not sure which function to select, there is a Help button in the Office 
Assistant to guide you. 
 
Charts  

Growth rate analysis or monthly sales reports which would be a very tedious job can be 
made quite interesting and time conserving if depicted through charts. To create a chart, you 
must select a range of cells containing both labels and numeric values. Then you can use the 
Chart Wizard button on the standard toolbar, Charts are created as chart sheets in a workbook 
by default or can be embedded in a worksheet. You can create a chart using the Chart wizard 
by following the steps listed hereunder:    
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1. Select a range with numeric data and labels. 
2. Click on the Chart Wizard tool on the standard toolbar. 
3. When the mouse button is released, the chart wizard dialog box gets invoked as 

shown in given figure. The chart wizard then guides you to different steps of creating 
chart of your own choice. 

4. Click on the Finish button to complete the process of creating charts. A chart using 
the default format is drawn. 

5. You can select the next option to go the next step which would show step 2 of 4 
dialog box and in this manner, you can move to step 3 to 4 of dialog box to make your 
charts more detailed and according to your convenience. 

6. The step 2 of 4 dialog box lets you specify your range of data that you want to include 
in the chart. 

7. The Data range tab display the range recognized by the chart. If you need to change, it 
then type in the new range. 

8. The series tab allows you to add and remove a data series. You can also specify the x-
axis labels.  

9. Step 3 to 4 dialog box of the chart wizard has number of tabs. Each one has a specific 
button to perform. 

 
 Titles tab: adds / removes titles to chars. 
 Axes: toggles the axis values on and off. 
 Gridlines tab: displays gridlines parallel to x and y axis. 
 Legend tab: toggles a legends on and off angles it, and place it to the charts. 
 Data labels tab: adds or removes labels and values to series. 
 Data table tab: links or removes source data from the chart. 
 
 
This chart wizard helps you to specify the location as embedded chart on a worksheet, or 

as a chart sheet. 
Select the option as object in and click on finish. Your final chart would be placed on 

your worksheet. 
 

Check Your Progress: 
In the blank area, write the letter of the corresponding terms or phrases: 

1. ____________ provides the information about the setting that are currently being 
as well as for date & time. 

2. ____________ a group of cells on which a operation is to be performed. 
3. ____________ a commonly used calculation that is built into the spreadsheet. 
4. ____________ designates the intersection of a row & column 
5. ____________ contains the main menu and the edit line. 
6. ____________ a number the can be used in mathematical operation 
7. ____________ indicates for operation currently being performed  
8. ____________ an equation entered into the spreadsheet by the user. 
9. ____________ the area when data can be entered or changed. 
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4.5 Summary: 
 

 Spreadsheet is software that simulates a paper worksheet.  
 MS-Excel is a windows based spreadsheet package. Movement in a worksheet 

is possible by using the keyboard, mouse or the scroll bars.  
 Data entry can be of text, numbers, date and time. Series of text numbers dates 

and time can be conveniently created. 
 Saving a workbook saves all the worksheets contained in it. 
 Worksheet can also be saved in different formats; making modification in 

worksheet is possible. Editing a cell or a cell range can do it copying and 
moving data from one place to another in a worksheet can be done.  

 Worksheets can inserted, renamed and deletion of these worksheets is also 
permitted. Column width can be changed by using the format, column and 
width captions.  

 Row height can be altered by using format, row and height option. Charts can 
be embedded in your worksheets by using the chart wizard feature of excel. 
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Chapter 5 
 

Communication using the Internet 
 

5.0 Introduction 
5.1 Objectives 
5.2 Basics of Computer Networks 
5.3 Internet 
5.4 summary 
5.5 model answers 
 
5.0 Introduction 

Computers in organizations have been used to extract and correlate information. 
Resource sharing, high reliability and communication can be achieved by connecting these 
computers. Computer Networks offer better price / performance ratio over mainframe 
computers. Network also delivers services to individuals like access to remote information, 
pay their bills, manage their bank accounts and handle their investments electronically. World 
Wide Web contains information about almost everything. Another important category of 
network use is person to person interaction and Email is already widely used by millions of 
people and now also contains audio, video besides text. Irrespective of its place, Internet can 
be used for a number of purposes like accessing World Wide Web, email etc. 

 
5.1 Objectives 
After Completing this lesson you will be able to, 

 Know the different concepts of Local Area Networks 
 Become familiar with WAN terminology. 
 Learn about different types of WAN terminology. 
 Configure the Ethernet Card. 
 Configure Modem Card for Dial Up 
 Know about different protocols and terms used in Internet. 

 
5.2 Basics of Computer Networks 

The merging of Computers and communications has had a profound influence on the 
way Computer systems are organized. The old model of a single mainframe computer serving 
all of organizations need has been replaced by one in which a large number of separate but 
interconnected computers do the job. These systems called Computer Networks. 

 
5.2.1 Local Area Network 

Local Area Network as the word itself defines is a network confined to a small area. It 
is a network of Computers that is privately owned and limited to a small room, single 
building or at most spread across the campus. There are three characteristics of LANs, which 
distinguish them from other types of networks.1) Size,2) Transmission Technology,3) 
Topology 
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Size:  

As mentioned above, LANs are restricted in size and usually spread across a range of 
1 km of radius. 

 
Transmission Technology:  

It refers to the technology by which data from source is transmitted to the destination. 
These days varies from 10 Mbps to 1000 Mbps (1 Giga Bits per second) or even more. 

 
Topology:  

Topology refers to the physical arrangement of placing computers. There are a 
number of topologies possible. One commonly used topology is Bus. In a bus ( a Linear 
Cable) network only one computer is allowed to an arbitration method is required to resolve 
the conflict. Other topology is star in which a hub is required to connect the Computers. The 
hub can be used to connect 4/8/12/24 Computers. In more than 90% of the LAN installations, 
this topology is used. 

 
Most commonly used standard defined for LAN is IEE 802.3, which is popularly 

known as Ethernet. It defines the types of cables and connectors that can be used. The data 
transmission rate is 10 Mbps in following implementations,  

 
Thick Ethernet which used thick Coaxial cable is called Thick Ethernet and can be 

used to create a LAN segment of 500 meters. It is also called 10 Base – 5 network. 
 
Thin Ethernet or 10 Base-2 LAN is implemented through thin coaxial cable and its 

LAN segment is limited to 185 meters. BNC connectors were used in this network. 
 
These days UPT (Unshielded Twisted Pair) cable is used in more then 90 % of the 

LAN installations. The advantage of this implementation is that it is easy to maintain and cost 
effective. The segment size is limited to 100 meters and computers are connected to a central 
hub or switch using star topology. 

 
10 Base-T standard uses UPT category 3 cable and RJ 45 connectors. With the UTP 

CAT5 ( Category 5) cable and Switch, it is possible to achieve a data transfer rate of 100 
Mbps in LANs. This implementation is called 100 Base-T. 
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5.2.2 Wide Area Networks 
A wide area network (WAN) spans a large geographical area, often a country or 

continent. WAN is a geographically dispersed telecommunications network. For the 
transmission of data beyond a local area, communications is typically achieved by 
transmitting the data from source to the destination through a network of intermediate 
switching nodes. These switching elements are specialized computers used to connect two or 
more transmission lines. When data arrives on an incoming line, the switching element must 
choose an outgoing line to forward them on. There is no consensus on the term used to 
represent switching element but Router is much widely used. The term distinguishes a 
broader telecommunication structure from a local area network. A wide area network may be 
privately owned or rented, but the tem usually denotes the inclusion of public (shared user) 
networks. 

 
In most of the WANs, the network contains numerous cables or telephone lines, each 

one connecting a pair of routers. If two routers that don’t share a cable nevertheless wish to 
communicate, they must do it indirectly via other routers. When a packet is sent from one 
router to another via one or more intermediate routers, the packet is received in its entirely, 
stored there until the required output line is free, and then forwarded. 
 
5.3 Internet 

Internet is the world’s largest computer network and is described as a network of 
networks. One of the greatest thing about the Internet is that nobody really owns it. It is a 
global collection of networks, both big and small. These networks connect together in many 
different ways to form the single entity that we know as the Internet. In fact, the very name 
comes from this idea of interconnected networks. The term “The Internet” was first used in 
1982 to refer to the enormous collection of inter-connected network that use TCP/IP 
protocols. 

 
 
5.3.1 Concept of Internet 

APRANET (Advanced Research Project Agency Networks), the originator of Internet 
emerged in 1957 from the U.S. Department of Defence as a fault-tolerance Wide Area 
Computer Networking paradigm, one that would survive a nuclear attack. Within a decade it 
became the largest, the most powerful and definitely the most uncontrollable force in the 
world. Since its beginning in 1969, the Internet has grown from four host computer systems 
to tens of millions. Although nobody owns the Internet, but it is monitored and maintained in 
different ways. The Internet Society, a non-profit group established in 1992, oversees the 
formation of the policies and protocols that define how we use and interact with the Internet. 
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When internet innovators developed its infrastructure, their primary intension was to 

create a tool that could advance communications and research across academic institutions. 
Even in the early nineties when a broad consumer audience began to use the Internet, people 
viewed it as a speedy version of postal mail. Only in the past ten years have consumers’ 
begum using the Internet for entertainment, shopping, business, banking and personal 
productivity. 

 
A computer on Internet can be addressed using a Internet protocol (IP) address and 

can also be located using Domain Name Service (DNS). The IP address consists of Address 
of the Network and Address of the computer within the Network. A typical IP address look 
like this. 
216.27.61.137 
 

To make it easier for us (humans) to remember, IP addresses are normally expressed 
in decimal format as a dotted decimal number like the one above. But communicate in binary 
form. Look at the same IP address in binary: 
11011000.00011011.00111101.10001001 
 

The four numbers in a IP address are called octets, because they each have eight 
positions when viewed in binary form. If you add all the positions together, you get 32, which 
is why IP addresses are considered 32- bit numbers. Since each of the eight positions can 
have two different states(1 or 0), the total number of possible combinations per octet is 28 or 
256. So each octet can contain any value between 0 and 255. Combine the four octets and 
you get 232 or a possible 4,294,967,296 unique values. 

 
Out of the almost 4.3 billion possible combinations, certain values are restricted from 

use as typical IP address. For example, the IP address 0.0.0.0 is reserved for the default 
network and the address 255.255.255.255 is used for broadcasts. 

 
The octets serve a purpose other than simply separating the numbers. They are used to 

create classes of IP addresses that can be assigned to a particular business; government or 
other entity based on size and need. The octets are split into two sections: Net and Host. The 
Net section always contains the first octet. It is used to identify the network that a computer 
belongs to. Host (sometimes referred to as Node) identify the actual computer on the 
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network. The host section always contains the last octet. There are five IP classes plus certain 
special addresses. 

 
When the Internet is its infancy, it consisted of a small number of computers hooked 

together with modems and telephone lines. You could only make connections by providing 
the IP address of the computer you wanted to establish a link with. For example, a typical IP 
address might be 216.27.22.162. This was fine when there were only a few hosts out there, 
but is became unwieldy as more and more systems came online. 

 
The first solution to the problem was a simple text file maintained by the Network 

Information Center that mapped names to IP addresses. Soon this text file became so large it 
was too cumbersome to manage. In 1983, the University of Wisconsin created the Domain 
Name System (DNS), which maps text names to IP addresses automatically. 
The DNS scheme gives us meaningful name to the addresses. For example: 
username@Organisationname.OrganisationType.Geography 
mailto:Unsername@Organisationname.OrganisationType.Geography 
 
 Internet Architecture 

The internet architecture can be broadly classified into three layers. The very first 
layer consists of Internet Backbones and very high speed network lines. The National Science 
Foundation (NSF) created the first high-speed backbone in 1987 called NSFNET, it was a T1 
line that connected 170 smaller networks together and operated at 1.544 Mbps (million bits 
per second). IBM, MCI and Merit worked with NSF to create the backbone and developed a 
T3 (45Mbps) backbone the following year. Backbones are typically fiber optic trunk lines. 
The trunk line has multiple fiber optic cables combined together to increase the capacity. 
Fiber optic cables are designated OC-48 can transmit 2,488 Mbps (2.488 Gbps). The nodes 
are known as Network Access Point (NAPs). The second layer is usually known as Internet 
Service Provider (ISP). The ISPs are connected to the Backbones at NAP’s with high speed 
lines. The end users which are part of third layer are connected to ISPs by dial up or leased 
lines and modems. The speed of communication is usually 1400 bps to 2048 kbps. 

 
In the real Internet, dozens of large Internet providers interconnect at NAPs in various 

cities, and trillions of bytes of data flow between the individual networks at these points. The 
Internet is a collection of huge corporate networks interconnected with one other at the 
NAPs, backbones and routers to talk to each other. A message can leave one computer and 
travel halfway across the world through several different networks and arrive at another 
computer in a fraction of a second. 

The routers determine where to send information from one computer to another. 
Routers are specialized computers that send messages to their destinations along thousands of 
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pathways. It joins two networks, passing information from one to the other. It also protects 
the networks from one another, preventing the traffic on one from unnecessarily spilling over 
to the other. Regardless  of how many networks are attached, the basic operation and function 
of the router remains the same. Since the Internet is one huge network made up of tens of 
thousands of smaller networks, its use of routers is an absolute necessity. 

 
World Wide Web (WWW): 

It integrates all the information from the Internet in one big web. It is the most user-
friendly service. It is the most user-friendly service. It allows connecting to any computer 
having information. It offers the capability to links with sites. Web Servers are software that 
run on the Internet servers and provide information to the Web users and other servers. 
Internet servers store information on the Internet are either servers or clients. The machines 
that provide services to other machines are servers. The machines that are used to connect to 
those services are clients. There are Web servers, e-mail servers, FTP servers etc. serving the 
needs of Internet users all over the world. 

 
The information on the web server is compiled in Hyper Text Markup Language 

(HTML). It has useful text and images linked to different documents. HTML provides 2-D 
effect. But to have 3-D effect of the images and to have sound effect etc. , Virtual Reality 
Modeling Language ( VRML) can be used very efficiently. Web browser is software, which 
provides interface to WWW. This software runs on user’s machine. Web browser is available 
in two formats: Graphical format and Text format. Once a client has connected to a service 
on a particular port, it accesses the service using a specific protocol. Protocols are rules that 
describe how the client and server will have their conversation. Every Web server on the 
Internet conforms to the Hypertext Transfer Protocol (HTTP). 

 
For locating any document on the WWW, a unique address known as a Uniform 

Resource Locator (URL) is required. It consists of three parts: protocol name, server address 
and document location within the server’s space. When you connect to 
http://www.doeacc.org.in/info.htm to read a page, you are a user sitting at a client’s machine. 
You are accessing the DOEACC web server. The server machine finds the page you 
requested and sends it to you. Clients that come to a server machine do so with a specific 
intent, so clients direct their requests to a specific software server running on the server 
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machine. For example, if you are running a Web browser on your machine, it will want to 
talk to the Web Server on the server machine, not the e-mail server. 

 
5.3.2 Application of internet 
E-mail: 

It is way to communicate offline between different Internet users. With electronic 
mail you can send messages to people across town, across the country, or across the globe 
instantaneously. It is a concept that is radically reshaping how the world communicates. 
Email goes even further- you can also send and receive digitized pictures, sounds, and entire 
computer programs, using Internet email as a “carrier”. Hundreds of electronic libraries and 
archives all over the world can be accessed using this technique to provide access to their 
resources. Finally, you can subscribe to mailing lists – electronic equivalents of magazines or 
newspapers. Except on these magazines, the subscribers can also talk with each other, turning 
the list into a private forum. 
 
Chat: 

Chat or Internet Relay Chat is a multi-user, multi channel, real time Chat. It allows 
multiple users to take part in the conversation. It can be used for marketing, giving 
production, etc. in business sector. 

 
News Groups: 

Many Users can communicate and share their views through this Internet Service. A 
newsgroup is a discussion about a particular subject consisting of notes written to a central 
Internet site and redistributed through Usenet, a worldwide network of news discussion  
groups. Usenet uses the Network News Transfer Protocol (NNTP). Newsgroups are 
organized into subject hierarchies, with the first few letters of the newsgroup name indicating 
the major subject category and sub-categories represented by a subtopic name. Many subjects 
have multiple levels of subtopics. Some major subject categories are: news, rec ( recreation), 
soc(society), sci(science), comp (computers), and many more. Users can post to existing 
newsgroups, respond to previous posts, and create new newsgroups. 

 
Other Internet Services 
Telnet: 

This Internet Tool enables us to login host computer on the Internet. Many  
companies provide guest login, which can be accessed through Telnet. It has two operating 
modes: Command mode and Input mode. Command mode is used to open, close and quit the 
remote host computer. The input mode can be used for inputting different data. 
 
Gopher: 

It is a menu-based information retrieval tool. It is used to search the keywords to get 
the closest menu. It was used to retrieve information by linking up to Telnet. It was very 
popular www came into existence.  

 
FTP: 

File Transfer Protocol (FTP) is used to transfer information in the form of file from 
one user computer to another computer. FTP  is an application protocol that used the Intenet’s 
TCP/IP protocols. FTP is commonly used to transfer Web page files from their creator to the 
computer that acts as their server for everyone on the Internet. It’s also commonly used to 
download programs and other files  to user’s computer from other servers. 
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5.3.3Connecting to the internet: 
Dial-up: 

In dial-up Internet Access can be taken with the help of Telephone Lines. With the 
help of Modem your computer can be connect to Internet Service Provider and dial for 
Internet Access. Dial-up type of services mostly need only telephone network, other type of 
architecture is not necessary. At remote places due to low population, broadband setup cannot 
be established therefore dial-up connection is available at lower rates. In dial-up type 
connection telephone cannot be accessed while using Internet. 

 
Broad Band: 

In broad band type of communication large range of frequencies are used for 
transmission of Information. As the bandwidth is increased, Information Transmission 
Capacity also increases. Analog modems are used for transmitting the data on telephone lines 
to achieve the speed of 56 kbps or more. When ADSL (Asymmetric Digital Subscriber Line) 
is used on these telephone lines data transmission speed can be increased up-to several mbps. 
With the use of various Medias, variable transmission speeds can be achieved therefore 
particular transmission speed is not set for broad band transmission. Many packets of 
information can be sent simultaneously. Compared to dial-up broad band transmission is 
faster and telephone can be used while accessing the Internet. 

 
Wi Fi (Wireless Fidelity) – Wi Fi is a wireless technology. In this type of network 

computers are connected to each other without cable of wire. Therefore the expenses on 
configuration and maintenance of the network are reduced. There are some places where 
setting up the network with cables is difficult or sometimes not possible, on such places 
wireless networks are very helpful to be connected. In this type of networks information can 
be send over the network nodes as personal computers, and many other devices. In wireless 
networks there is a limit on the size of the network and also these networks are less secure 
compared to other networks with cable. 

 
To prepare the Computer for Internet access and LAN, you would require some 

information that you can get from the Network Administrator. The Ethernet card can be 
configured in the following steps: 

1. Click on start, select control panel and click on Network or Right click on My 
Network places at Desktop and select its properties. 

2. This screen informs about the network and dial up connections. Select the one that 
you want to install. 

3. To install Local Area Network, select the icon, a new screen appears with the details 
of the Ethernet card and the bland area where components can be installed. 

4. Click on install button and add the components like Client for Microsoft Network, 
File and printer sharing for Microsoft, NetBEUI protocol. TCP/IP protocol should be 
added if you want to access Internet. 

5. To configure TCP/IP, select it and click on properties. 
6. Select obtain IP address automatically if DHCP has been configured on Windows NT 

/2000 domain. Otherwise specify the IP address manually and subnet mask. If DNS is 
configured in the network, specify its IP address. DNS is used to resolve the name 
with IP address. 

7. Click on Advanced and Select WINS configuration Tab. As your computer is 
identified by a name and actually any computer needs IP address to connect to 
network so WINS is required to be configured to resolve names in WIN NT /2000 
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server based network. If WINS is installed in the network, enable WINS resolution by 
giving the IP address of WINS server. 
 

Once all above details are given, the computer is ready for access through LAN. 
 
To Configure Dial up Connection 

8. The dial up connection should be configured if you want to access Internet from the 
computer at your home through telephone lines. Select dial up connection option as 
mentioned in point2. Network connection wizard will help you in creating this dialup 
connection. 

9. Follow the instructions and give the desired information. Select the connection type 
and click next. 

10. Now the wizard requires to know about the availability of this connection. Select the 
type and click next. 

11. Give a name to this dial up connection and click finish to complete. 
 
5.3.4 Troubleshooting: 

Any one of the following issues can cause problems when you try to communicate with a 
server on the Internet:  

 The server is not functioning correctly or has been temporarily removed from the 
Internet.  

 Your Internet browser is not configured correctly.  
 The TCP/IP configuration for your dial-up connection to your ISP is incorrect.  
 Your ISP's Domain Name Service (DNS) server is not working correctly.  
 Hosts files in the System_drive:\Windows, 

System_drive:\Windows\System32\Drivers, and System_drive:\Program 
Files\Network Ice\Black Ice directories may be damaged or corrupted.  

To determine the cause and resolution of the problem that you are experiencing, 
follow the procedures in each of the following sections, in the order that they are presented 
in. After you complete a procedure, try again to see whether you can successfully 
communicate with servers on the Internet.  
 

If you cannot communicate with a specific server on the Internet, try to connect to the 
Microsoft Web site by using its fully qualified domain name (FQDN):  
http://www.microsoft.com 
 

An FQDN is made up of a host name (in this case, "microsoft") and a domain name 
(".com"). If you can connect to the Microsoft Web site by using its FQDN, the TCP/IP 
configuration on your computer is correct.  
 
          If you can connect to the Microsoft Web site but you cannot connect to another specific 
Internet site after several tries, the other site may not be functioning correctly or may be 
temporarily removed from the Internet. Try to connect to some different Web sites. If you can 
connect to some Web sites but not to other Web sites, contact your ISP if you need help.  
 
         If you cannot connect to any Web sites, there may be an issue with your Internet 
browser configuration or with the TCP/IP configuration for your dial-up connection to your 
ISP.  
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Make sure that your Internet browser (for example, Microsoft Internet Explorer) is 
correctly configured to connect to the Internet through the dial-up connection to your ISP, 
and make sure that your Internet browser is not configured to connect through a proxy server. 
(A proxy server is a computer or a program that acts as a "go-between" barrier between a 
local area network (LAN) and the Internet. A proxy server is a firewall component that 
presents one single network address to external sites.) 
 
           To verify these settings, start Internet Explorer, and then click Internet Options on the 
Tools menu. Click the Connections tab, and then view the settings that relate to your ISP.  
 
To see whether your browser is using a proxy server, click LAN Settings.  

Confirm your Internet Protocol (IP) address 
If your ISP has given you a static (permanent) IP address, make sure that the TCP/IP 
configuration for your ISP connection contains the correct information. Follow these steps:  

1. Connect to your ISP.  
2. Start a command prompt, type the following command, and then press ENTER:  

 
ipconfig /all: 

The ipconfig /all command displays Windows TCP/IP settings for all your network 
adapters and modem connections. The address for a modem connection is displayed as 
"NDISWAN x adapter", where x is a number. The default gateway for the NDISWAN x 
adapter is the same as the IP address. This is by design. More than one NDISWAN x adapter 
may be displayed. Any NDISWAN x adapters that are not currently in use display zeros for 
the IP address.  

If the IP address that is displayed for your dial-up connection to your ISP does not 
match the IP address that your ISP gave you, change the IP address that is displayed so that it 
matches the address that your ISP gave you. Follow these steps: 

a. Click Start, point to Settings, click Control Panel, and then double-click 
Network Connections.  

b. Right-click your Internet connection, click Properties, and then click the 
Networking tab.  

c. Click the Internet Protocol adapter, and then click Properties.  
d. If the settings are not correct, change the TCP/IP settings to match the settings 

provided by your ISP, click OK, and then click OK again. 

Turn on the option to use a default gateway on the remote network 
If you connect to a local network by using a network adapter and, at the same time, 

connect to your ISP by using a modem, configure your dial-up connection so that any routing 
conflicts are resolved in favor of your dial-up connection to your ISP. Follow these steps:  

1. In Control Panel, double-click Network Connections.  
2. Right-click your Internet connection, click Properties, and then click the Networking 

tab.  
3. Click the Internet Protocol adapter, click Properties, and then click Advanced.  
4. Click to select the Use default gateway on remote network check box, and then 

click OK.  
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Check the transfer and receive lights 
If you connect to a local network by using a network adapter and, at the same time, 

connect to your ISP by using a modem, a conflict between your network adapter and your 
modem can prevent your modem from sending information to servers on the Internet. To 
verify that TCP/IP packets are being routed through your modem to your ISP, follow these 
steps:  

1. Connect to and log on to your ISP.  
2. Use the ping command to cause your modem to send test information. At a command 

prompt, type the following command, and then press ENTER:  

ping IP address: 

where IP address is the IP address of a known good server on the Internet. If you do 
not know the IP address of a server on the Internet, use the IP address for ftp.microsoft.com, 
207.46.133.140. 
Dial-Up Networking Monitor uses lights to show the modem status.  

 If the transfer (Tx) light in Dial-Up Networking Monitor flashes when you ping a 
server on the Internet, TCP/IP information is being routed through your modem to 
your ISP.  

 If the transfer (Tx) light in Dial-Up Networking Monitor does not flash when you 
ping a server on the Internet, packets are not being routed through your modem. Make 
sure that the IP address that your ISP assigned to you for your dial-up connection is 
different from the IP address for your network adapter or loopback driver (if one is 
installed). Also, the IP address of your network adapter or loopback driver must not 
be on the same network as the IP address that your ISP assigned for your dial-up 
connection.  

 If the receive (Rx) light in Dial-Up Networking Monitor does not flash when you ping 
a server on the Internet, packets are not being received from your ISP. Contact your 
ISP if you need help.  

 If the receive (Rx) light in Dial-Up Networking Monitor flashes when you ping a 
server on the Internet, but you still cannot connect to the server by using its FQDN, 
there may be a name resolution issue. 

Test the name resolution: 
A DNS server provides host name resolution. If you cannot connect to a server on the 

Internet by using its FQDN, there might be an issue with the DNS configuration of your dial-
up connection to your ISP or with your ISP's DNS server.  
 
      To determine whether there is an issue with the DNS configuration of your dial-up 
connection to your ISP, follow these steps:  

1. At a command prompt, type ipconfig /all, and then press ENTER to display the IP 
address   your DNS server. If the IP address for your DNS server does not appear, 
contact your ISP to obtain the IP address for your DNS server.  

2. To verify that your computer can communicate with your DNS server, ping your DNS 
server's IP address. The reply looks something like this:  

3.    Pinging ###.###.###.### with 32 bytes of data: 
4.    Reply from ###.###.###.###: bytes=32 time=77ms TTL=28 
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5.    Reply from ###.###.###.###: bytes=32 time=80ms TTL=28 
6.    Reply from ###.###.###.###: bytes=32 time=78ms TTL=28 

   Reply from ###.###.###.###: bytes=32 time=79ms TTL=28  

 The series of number signs (###.###.###.###) represents the IP address of the DNS server.  
 

If you cannot successfully ping the IP address of the DNS server, contact your ISP to 
verify that you are using the correct IP address and that the DNS server is working correctly.  
If using another DNS server resolves the issue, contact your ISP to correct the issue with the 
original DNS server.  

Examine the host files 
Open Internet Explorer. Connect to the Internet. Type www.microsoft.com and other 

FQDN addresses in the address bar, and then click Go. MSN Search reports that no page is 
found. However, if you type the IP address for any one of the Web sites, the Web site 
appears.  
 
To resolve this issue, follow these steps:  

1. Search for hosts files on the local hard disk(s).  
2. If file name extensions are visible, find any hosts file without the .sam extension, 

open it with Notepad to verify that it contains references to the sites that are 
unavailable.  

3. Delete all hosts files that do not have the .sam extension.  
 
    When you have verified the correct IP address for your DNS server, update the TCP/IP 
settings for your dial-up connection to your ISP. To change or add a valid IP address for your 
DNS server for a Dial-Up Networking phonebook entry, follow these steps:  

1. In Control Panel, double-click Network Connections.  
2. Right-click your Internet connection, click Properties, and then click the Networking 

tab.  
3. Click the Internet Protocol adapter, and then click Properties.  
4. Click Use the following DNS server addresses, and then type the correct IP address 

in the Preferred DNS Server box.  
5. Click OK, and then click OK again. 

 
Do it Yourself 
Q.1 What are the different types of topology used in LAN. 
Q.2 Configure the Ethernet Card after consulting the Network Administrator of an 
organization. 
Q.3 Configure the modem card for “Dial up connection” with your ISP. 
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5.4 Summary 
  

 When several computers are interconnected to share the resources, it is called a network. 
 There can be several different types of Network like LAN and WAN. 
 When this network  is confined to small area, i.e. a room, a building, it is known as Local 

Area Network.  
 There are several ways by which LAN can be implemented. More than 90% of the 

organization implementations are through UTP cable. 
 When the network is spread across a wide area, i.e. across the country, in different 

countries, continents, is called Wide Area Network. 
 Internet is a network of networks. 
 Different protocols are used in Internet like www, SMTP (email), FTP, Telnet (Remote 

Login) 
 LAN Card or Ethernet can be configured so that computer can access Internet or email 

through Internet or email through Internet Service provider (ISP) 
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CHAPTER  06 
 

WWW AND WEB BROWSER 
 

6.0 Introduction 
6.1 Objectives 
6.2 World Wide Web (WWW) 
6.3 Web browsing soft wares 
6.4 Search Engines 
6.5 Understanding URL 
6.6 Surfing the web 
6.7 Summary 
6.8 Model Answers 
 
6.0 Introduction 

The Internet is a collection of computer networks that connects millions of computers 
around the world. The WWW incorporates all the Internet services discussed in last chapter 
and much more. You can retrieve documents, view images, animation and video, listen to 
music and sound files, retrieve and transmit voice, and view programs that run on practically 
any software in the world, provided your computer has the hardware and software to do these 
things. 

Internet browser enables you to connect to the Internet and gain access to the vast 
storage of information on these computers. Whether you’re searching for information or 
having it delivered to your computer, take a look at some of the features that make them easy 
to browse the Internet. 

 
6.1 Objectives 
After completing this lesson you will be able to 
Explain world wide web. 
Understand different types of Browsers 
Configure the browser. 
Search websites or web pages. 
Download and search through Internet Explorer. 
 
6.2 World Wide Web 

The World Wide Web, abbreviated as WWW or W3 and commonly known as the 
Web, is a system of interlinked hypertext documents accessed via the Internet. With a web 
browser, one can view web pages that may contain text, images, videos, and other multimedia 
and navigate between them via hyperlinks.  

The terms Internet and World Wide Web are often used in every-day speech without 
much distinction. However, the Internet and the World Wide Web are not one and the same. 
The Internet is a global system of interconnected computer networks. In contrast, the Web is 
one of the services that runs on the Internet. It is a collection of interconnected documents 
and other resources, linked by hyperlinks and URLs. In short, the Web is an application 
running on the Internet.  
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"The World-Wide Web was developed to be a pool of human knowledge, and human 
culture, which would allow collaborators in remote sites to share their ideas and all aspects of 
a common project."  

6.3 Web Browsing Software’s: 
A web page is an electronic document written in a computer language called HTML. 

Web pages can contain text, graphics, video, animation, and sound, as well as interactive 
features, such as a person, business, organization, or a subject, such as sports. The first page 
is called the home page, which acts like an index, indicating the content on the site. From the 
home page, you can click hyperlinks to access other web pages. 

 
A browser is a computer programs that resides on your computer enabling you to use 

the computer to view WWW documents and access the Internet taking advantage of text 
formatting, hypertext links, images, sounds, motion and other features. Netscape and Internet 
Explorer are currently the leading “graphical browsers” in the world (meaning they facilitate 
the viewing of graphics such as images and video and more). There are other browsers also 
like Mac web, Opera. Most offer similar features and can be successfully used to retrieve 
documents and activate different kinds of programs.  

 
When you log onto the Internet using Netscape or Microsoft’s Internet Explorer or 

some other browser, you are viewing documents on the Worlds Wide Web. It is HTML and 
other programming embedded within HTML that makes buttons or icons using graphics on 
which user can click mouse button to retrieve another documents into the computer. Every 
document, file , site , movie, sound file or anything you find on the Web has a unique address 
called Uniform Resource Locator (URL) 

 
Browsers all rely on “plug-ins” to handle the fancier files you find on the Web. Plug-

ins are sub-programs stored within a browser or elsewhere in your computer especially to 
support special types of files you may click on. If you click on a link, and your computer does 
not currently have the plug-in needed for the file you clicked on, you are usually prompted 
with an opportunity to get the plug-in. Most plug-ins are free and easy and safe to install on 
computer, the user has to follow the instructions that are given. 

 
6.3.1 Popular Web browsing Softwares: 
 Internet Explorer 

Microsoft Internet Explorer enables you to connect to the Internet to gain access to the 
vast stores of information on these computers. Subscribe to your favourite sites so that the 
content is automatically updated whenever you want-daily, weekly or monthly. Internet 
Explorer can download  updated Web Pages or entire sites in the background while you do 
other work on your computer, or even while you sleep. Then you can browse through them 
later online, offline, at work, at home, or on the road. You can add a Web page to your list of 
favourites for easy access from the Favourite menu or Explorer bar. 
 

With Auto Complete, when you start typing a frequently used URL in the Address 
bar, Internet Explorer completes the address for you. Using security zones, you can set 
different levels of security for different areas of the Web to protect your computer. With 
Content Advisor, you can screen out objectionable or offensive content. Once you’re set up, 
take a look at some of the things you can do on the Web. From basic browsing and searching, 
to viewing channels and subscriptions. 
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Netscape Navigator 

One of the most popular ways people use Netscape is to browse the Web. Navigator, 
the Netscape component that lets you visit web pages, offers many ways to visit web pages 
and search the Web. When you start Netscape, you see Navigator, your browser. A “What’s 
New” page appears automatically in the browser window when you first launch Netscape. 

 
 
After the first launch, you will normally see your home page when you launch Netscape. 
Unless you choose a home page yourself, your home page is chosen by your network or 
Internet service provider, or you see Netscape’s home page. We have given 
www.doeaccchennai.edu.in < http://www.doeaccchennai.edu.in > as our home page. 
Going Directly to a URL 

1. Click on File, Open page. Enter a URL in the white box and press to retrieve the 
document. You may also invoke it using Ctrl key + O key. 

2. URL / Location / Go to box ( While box above the document window) also works to 
go directly to a URL. 

a. Click over the text of the URL currently in the URL /Location box. 
b. While it is highlighted, type in the new URL and press. 
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c. The advantage of using the URL / Location box is that a history of URLs you 
retrieve is available by pressing the gray pop-down arrow at the right end of 
the URL / Location box. 

 
6.4 Search Engines: 

A search engine is an information retrieval system designed to help find information 
stored on a computer systems accessed through the means such as the World Wide Web. The 
search engine allows you to make a query usually with a word or phrase and retrieves a list of 
items that best match the criteria you have requested. This list is often sorted with respect to 
some measure of relevance of the results. Search engines use regularly updated indexes to 
operate quickly and efficiently. While all search engines “Search” for data, it is important to 
understand that there several “types” of search engines which range from searching for 
newsgroups and directories to databases. 

 Vertical search engines 
 Category-focused vertical search engines 
 Media-focused search engines 
 Forum and discussion group search engines 
 Meta search engine 
 Image search engine 

 
6.4.1 Popular search Engines/Searching for Content 

The top five search engines are: 

1. Google Search  
2. Yahoo! Search  
3. MSN/Windows Live Search  
4. AOL Search  
5. Ask.com Search  

To understand and appreciate why the search engines have gained popularity, let us know 
the basic working of Internet search engines. 

There's loads of information available on the World Wide Web, but how do we get the 
exact info we require? The answer to this Internet search engines. These are special web sites 
which are designed in such a way that they help people find information stored in other sites. 
The way each one works is different but they perform three basic tasks namely searching the 
web for select key words, build an index of the words they find and their location and 
facilitate users to look for those key words or their combinations. The software robot called 
spiders does the work of building the lists of words and the process is known as crawling. 
Next happens the indexing. The search engine stores the keyword and the URL where it has 
been found. These words are assigned rankings depending upon where they appear in the 
page, in title or sub titles or the body text. Each search engine has different formulas to 
calculate or assign these rankings to the words which cause variations in search results when 
searched for the same keyword in different search engines. Now when the user submits a 
query the engine searches through the index and based on the weight and relevance of the 
word the results are displayed with the most useful ones at the top of the list of search results. 
How efficient these processes happen earns popularity of the search engine. 

Google search has gained repute as the top choice for those searching the web. The 
crawler-based service provides both comprehensive and relevant coverage of the web. 
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Google uses multiple spiders, three at a time. Each spider connects to as many as several 
hundreds of Web pages at a single instance crawling over 100 pages per second, generating 
hundreds of kilobytes of data per second. Another important feature of the Google search is 
the PageRank which finds how many times other sites link to a particular page. Hence sites 
which are more popular gain higher ranks and appear in the top list of query results. 

Google search, through its ranking algorithms, gives weight to the user preferences. 
Based on their searches, it returns the most sensible result to the query depending upon what 
the person actually looks for. Their constant fine tuning of the search engine has gained 
popularity all over the world bridging the gap between what the users are looking for and 
what is listed as search results. As new pages constantly get added to the net, Google while 
changing formulas to get those pages included in the search results, takes care of the quality 
by verifying whether the topic is hot and current. Else they retain the old pages which can be 
linked by other sites easily. While displaying the results, the comprehensive text which 
appears below the link called snippets gives users hints about a certain site’s content. The 
users are briefed about site's content even before they look into it. Attractive features like 
excellent spell check, easy access to dictionaries, street maps, telephone numbers and the user 
friendly Google Toolbar for easy access to Google and its features directly from the Internet 
Explorer browser have made it the user's first choice. 

Closely following Google is the Yahoo search engine which has become a web crawler 
based search engine since 2003. Earlier it was dependent on other search engines for its 
results. Yahoo’s reinvented search engine combines the capabilities of Alltheweb and 
AltaVista owned previously by Overture Services, Inc. More specialized options like images, 
yellow page listings are offered by Yahoo and serves as excellent shopping search engine. 
Yahoo directory services offer results from human compiled Yahoo directory when searched 
from Yahoo directory home page. 

Listed as the third most popular search engine, MSN search engine comprises of a search 
engine by Microsoft, index and a web crawler. Now this has been christened as Live Search. 
Specific types of information can be accessed using search tabs provided for Web, images, 
news, music, local, desktop and Microsoft Encarta. While it receives more than a few billion 
queries per month, it still provides required answers to user’s query and improved access to 
information. MSN search has been upgraded to use its own search engine to query results and 
the index is updated on a weekly basis. It also provides its search results to other search 
engines in order to be on par with its competitors. 

AOL search uses the Google search engine to query results. So most of the time, results 
turned out by Google and AOL remain the same. What makes AOL search special then? It is 
that the internal version of AOL search provides links which can be accessed only by AOL 
online users. It provides precise results for the query from Google but with one click to get 
required images, pictures, maps or stock quotes and news. The safe search filter in AOL 
search engine filters out unwanted adult images if it is set in preferences. Domain specific 
searches are also possible with this search engine. 

Rated as fifth in terms of popularity, Ask.com (previously known as Askjeeves.com) was 
first started as a question-answering search engine. It answered all the questions posed to it 
daily in natural language (English). It also responds to search terms, thus being very user-
friendly. Since Indexing was rather slow in this search engine compared to Google, Yahoo or 
MSN, it was not affected by link spam which prevented important web pages from being 
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accessed. Its ExpertRank algorithm goes beyond Google in delivering which is best rather 
than which is bigger. By identifying the subject specific sites they bring more relevance and 
editorial touch to their query results. Ask.com owns sites which are country–specific for UK, 
Spain, Italy, Japan and The Netherlands thereby increasing the user traffic and gaining 
popularity. 

Ultimately, the number of visitors to a particular search engine website, the search 
sessions happening on daily or weekly or monthly basis, length of the session, user 
preferences and how frequent they return to the same website determines the popularity. 

You can find information on the Web in a variety of ways. When you click the Search 
button on the toolbar, The explorer bar appears at the left of the window. It provides access to 
a number of search services that offer different kinds of searching capabilities. In Internet 
Explorer, if you are looking for some website. But don’t know Its URL address. Then there 
are some websites called Search Engines which helps you to search that website. For 
example, www.yahoo.com, www.google.com. To search about specific topic, follow these 
steps: 

1. Open Internet Explorer and Type the URL address of search engine website e.g. 
www.google.com in the Address Bar. The following screen appears as shown in the 
figure. 

 
2. Type the desired topic like “doeacc” and click on Google Search. 
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3. The new window will open with all the websites related to the topic that you give in 
search bar as shown in the figure below. Then click on the any of the topic. 
 

6.4.2 Accessing web browser: 
 Open a web browser software, that contain the title bar in this place we can type the 
particular URL and click go button near the title bar. 
 
To Navigate The Web Using IE or Netscape 

1. Click on links or buttons within a document in the document window. Links are the 
highlighted areas of hypertext in the document itself. They will retrieve other documents. To 
click on a link, move the mouse over the highlighted area and click once. 

2. Back ( the first toolbar button) returns to the previous document. Use the Forward 
toolbar button only after you’ve already backed up to a previous document. It will return you 
to the document you were viewing before you chose to go back. 

3. Go in Netscape and History in IE show you a list of sites you have recently visited. 
Using them may be faster than clicking Back several times. Home ( a little house toolbar 
button on the in both IE and Netscape) returns you to the DOEACC Web Home Page. 
 
Giving the URL 

If you have the URL (Uniform Resource Locator) of a specific document  you want to 
see, type the URL into the white Location or Address box, and press the Enter Key. ( You 
will need to highlight and delete the text in that box before you can type in a new URL) 
 
To Move Through a Document using IE or Netscape 

Click the mouse in the arrows at the ends of the scrollbars on the right(or bottom) side 
of the document to move through the document. You may hold the right mouse button down 
on the pad in the scroll bars and drag it to move the document as well. The space bar key will 
also take you down through the document, and the backspace key will bring you back up. 
Page Up and Page Down keys or the arrow keys also let you move. 
 
The screens 

The main way in which browsers differ is in the convenience features they offer for 
navigating and managing the Web and all the URLs you may want to keep track of. Netscape 
and Internet Explorer both offer the ability to e-mail documents, download them to diskette, 
print them, and keep track of sites visited and important sites you want to bookmark”. 
For most of the purposes, one browser is sufficient. IE and Netscape are excellent browsers. 
For a long time, Netscape was the more heavily used of the two. In the last couple of years, 
both have become very powerful. Netscape continues to offer Bookmark capabilities that IE’s 
“Favourites” cannot match. Most other features are quite similar in both of these browsers. 
The layout of these browsers. The layout of these browsers is organized from top to bottom in 
the following manner. 
 The menu bar ( top row, starting with File in both IE and Netscape) 
 The toolbar buttons (usually second row, starting with Back and Forward, in both IE 

and Netscape) 
 The location or address field, a white box which displays the URL of the current 

document and in which you can type the URL of a document you want to retrieve 
 To document window (the large area in the center) 
 The scroll bars on the right and bottom, for moving through the document (appear 

whenever a document is too tall or wide for the screen) 



105 
 

 The progress or status bar chosen appears, and where the URL of link displays before 
you click on it. 

 
Fast Searches 
There are three ways to search quickly: From the Location bar, from My Sidebar, and from 
the Net Search page. 
Searching from the Location Bar 

 
Searching for web pages on a particular topic is as easy as typing a question, or just a work or 
two, into the browser’s Location Bar. For example, if you want to find information about 
DOEACC: 

1. Double – Click in the Location Bar to select the current text. 
2. Type the word “DOEACC”. Your typing replaces the current text. 
3. Perform one of these steps 

a. Click the Search button. 
b. Click “Search Netscape Search for “Doeacc” at the bottom of the drop –down 

list in the Location Bar. (Your default search engine may be different). The 
default search engine you choose in Preferences is used. Search results for 
“Doeacc” appear in both the browser window and in My Sidebar. Click the 
links to visit web pages about doeacc.  

Download Manager 
You can use Download Manager to keep track of files you download. Download 

Manager shows the following information: 
1. Filename 
2. Time 

The following menu options are available in Download manager: 
Properties : Select a file being downloaded and click Properties to show the progress dialog 
box. 
Cancel: Select a file being downloaded and click Cancel to stop the download. 
Remove from List : Select a file and click Remove from List to remove a cancelled or 
finished download. This will not delete the file from your hard disk. 
Launch File: Click this to open a selected file. 
Show in Explorer: Click this to show the location of a selected file. 
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Downloading Documents and Other Types of Files 
Downloading refers to the method by which you access digital information from a remote 

computer. As it turns out, almost everything you do on the Web is some form of downloading  
 
To download documents. 
1. Click on File (at top) with document in your screen, and select Save As. 
2. Complete Save As Window – Select disk drive and name the file ( If you keep the 

extension “.htm” the document will “replay” in Netscape and other browsers, but not 
in any word processor. If you add the extension. “.txt” the document will be a plain 
text ( ASCII) file readable in work processors.) then, Click OK. 

Images, sound and other types of Files 
These do not download with the text of the document in the procedure described above. You 
must save each image or other files as a separate file if you want it. 
With the cursor over the image or whatever contains a link to the file you want, click the right 
mouse button. Click on Save Image As or equivalent for other files. 
Complete Save As dialog box as above, and allow the file extension to remain as is ( e.g..jpg, 
.jpeg, .gif, .wav) 
You may verify what you have saved in Netscape by typing in the URL / Location box, the 
drive (a: for example), then click on the file name when it appears in the document window. 
Retrieving documents and images and other files saved to diskette viewing or playing in 
Netscape 7.x: 

1. Click on File (at top), then Open Page. 
2. Click on Browse Button. 
3. Locate your file (Standard Windows 98 or 2K dialog box.) 
4. Click OK. 
5. Netscape should invoke or prompt you to get the appropriate plug-in (software) if you 

don’t have it. 
For older versions of Netscape, click on File, Open File, locate your drive and file. 
You can also view .txt files in almost any word processing program. Image, sound and other 
files may viewed in any image viewing or audio / video program that supports the type of file 
designated in the extension. 
 
Document taking more time to load? 

1. Try clicking on the stop button, then on Reload 
2. Try turning off the Automatic Loading of Images when any document is retrieved. In 

Netscape 7.x, click on Edit, Preferences, Advanced and then uncheck the box 
“Automatically Load Images”  This option is not available in the most recent 
Netscape versions. 

3. Java Downloading can tie up your computer. To prevent this, you may go to Edit , 
preferences, Advanced and the uncheck “Enable Java” (You do not have to disable 
Java Script, which does not slow down your computer.) 
 

Modifying Netscape Preferences 
In Netscape 7.x,choose Edit, Preferences. In the panel to the left of the window that opens, 
click on any of the terms in the list to display the types of options you can modify under that 
term.  
Appearance allows you to change toolbar appearance. 
Fonts and Colors - Allows to change fonts and colors. 
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Navigator Provides box where you can specify the URL of the page you want to be 
HOME on your computer. Netscape will open to this page automatically unless you specify a 
different option. 

Set the number of days (up to 365) for your search History to be retained. 
If you do not want your history or the URLs you’ve entered in the Location bar to be 
retained, you may Clear either or both using buttons under Navigator. 
 
Right Mouse Button 

This allows you shortcuts to do several things, including adding a bookmark without 
going to the page for that item. Clicking the right mouse button produces a pop-up menu with 
items that are shortcuts for several commands. The items in the menu depend on the type or 
contents of the window you are on. For example, when pressing the mouse button over a link, 
menu items refer to the page specially by the link; over an image, menu items refer to the 
image file specified by the image; over a pane in the Mail or News window, menu items 
apply specially to mail the image file specified by the image; over a pane in the Mail or News 
window, menu items apply specifically to mail or news features. When a frame is selected, 
Back and Forward menu items refer to the individual frame. 

 
 Back (or Back in Frame) – Displays the previous page in the history or frame history 

list. 
 Forward ( or Forward in Frame) (Same as Go, Forward item) – Displays the next page 

in the history or frame history list. 
 Open this Link ( Filename)- Displays the specified page. 
 Add Bookmark for this Link – Creates a bookmark at the bottom of the bookmark list 

for the specified page.  
 New Window with this Link – Displays the specified page into a newly opened 

Netscape Window instead of the current window. You can have  several versions of 
Netscape running at the same time, each at a different page. 

 Save this Link as – Saves the specified page to disk ( instead of displaying on screen) 
 Copy this Link Location – Copies the specified page location ( URL) to the clipboard.  
 View this Image (filename) – Displays the specified image in a separate window.  
 Save this Image as – Saves the specified image to disk ( instead of displaying on 

screen) 
 Copy this Image Location – Copies the specified image location (URL) to the 

clipboard. 
 
6.4.3 Using Favourites Folder 

The address for your favourite websites can be stored in a folder so that you can later on 
retrieve that address from favourite Folder. 

1. Click on Favourite on Menu bar, Add to Favourites. This invokes a properties screen 
as shown in the given figure. 

2. The name of the website automatically appears in the Name Box. You can Click x on 
the icon to Make available Offline. 

3. Now click OK to store this address in favourite folder. 
 

6.4.4 Downloading Web Pages 
When you access a web page, for instance, you actually downloading the document 

and all its associated graphics from a web server. To download files is to click on the link to 
the file with your right mouse button and select Save to Disk form the pop-up box. In some 
cases, you will be prompted to save the file somewhere on your hard drive, or the file may 
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download automatically to your desktop, depending on how your browser is configures. 
Another way to Save or Download a Document to a Diskette is given below. 

 
1. From the File Menu in IE or Netscape, select Save As. Following dialog box will 

appear. 

 
2. Select Save this to disk radio button and click OK. It will ask for the folder where this 

web page is to be stored and file name. Give folder and file name and click Save. 
The web page is now available in the specified folder in your Computer 
 

6.4.5 Printing Web Pages 
Most browsers have a Print button on the toolbar that lets you print a web page. Click 

File in the Menu bar, Then Print. Select desired options. Click File, then Page Setup to alter 
margins, select landscape view, and other details. 

Some web pages are divided into multiple sections called frames. You can only print 
one frame at a time. To print a particular frame, first select it by clicking it. Then click the 
Print button or select Print Frame from the file menu. 

 
6.5 Understanding URL: 

Every Web page has a unique address called a URL (Uniform Resource Locator) 
which identifies where it is located on the Web. For example, the URL for CSM Library's 
home page is: http://www.smccd.edu/accounts/csmlibrary/index.htm 

The basic parts of a URL often provide "clues" to where a web page originates and 
who might be responsible for the information at that page or site. 

URLs have three basic parts: the protocol, the server name and the resource ID. Look 
again at CSM Library's URL below to see these three parts. The protocol is shown at the 
beginning of the URL before the double slash (//); the server name is between the double 
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slash (//) and the first single slash (/); and the resource id is everything after the first single 
slash (/). 

http://www.smccd.edu/accounts/csmlibrary/index.htm 
protocol | server name | resource id 

Let's examine each part of this URL: 

First part: protocol (http://) 
        The protocol identifies the method (set of rules) by which the resource is transmitted. 
All Web pages use Hypertext Transfer Protocol (HTTP). Thus, all web URL's (including 
CSM Library's) begin with http://. 

Second part: Server name: 
      The server name identifies the computer on which the resource is found. (Computers that 
store and "serve up" Web pages are called remote servers.) This part of the URL commonly 
identifies which company, agency or organization may be either directly responsible for the 
information, or is simply providing the computer space where the information is stored. Web 
server names often begin with the letters www, but not always. 

The server name always ends with a dot and a three-letter or two-letter extension 
called the domain name. The domain is important because it usually identifies the type of 
organization that created or sponsored the resource. Sometimes it indicates the country where 
the server is located. The most common domain names are: 

* .com which identifies company or commercial sites 
* .org for non-profit organization sites 
* .edu for educational sites (most commonly four-year universities) 
* .gov for government sites 
* .net for Internet service providers or other types of networks 

If the domain name is two letters, it identifies a country, e.g. .us for the United States, .uk for 
the United Kingdom, .au for Australia, .mx for Mexico or .ca for Canada. 

The server name for our library's Web site is: www.smccd.edu. The server name may 
also be the name of a Web site. (A Web site is a complete group of Web pages that are 
organized as a comprehensive set.) Web sites can be either all of the pages on one server 
(computer) or all of the pages under a specific subdirectory on a server. For CSM Library, the 
server name (www.smccd.edu) identifies the San Mateo County Community College 
District. The CSM Library Web site consists of all of the pages under the subdirectory: 
/accounts/csmlibrary. 

Third part: resource ID (/accounts/csmlibrary/index.htm) 
     The resource ID is the name of the file for the page and any directories or subdirectories 
under which it is stored on the specified computer. The resource ID for our library's 
homepage is: /accounts/csmlibrary/index.htm. (A "homepage" is the opening or main page 
for any web site that provides links to all of the other pages on the site.) The part of the 
resource ID after the last slash (/) is the file name for the specific page or other resource. The 
file name ends with a three or four letter designation that specifies the file type (e.g., .htm or 
.html for a standard Web page, .jpg or .gif for common graphic files.) 
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6.6 Surfing the Web 
Accessing through Internet Explorer 
Here we are using Microsoft Internet Explorer to access World Wide Web and showing you 
the screen shots. Follow the given steps to use this client-based software. 

1. Double-click on the Internet Explorer icon on the Desktop as shown in the figure. 
2. This invokes explorer screen which is shown below. This screen contains the URL in 

Address Bar and the Home Page of given website. The process for settings this screen 
is given below. 

3. If you make the current website as your Home Page. Click on Tools / Internet / 
Options. The screen will appear as shown in the figure 
 

 
 
To get a desired website, type the URL (name of the website, e.g. 
www.doeaccchennai.edu.in) of the site in the Address bar. 
 
6.6.1 Using e-governance Website: 

 e-Government (short for electronic government, also known as e-gov, digital 
government, online government, or connected government) is digital interaction between 
a government and citizens (G2C), government and businesses/commerce/eCommerce (G2B), 
and between government agencies (G2G), Government-to-Religious Movements/Church 
(G2R), Government-to-Households (G2H). This digital interaction consists of governance, 
information and communication technology (ICT), business process re-engineering (BPR), 
and e-citizen at all levels of government (city, state/provence, national, and international). 
 The National e-Governance Plan of Indian Government seeks to lay the foundation 
and provide the impetus for long-term growth of e-Governance within the country. The plan 
seeks to create the right governance and institutional mechanisms, set up the core 
infrastructure and policies and implement a number of Mission Mode Projects at the center, 
state and integrated service levels to create a citizen-centric and business-centric environment 
for governance. 
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Do it Yourself 
Q.1 what is a web site? 
Q.2 how web sites can be accessed? 
Q.3 what is the use of e-goverence 
 

6.7 Summary 
 A web page is an electronic document written in a computer language called HTML 
 A website is one or more web pages that relate to a common theme, such as a person, 

business, organization, or a subject , such as sports. 
 A browser is a computer program that resides on your computer enabling you to use 

the computer to view WWW documents. 
 Navigator, the Netscape components that lets you visit web pages, offers many ways 

to visit web pages and search the web. 
 The Internet Connection Wizard in Internet Explorer will guide you through 

establishing a connection to the Internet. 
 The addresses for your favourite website can be stored in a folder so that you can later 

on retrieve that address from favourite Folder in Internet Explorer and Bookmark in 
Netscape. 

 You can find information on the Web in a variety of ways. 
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Chapter 7 
 

Communication and collaboration 
7.0 Introduction 
7.1 Objectives 
7.2 Basic of E-mail 
7.3 Using E-mails 
7.4 Document Collaboration 
7.5 Instant Messaging and collaboration 
7.6 Summary 
7.7 Model Answers 
 
7.0 Introduction 

With an Internet connection and email software like Microsoft Outlook Express, you 
can exchange messages with anyone on the Internet and join any number of fascinating 
newsgroups. You can set up Outlook Express to receive mail from multiple accounts. If 
several people share one mail account, you can set up folders for each person and then 
automatically route incoming messages to individual folders. For example, if you have email 
accounts for home and work, you can set up Outlook Express to receive messages for both 
accounts and sort them into separate accounts for each, note, however, that each person must 
log on as a different user to use a different mail account, it is also possible to send and receive 
mails through a browser like Internet Explorer.  But we will concentrate on email software to 
send and receive emails. 
 
7.1 Objectives 

 After completing this chapter you will be able to 
 Know different components of emails 
 Know the different components of email address 
 Configure Email client i.e. outlook express 
 Work with Outlook express 
 Compose ,Send and receive emails 
 Reply and forward emails 
 Send document and attachment as email 
 Store and manipulate contacts in an address book 

 
7.2 Basics of E-mail 

If you have several mail accounts with different Internet service providers (ISPs), you 
can use them all from one window. The Internet Connection Wizard helps you connect to one 
or more mail servers. Mail server is a Computer that maintains all the emails of the users of  
an organization. All the mails are received and sent through this server. You will need the 
following information from your Internet Service Provider (ISP) or local area network (LAN) 
administrator. To add a mail account, you need your account name and password, and the 
names of an incoming and an outgoing mail server. 

 
If your ISP used an IMAP  mail server for incoming mail, you can read, store and 

organize you messages in folders on the server without downloading the messages to your 
computer. The way, you view messages from any computer that can connect to that server. 
You can save names and addresses in your address book either by importing them from other 
programs, typing them in, adding them form e-mail messages you receive, or searching 
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popular Internet directory services (white pages). The Address Book supports Light weight 
Directory Service Access Protocol (LDAP) for accessing Internet directory services. Insert 
essential information (such as your phone number) into outgoing messages as part of your 
personal signature, or add stationery patterns and backgrounds to make your messages more 
attractive. 

 
7.2.1 What is an Electronic Mail 

E-mail (electronic mail) is the exchange of computer – stored messages by 
telecommunications. E-mail messages are usually encoded in ASCII text. However, you can 
also send non-text files, such as graphic images and sound files, as attachments sent in binary 
streams. I-mail was one of the first uses of the Internet and is still the most popular use. A 
large percentage of the total traffic over the Internet is e-mail. E-mail can also be exchanged 
between online service users and in networks other than the Internet, both public and private. 
E-mail can be distributed to lists of people as well as to individuals. 
It has three main parts – 

1. Header 
2. Message body 
3. Signature 

 
Header : An email header has following parts 

a) To : Which contains the addresses of recipients 
b) CC : The Carbon Copy, addresses of additional recipients whom a copy of email is to 

be sent 
c) Subject : Subject of Email 

 
Message Body: This is the place where the actual text of the email is written. 
Signature: It uniquely identifies the sender. The details that can be part of it are Name, 
Phone-Fax No. and Address etc of the sender.  
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7.2.2 Email Addressing: 
A Computer on Internet can be addressed using an IP address and can also be located 

using Domain Name Service (DNS). The IP address consists of address of the Network and 
Address of the computer within the Network. An Internet address (sometimes called a URL, 
or Uniform Resource Locator) typically starts with a protocol name (A protocol is a set of 
rules and standards that enable computers to exchange information), followed by the name of 
the organization that maintains  the site; the suffix identifies the kind of organization it is. For 
example, the address http: www.doeacc.edu / provides the following information. 

 
http: Web Server uses http: protocol 
www This place is on world wide web 
doeacc Web server is located at “doeacc” 
.edu This is an educational organization 

 
Generally, commercial site addresses end with .com, and government site addresses 

end with .gov, site address of non profit organization end with .org. this naming convention is 
followed in USA. In other countries, name of the country in two letters is also mentioned. For 
example, http://www.doeacc.org.in . In this address .in refers to India. For England it is .uk, 
for Singapore it is .sg etc., Type of organization .ac refers to academic institutions. 
Email address of a user on the Internet is similar to above internet addresses except the 
protocol name is replaced by the user name. 
 Mail to:Username@Organisationname.OrganizationType. Geography  

For example sjasola@doeacc.org.in mailto:sjasola@doeacc.org.in is email address, 
where sjasola is the name of a user. A mail server maintains all the email addresses of an 
organization. 

 
7.3 Using Emails 

Your messages in electronic form can be sent through email client like Outlook 
Express. Operations on emails like Composing, sending, replying and forwarding are very 
easy. 

Similar to other office software, mails are systematically kept in different folders. 
Incoming emails are kept in Inbox folder and outgoing mails are kept in Outbox folder. Mails 
that have been partially written and not sent can be kept in Draft folder. 

 
7.3.1 Opening Email Account: 
 Many site provide the e-mail account free for every user.Some popular e-mail account 
website are yahoomail,gmail,rediff etc. 
  
For example consider the yahoomail web site 
1.  Go the home page of Yahoo at www.yahoomail.com. 

     You will see a new page that looks like this: 
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2.  Click on the Sign up now hyperlink. 

 

3.Fill out the form like the one below 

Yahoo! ID: @ yahoo.com  
  (examples: "lildude56" or "goody2shoes") 

Password:  
Re-type Password:  

 

 
If you forget your password, we would identify you with this information. 

Security Question: [select a question to answ er]  
Your Answer:  

Birthday: [select one] , (Month Day, Year) 
Current Email 

(Optional):  

First Name:   Last Name:  
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Language & 

Content: 
English - United States  

Zip/Postal Code:     Gender: ---  
Occupation: [select occupation]  

Industry: [select industry]  
People Search 

Listing: List my new Yahoo! Mail address for free 

 

Listing includes real name, city, state, and country. 
Interest(optional):  

 Entertainment 

 Home & 
Family 

 Health 

 Music 

 Business 

 Computers & 
Technology 

 Personal Finance 

 Small Business 

 Shopping 

 Sports & Outdoors

 Travel 

 Sweepstakes & 
Free Stuff  

Enter tEnter the word as it is shown in the box below. point  

 
 

If you cannot see this image click here.  
 

 
 

 
 

have finished filling out the form, click on the Submit button. 

 
After submitting the form it confirm the e-mail account id and password.Using this id and 
password we can open a e-mail account.  
 
7.3.2 Mailboxes 
Inbox 

Inbox folder is places your incoming e-mails. To open you Inbox, click Inbox icon on 
the bar or folder list. Once the messages are in Inbox Folder, they can be read. You can read 
your messages using a small preview pane, or in a separate message window. If you receive 
lots of i-mails, you will probably use the preview pane to sort interesting messages. For really 
importing or long messages, you can open a separate window that will give you more reading 
room. 

To view a message in the preview pane, follow these steps: 
In the message list, click the subject line of the message you want to read. The text of the 
message will appear in the preview pane located beneath the list. 
To view a message in the preview pane, follow these steps: 
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In the message list, click the subject line of the message you want to read. The text of 
the message will appear in the preview pane located beneath the list. 
To view the message in a separate window: 

In the message list, double-click the message you want to read. A separate window for the 
message will open as shown in figure 

 
When you are finished reading the message, close it by clicking the button x in the top right- 
hand corner of the window. 
 
Checking for New Messages 

If you want to check for new messages, simply click the Send and Receive button on 
the Outlook bar. Outlook Express will download your e-mail and show you a list of subject 
titles in your Inbox. 
 
Outbox 

It is not necessary to be connected to the Internet to compose a message. With Outlook 
Express you can write a message while you are “Offline” and send it later when you are 
online. Composing your e-mail while you are offline will save you valuable connection time 
and lots of money. 

1. Compose your e-mail message. 
2. On the File menu, click Send Later. 
3. Your message will be saved in the Outbox. 
You may want to compose several messages and save them in your Outbox before 

connecting to the Internet. When you are online again, click the Send and Receive button and 
your messages will be delivered all at once. 

 
7.3.3 Creating and Sending a New Mail 
With Outlook express, you can create a new message with following steps: 

1. Click on Mail Message of New option form File menu. 
2. The above screen appears with options for writing e-mail address of recipients, 

subject and area for writing the contents of mail. 
3. In the To box, type the e-mail address of the person you are sending the message to. 

For example ccc@doeacc.org.in mailto:courses@doeacc.org.in; 
sjasola@doeacc.org.in <mailto : sjasola@doeacc.org.in> as shown in above figure.  

4. Type the e-mail addresses of the recipients in the CC box. If there is more than one 
address, separate them using a semi-colon (;) . This means the e-mail addresses of the 
people receiving it do not appear on the e-mail message. This means the e-mail 
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recipients will not know who else has received the message. Type the e-mail address 
of the recipients in the Bcc box. 

5. Type your message in the message area. As shown in the message area. As shown in 
the above figure. 

6. On the toolbar, click the Send Sutton. Depending on the connection you have to the 
Internet, a message box may appear telling you that the e-mail message is being 
moved to the Outbox. If it does appear, simply click OK. To send the message from 
the Outbox, click the Send and Receive button. Are you sure your message has been 
sent? If not, look inside the Sent Messages folder. To open this, folder, double-click 
the Sent Items button on the Outlook bar. 

Saving a Message for Later use. 
You don’t need to worry about finishing that message you’ve started. You can save it for 
later. 

1. To keep a work-in-progress in a safe place: In the window that you are composing 
your message, go the File menu and select Save. 

2. A message box will appear to tell you that the message has been saved to your Drafts 
folder as shown in the figure. 

 
Retrieving a Saved Message 
When you have time to finish your message, retrieve it using following steps: 

1. On the outlook Bar, click the Drafts icon. A list of message titles will appear as shown 
in the above figure. 

2. Find the message you want to work on and double click it.  Your message will open in 
a new window. 

3. Complete your message, and click the Send button. 
 

7.3.4 Replying to an e-mail message 
With Outlook Express, replying to an e-mail message is very easy. All you have to do is 

decide who should see your reply, then click the appropriate button. A simple reply to the 
person who sent the e-mail is used most often. Follow these steps to reply to the author: 

1. In the message list, click the message you want to respond to. The message will be 
highlighted with a blue box. 

2. On the toolbar, click the Reply button. A message window will open. You will see 
original message in it. 

3. In the message area, type your message. 
4. Click the Send button to transfer your message to the Outbox. 

Replying to everyone who received the Message 
Follow these steps to reply to everyone who received the message: 

1. In the message list, click the message you want to reply to. 
2. On the toolbar, click the Reply to All button. An e-mail message window will appear. 
3. Type your reply, and click the Send button. All the people who received the original 

message will now receive your response. 
 

7.3.5 Forwarding an e-mail message 
When an e-mail message is very interesting, you want to share it with others. With 

Outlook Express, you can simply forward the original message to other e-mail addresses 
using the method given below. 

1. In the message list, click the message you want to forward. 
2. On the toolbar, click the Forward button as shown in figure. 
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3. A forward message window will appear. The original subject line will appear in the 
Subject box, along with the abbreviation. 
 

 
 

4. In the To box, type the recipient’s e-mail address. 
5. You can add your comments by typing in the message area. On the toolbar, click the 

Send button.  
6. Once the e-mail is sent, the Forward message window will be closed. 

 
7.3.6 Sorting and searching e-mails 
 You can sort your messages based on different kinds of information: the date you 
received them, who you received them from, or their subject. You can sort messages in a 
couple of ways: using the Actions menu or using the column headers. 

To sort messages using the Actions menu: 

1. Open a folder.  
2. Click Actions and choose a sorting option. 
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To sort messages using a column header: 

1. Open a folder.  
2. Click the Date column header. 

 

3. The direction of the arrow changes, and the contents of the folder are restored in 
ascending order, so the most recent message appears at the bottom of the list. 

 

4. To sort the messages by the data in a different column, click the desired column 
header. For example, click From to sort by the senders of the messages. 

 

The sort order arrow appears on the selected column header, and the contents 
of the folder are restored based on this column’s data. The sort order (that is, 
ascending or descending) remains the same as it was on the last column—ascending 
in this case. 
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To find mail in Yahoo! Mail:  

 Type your query into the Find Messages... box.  
 You can search for an exact quote by surrounding your terms with quotations marks. 

Type '"melodic enthusiasm"' (including the inner but not the outer quotation marks), 
for example, to find messages containing "melodic enthusiasm" as a phrase.  

 See below for operators to search specific email fields.  
 Hit Enter or click Go.  

Yahoo! Mail Search Operators 

You can precede search terms with special operators to search only in certain fields, not 
across all of an email's content and headers.  

 from: — Search for email addresses and names (or parts thereof) in the From: fields 
of your emails.  

 Type "from:homer" (not including the quotation marks), for example, to find all 
messages from, say, "Homer <sim@yahoo.com>" or "Dad <homer@yahoo.com>".  

 You can also search for a full name by surrounding it with quotation marks: 
'from:"Homer Simpson"' (including the inner quotation marks), for example.  

 subject: — Search for words or phrases in Subject: lines.  
 Type "subject:email" (excluding the quotation marks) to find emails that have "email" 

in the Subject: line, for example.  
 Use 'subject:"about email"' (including the inner quotation marks) to find emails with 

the phrase "about email" in the Subject: line.  
 To search for two terms anywhere in the Subject:, use two "subject:" operators, such 

as "subject:about subject:email".  
 to:, cc:, bcc: — Search Cc: and Bcc: fields in a manner analogous to the To: field 

above for email recipients.  

Combining Search Terms and Operators 

You can combine search terms and operator to further search results' precision:  

 Separate multiple search terms, phrases and operators with a white space character to 
create queries whose results must match all terms.  

 Precede a term, phrase or operator construct with "-" to exclude it from results.  
 To search for all mail from Homer that have "about email" but not "caramba" in the 

Subject: line, use 'from:homer subject:"about email" -subject:caramba' (not including the 
outer quotation marks).  

 
Advance email features 
Now you know how to send a plain e-mail. You would also like to send a multimedia rich 
mail to your friends. It is also possible to send a document directly as an email message. You 
don’t need to remember the address of your friends; Outlook Express will do this for you. It 
maintains an address book that can be used to store details of your friends. Spellings and 
grammar can also be checked using spell feature of outlook express. 
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Sending Document by email 
1. Go to the page you want to send. 
2. On the File menu, point to Send, and then click Page by Email or Link by email. 
3. Type the address you want to send the Web page to, and then click the Send button on 

the toolbar. 
4. To include the Web page or link in an e-mail message, you must have an e-mail 

account. 
 

Activating the spell-checker 
Outlook Express can automatically check the spelling in all your messages. The spelling 
command may not be available if you do not have Microsoft Office 97/XP programs (e.g. 
Microsoft Word, Microsoft Excel, or Microsoft PowerPoint) Installed on you computer. 

1. In the Outlook Window, click the Tools menu, and  click Options. The Options dialog 
box will open as shown in figure 

2. Select the spelling tab. Click the check  the check box next to “Always check  spelling 
before sending”, “Suggest replacements for misspelled words” and Click OK. 

 
 
Using Address book 
Addresses of your friends can be kept in Address Book. The Address book is a convenient 
place for you to store e-mail addresses. You can add new contacts to your Address Book by 
typing them in or by adding them directly from e-mail messages. 

1. On the toolbar, click the address book button. The address book window will open as 
shown in figure. 

2. On the Address Book toolbar, click the New, Contact button. The Properties dialog 
box will open as shown below. 

3. Select the Personal tab and type the contact’s first and last name in the name boxes. 
The full name is automatically added to the Display Box. If you want a different name 
to appear in the box, type it in. 
 

 
4. In the Add new box, type the contact’s e-mail address, and click OK. The contact is 

now saved in your Address Book 
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Adding a Contact Directly from a Message 
You can add contacts to your Address Book directly from an individual message by using 

following method. 
1. In the message window, click the contact’s name to select it. 
2. Click the Tools menu, point to Add to Address Book, and click Sender. 
3. The Properties dialog box will open. The e-mail address will already be filled in as 

shown in figure. 
4. Add any additional information, and click OK. The contact’s name is now added to 

your Address Book. 
 

Check Name 
Instead of looking-up the information, you can fill in a partial name or address in the To: 

box. Outlook Express will search your Address Book to find an entry that matches and fill in 
the rest for you. 

1. In the To: box, type the first few letters of a name in your Address Book. Outlook 
Express will try to complete the entry. If it doesn’t proceed to the next step. 

2. In the message window, click the Tools menu, and click Check Names as shown in 
the given figure. A Check Names dialog box appears. If more than one person in your 
Address Book has the same first name, the dialog box displays all matching names. 

 
If the name you want is shown, select it and click OK. The name will appear in the To: 

box of your message window. 
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Saving your Address Book to Disk 
It is possible to keep a copy of your address book on a floppy disk is better than paper. 
Follow these steps to perform above task: 

1. Open the Address Book. 
2. In the Address Book list, select the contacts that you want to save to disk. 
3. Click the File menu, point to Export, and click Address Book. The Address Book 

Export Tool will open as shown in figure. 
4. In the Export Tool Window, select “Text File” ( Comma Separated Values )  from the 

list, and click Export. The CSV Export dialog box will open. 
 

 
 

5. Click the Browse button to open the Save As dialog box. 
6. Fill in the following information: 

 In the Save in box, scroll until you locate the floppy drive [A:], then click it. 
 In the File name box, type a name for the file (e.g. Address Book), then in the 

Save as type box, select “Text Files” 
 Click the Save button. The Save As dialog box will close and you will return 

to the CSV Export dialog box. 
7. In the CSV Export dialog box, click the Next button, then click Finish. The Export 

dialog will close. A message box will appear confirming that the Address Book has 
been successfully exported. When you open the Address book file from your floppy 
disk, it will automatically open using the Notepad program on you computer.  
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Sending Softcopy as Attachment 
If you are attaching a link or picture, make sure HTML formatting is turned on by 

clicking the Format menu in the message window and then clicking Rich Text (HTML). A 
black dot appears by the command when it is selected. 

1. In the message, click where you want the image or file to appear, or select the text 
that you want to link to a file or Web Page. 

2. To insert a file, click the Insert menu, click File Attachment, and then double-click the 
file you want to send or select the file and click attach as shown in figure. 

 
3. To insert an image, click the Insert menu, and then click Picture. Click Browse to find 

the image file, and then double-click the file name. 
4. To Insert a link, click the Insert Hyperlink button on the formatting toolbar, select the 

file type, and then type the location or address of the link. 
5. If message recipients are not able to view your inserted images, click the Tools menu, 

and then click Options. Click the Send tab, click Settings and then make sure that 
Send Pictures with messages is selected. Then resend your message. 

 
Spam Handling 

Spam mails are also known as Junk or Unsolicited Bulk Mail. In spam same message 
is delivered to lot of recipients. 1990 onwards there is remarkable increase in the number of 
Spam mail. According to the information noted in April 2008, the number of spam mails was 
more than 100 billion per day. More than 80 percent spam messages are created and delivered 
by less than 200 spammers. With the help of Bot net’s Virus Affected Computer Network 
more than 80 percent spasm are delivered.   In case of spam mails, lot of times the expenses 
have to be paid by the recipients and not the sender, thus they are used as the inexpensive 
media of advertisement. 

In last few years the attempts are done to reduce the number of spam mails. Various 
filters are used to block the contents of spasm.  The technologies like Domain Name based 
Black Hole Lists, Grey Listing, Spam Traps, system check for bulk mail and others are being 
used to reduce the number of spam mails. 
 
Smiley 

A smiley or happy face, is a stylized representation of a smiling human face, 
commonly represented as a yellow (many other colors are also used) circle (or sphere) with 
two black dots representing eyes and a black half circle representing the mouth. “Smiley” is 
also sometimes used as a generic term for any emoticon. 
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John Smith designed the first Smiley face. The graphic was popularized in the early 
1970s. Smiley has been a registered trademark in some countries since 1971 

Smiley Expression 

 

Simple Smile is usually written like this, :) or (: or :] or [: or =) or (= or :-) or (-: 

 

Confused Smiley is usually written like this, :S or S: or :/ or :\ or /: or o_O or O_O or 
o.O or O.O 

 

Simple Frown is usually written like this, :( or ): or :[ or ]: or :'( or )': 

 

Shocked Smiley is usually written like this, :O or O: or :o or o: 

 

Smiley with Tongue sticking out is usually written like this, :P or q: or :p. If you use 
ASCII keys then, :Þ, is also possible. Press ALT + keypad0222 for "Þ" 

 

Smiley with big grin is usually written like this, :D or :]] or [[: 
 
 
7.4 Document Collaboration: 

Document collaboration is how you share data in a consistent manner, so it can be 
retrieved, reviewed, approved, and audited by authorized individuals. 

This means that your success in using document collaboration depends on selecting 
tools that provide a secure way to upload, find, and review documents – and then involving 
others in the review process. 

Let’s take a look at some of the risks associated with sending documents over email 
compared to more secure methods. 

Seven  Document Collaboration Risks 

When companies come to us, they’re usually looking at how to move from email – 
which they know is fraught with technical and legal issues – and explore web-based tools that 
simplify the Document Review process. 

During our workshops, we explore the risks associated with document collaboration and 
how they can improve their business processes. Here some examples of how we get started. 

1. Guidelines – We work with organizations to develop a set of guidelines for reviewing 
the documents so each contributor understands what is expected of them during the 
review process. What may be obvious to you, especially if you are more proficient 
with web technologies, may be more challenging for other individuals! 

2. Ownership – Each document must have a Document Owner. This person is 
responsible for driving the document through the review cycle and ensuring that it’s 
approved on time. Furthermore, this single point of contact can coordinate input from 
different authors and smooth out any political issues that may arise – for example, if 
several C Level executives are contributing to the same text 
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3. Security – Sharing documents by email creates different security risks, especially for 
confidential documents. For instance, you’re in a hurry to send an email, you type in 
the address, add the attachment and hit Enter. One wrong letter, character, or number 
– that’s all it takes. That confidential contract for Anne goes to Anna instead. You 
can imagine the damage this can be to one’s credibility. 

4. Progress Reports – While we all enjoy the convenience of email, there is no way to 
tell if others have started reviewing the document or if they’ve even opened it. 
Wouldn’t it be great if when someone reviewed your document, you received a 
confirmation message telling you what they’d written? One of the nice features in 
Agilewords is that you choose between automatic and daily emails whenever a 
Reviewer provides feedback on the document. This provides an audit trail all the 
comments and changes over the document lifecycle. 

5. Scheduling – One of the limitations of email is that while you can remind others to 
complete the document review by a specific date, they may ignore this or simply not 
see it in the email. When we developed Agilewords, we designed it so that you can 
schedule review tasks across the team and merge their comments into the final 
document, so it’s approved on time – every time. For legal firms, this helps avoid 
liability issues that may arise when incomplete or invalid documents are submitted. 

6. Version Control – Firms have told us that most employees don’t know how to use 
Track Changes or Version Control features in Microsoft Word correctly. And, from 
one angle, they shouldn’t have to. Their expertise lies elsewhere. Time spent 
wrestling with documents is billable time lost. One way this can be addressed is by 
creating a Master copy online, which is accessible by all authorized personnel. This 
avoids ‘version madness’ where multiple versions of the same document are in 
circulation, making the review process virtually impossible. Tools like Agilewords 
help you avoid this since the service assigns Access Rights to each document, 
meaning that the right person reads the right document. Furthermore, it also ensures 
that someone in a junior position does not have authority to override text written by a 
senior manager. 

7. Workflow – The true measure of success with Document Collaboration lies in 
improvements to the current processes, reduction in costs, and satisfied clients. You 
don’t want a scenario where highly-paid team members spend hours cutting and 
pasting between documents. The benefit that Agilewords offers our clients is that it 
simplifies the document review process. It reduces the steps involved in the review 
process, so your staff can contribute faster and move onto the next task. 

 
7.5 Instant Messaging and Collaboration 

Instant messaging (IM) is a collection of technologies that create the possibility of 
real-time text-based communication between two or more participants over the internet or 
some form of internal network/intranet. It is important to understand that what separates chat 
and instant messaging from technologies such as e-mail is the perceived synchronicity of the 
communication by the user - Chat happens in real-time. Some systems allow the sending of 
messages to people not currently logged on (offline messages), thus removing much of the 
difference between Instant Messaging and e-mail. 

IM allows effective and efficient communication, featuring immediate receipt of 
acknowledgment or reply. In certain cases Instant Messaging involves additional features, 
which make it even more popular. For example, users can see each other by using web-cams, 
or talk directly for free over the Internet using a microphone and loudspeakers. 
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7.5.1 Using Instant Messaging: 

The Internet has revolutionized the way we communicate. E-mail has been the most 
rapidly adopted form of communication ever known. Less than two decades ago, not many 
people had heard of it. Now, many of us e-mail instead of writing letters or even calling 
people on the phone. People around the world send out billions of e-mail messages every day.  

But sometimes even e-mail isn't fast enough. You might not know if a person you 
want to e-mail is online at that moment. Also, if you're e-mailing back and forth with 
someone, you usually have to click through a few steps. This is why instant messaging (IM) 
has become so popular.  

With IM, you can keep a list of people you interact with. You can IM with anyone on 
your buddy list or contact list as long as that person is online. You type messages to each 
other into a small window that shows up on both of your screens. 

Most IM programs provide these features: 
 Instant messages - Send notes back and forth with a friend who is online  
 Chat - Create a chat room with friends or co-workers  
 Web links - Share links to your favorite Web sites  
 Video - Send and view videos, and chat face to face with friends  
 Images - Look at an image stored on your friend's computer  
 Sounds - Play sounds for your friends  
 Files - Share files by sending them directly to your friends  
 Talk - Use the Internet instead of a phone to actually talk with friends  
 Streaming content - Real-time or near-real-time stock quotes and news  
 Mobile capabilities - Send instant messages from your cell phone  

 
7.5.2 Instant Messaging providers 
 
  AOL Instant Messenger (AIM) became the IM leader. In the past few years, 
though, a number of services have cut into AIM's audience. Windows Live Messenger 
(formerly MSN Messenger) and Yahoo! Messenger, in particular, have become widely used 
around the globe. Google recently introduced its IM system, Google Talk. Proprietary 
multiprotocol applications like Trillian and Pidgin, which allow users to IM on several 
services at once, are also rapidly gaining in popularity.  
 
7.5.3 netiquettes 

While using Internet some etiquette has to be followed. These Etiquette / Netiquette 
began before the 1989, start of the World Wide Web.  We will discuss some etiquette to be 
followed while using the e-mail services. 

 First, there are the users who have no idea that the 'Cc' exists. Every address is listed 
in the 'To' even if the email is only directed to one person. Secondly, there are users 
who feel that every single e-mail should be copied to their entire address book 
whether it's relevant to those receiving it or not. The addresses in the 'Bcc' are like 'Cc' 
except that the addresses in 'To' and 'Cc' do not know that the addresses in the 'Bcc' 
are included in the conversation. The 'To' and 'Cc' addresses are blind to the 'Bcc' 
addresses. As you can imagine, use of the 'Bcc' is somewhat unethical and therefore 
its use is discouraged. 
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 The 'Reply to All' button is just a button, but it can generate tons of unnecessary e-
mails. For example, if I send a dozen people an e-mail asking if they are available at a 
certain time for a meeting I should get a dozen replies and that's it. However, if each 
person hits the "Reply to All' button not only do I get a dozen replies, but so does 
everyone else for a total of 144 messages! 

 First check the recipients of the e-mail which you have received before forwarding it 
to other, it may be possible that the message may be already received simultaneously 
when you received the message.   

 Don't get caught up in grammar and punctuation, especially excessive punctuation. 
 There are lots of e-mail clients (and some servers) which cannot handle messages 

when they are highly formatted, so try simple formatting for your messages. 
 In a business and non-business situation use proper type of salutations. 
 Use abbreviations that are already common to the English language. 
 Make your messages short and to the point. 
 Avoid the use of Capital letters, Bold of similar type of formatting for all the matter. It 

means avoid over highlighting the matter. 
 Since there are no visual or auditory cues with e-mail, users have come up with 

something called "smilies". They are simple strings of characters that are interspersed 
in the e-mail text to convey the writer's emotions.  

 Sometimes it may be possible that the recipient is not familiar to the person who is 
sending the message. So it is good practice to include the Signature lines at the end of 
the e-mail. It will help the recipient to find out the sender’s name, post working 
location etc. 

 While sending the attachment file size is up-to 1 MB for dial-up and more for 
broadband communication.  

 
Check Your Progress 

Q.1 How replaying to an e-mail? 
Q.2 How sort and searching the e-mail. 

 
7.6 Summary 

 Electronic mails are new mode of communication; they have header part where 
address and subjects of recipients are mentioned, message area where actual 
message is written and signature part which defines the identity of sender. 

 Dial-up connection can be configured so that computer can access Internet or 
email through service provider (ISP). 

 Different protocols are used in email like POP, SMTP, IMAP, LDAP. 
 Outlook Express can be used to send and receive emails through dialup and LAN 

connection. 
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Chapter-08  
 

Making Small Presentations 
 
8.0    Introduction  
8.1 Objectives  
8.2 Basics  
8.3 Creation of Presentation  
8.4 Preparation of Slides 
8.5 Presentation of Slides 
8.6 Slide Show 
8.7 Summary 
8.8 Model Answers 
   
8.0 Introduction: 

Power Point is used to create overhead transparency, 35mm slides, photo print or on-
screen presentation. Speakers’ notes and audience handouts can be generate, presentation 
contents with outlines can be organized with the help of different components of Power 
Point. Presentation can be created by typing the text, and inserting picture, sounds and 
animation. It also provides galleries of image and sounds. Design elements like auto layouts 
and presentation templates make the creation of any presentation offers a way to preview 
show, add special effects to the slides as displayed on screen and rehearse the timings of each 
slide. 

Navigation through on-screen slides and jumping to the first or the last slide is 
possible by using the action buttons options from the Slide Show menu. A particular 
combination of slides can be made by creating a custom show. One can preview and insert 
slides from another presentation by using the slide finger, animation charts and enhanced 
custom animation another. Presentation may also be run from a kiosk.  

 
8.1 Objective: 
After going through this unit you will be able to: 
 Create a Power Point Presentation  
 Insert and delete slides in new presentation 
 View a presentation 
 View with colours 
 Add header and footer 

 
8.2   Basics: 

In this section we discuss the elementary operations like opening, saving of Power Point 
files and different options of Power Point dialog box. 
 
8.2.1  Using Power Point: 
To use Power Point: 
1. Click on the start button located at the bottom left corner of your window environment. 
2. Select the Programs option from the Start menu. 
3. Select the Microsoft Power Point option from the Programs submenu as displayed in the 

given figure. 
4. Power Point dialog box with following options appears 
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Power Point Presentation Screen: 

The four options in the Power Point dialog box are: 
 

Auto Content Wizard  
if you click on the Auto-Content Wizard option, it displays a list of presentations that 

you can select. After this, a series of Wizard dialogs you through the creation of the new 
presentation. 

 
Design Template 

Presentation templates are built-in designs that contain colour schemes and design 
elements that provide a background for a slide. They are also referred to as design in Power 
Point slide. 

 
Blank Presentation 

Open a presentation with no elements or design background in place. This selection 
offers a lot of flexibility in creating you presentation elements. 

 
Open an Existing Presentation 

Opens a browse dialog box to locate a Power Point file that has previously been saved.  
 
8.2.2  OPENING A POWER POINT PRESENTATION  

You can open a presentation by selecting the Open an existing presentation option 
from the Power Point Task Pane. You can also open a presentation by selecting the Open 
option from the file menu. 
 
8.2.3 SAVING A PRESENTATION  
1. Select Save as option from the file menu. A Save as dialog box is displayed as shown 

in the Figure.  
2. Enter the file name 
3. Click on the Save button. 

 
If you want to save the changes to an existing file, select the Save option from the File 

menu. The latest version of Power Point also allows you to make a Web page out of any 
presentation by saving it in HTML format. Select Save as HTML option from the File menu. 
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8.3 CREATION OF PRESENTATION: 

Power Point offers a variety of ways to create a new presentation. You can create the 
presentation by using a wizard or templates, or you can create blank presentations that contain 
no colour or style or enhancements.  

 
8.3.1  CREATING A PRESENTATION USING A TEMPLATE  

When predefined slide and title masters, colour schemes and graphics elements are 
saved in a presentation file, it is called a presentation template. A presentation template 
includes masters with preformatted fonts and styles. 
If you select the Template option from the Power Point Task Pane, the New Presentation 
dialog box is displayed as shown in the given figure.  
 

 
 

Select the Auto layout you want and click on the OK button. It lets Power Point to do 
the work for you, it saves the time and trouble of creating new objects fro new slides and 
arranging and aligning them. Each Auto Layout contains placeholders for various kinds of 
objects such text, clip art, organization chart and so on. Select the layout you want for your 
new slide and then click on the OK button or double click on the layout you want to use. 

 
8.3.2 CREATING A BLANK PRESENTATION  

When you create a blank presentation, the default templates called Default Design use 
no colour and include no styles or enhancements as shown in the figure given below. When 
you create a blank presentation, you have a full control of the colour scheme, layout and style 
or your slides. You can add a template, colours and other enhancements selectively at any 
time by  
To create blank presentation: 

1. Select the New option from the file menu. Task pane will be displayed .  
2. Select a suitable layout and click on the OK button. You can also create a blank 

presentation by pressing Ctrl + N keys. 
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8.3.3 ENTERING AND EDITING TEXT: 

Every slide’s in a presentation contains text of some kind, even if it is just the title. 
Entering and editing text in Power Point is similar to entering and editing text in any Office 
application. 

The slide normally consists of title part and sub title bar. Depending user need we can 
change the documentation area. 

 
 
Typing the Content for Slides  

A method of entering slide text involves replacing the sample text in a slide 
placeholder with your own text. The slide shown in Figure, includes tow placeholders, one 
that contains a sample title and one that contains a bulleted list. A faint dotted line appears 
around each placeholder. Click anywhere within a placeholder to select it. A wide hashed 
border replaces the faint outline. The sample text disappears and an insertion point appears 
inside the placeholder. In a bulleted list, placeholder, the sample text disappears and the 
bullet remains, with the insertion point positioned where the text will begin. In a title or 
subtitle placeholder, the insertion point may be cantered or left aligned. When you finish 
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entering text, deselect the object by clicking by clicking on a blank area of the slide or the 
gray border around the slide.  

 
Creating New Text Object 

Select text box button on the drawing tool bar. Place the cursor where you want to 
insert the text.  Click with left mouse button. Click with left mouse button. Text box with 
insertion point will be displayed. Inter the desired text in the text place, the text box will be 
resized according to the text entered in the text box. If you want to type in the next line press 
enter key. 

 
Changing Text and Correcting Errors 

Click on the text object to make changes. An insertion point is displayed, indicating 
that you can edit the text. You can use the cut, copy, paste, clear and select all options from 
the Edit menu to edit the text. When text is selected on a slide, the Cut, Copy and Paste 
commands appear when you click the right mouse button to display the shortcut menu. 
Expand Slide is new feature of Power Point the allows you to easily break up a single slide 
into several individual slides. Display a slide with a great deal of text on it, and then select the 
Expand Slides option from the Tools menu. Power Point breaks up the text to create several 
slides. 

When you finish editing text, deselect the object by clicking on a blank area of the 
slide or the gray border around the slide.  

 
 

8.3.4 Inserting & Deleting Slides In A Presentation: 
After you create your presentation file, you can add, insert or delete slides wherever 

necessary. 
 
Adding Slides: 

1. Select the New Slide Option from the Insert menu. This invokes the New Slide 
dialog Box displaying the slide layout. 

2. Select an appropriate Auto Layout from the New Slide dialog box. 
3. Click on the OK button. 

If you want to add your own objects, text or pictures to a slide, select the appropriate option 
from the insert menu.  
 
Inserting Slides: 

Slides can be inserted before or after a particular slide. You can select in the Slide 
Sorter View and then add a slide by using the New Slide option from the Insert menu. This 
action will result in the new slide being inserted after the selected slide. 
To insert the slides from another file, select the Slides from Files option from. With the help 
of browse button you can start the slide finder dialog box. With the help of this box we can 
select the file from the available files and insert the desired slide from that file. 
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Changing Text & Correcting Errors: 
Click on the text object to make changes. An insertion point is displayed, indicating 

that you can edit the text. You can use the Cut, Copy, paste, Clear and Select All options; 
from the Edit menu t o edit the text. When text is selected on a slide, the Cut, Copy and Paste 
commands appear when you click the right mouse button to display the shortcut menu. 
Expand Slide is new feature of Power Point the allows you to easily break up a single slide 
into several individual slides. Display a slide with a great dial of text on it and then select the 
Expand Slides option from the Tools menu. Power Point breaks up the text to create several 
slides. 

When you finish editing text, deselect the object by clicking on a blank area of the 
slide or the gray border around the slide. 
 
Contents: 

The insert menu, Selecting the Browse button displays the Insert slides from the Files 
dialog box. This allows you to browse through other presentation and select slides from those 
presentation sets. 

 
Deleting Slides: 

To delete the slide mark the slide to be deleted and select the Delete slide option fro m 
the Edit menu. You can select the slide in the Slide Sorter View and press the Delete key to 
delete a slide.  

 
8.4 Preparation of Slides: 
8.4.1   Inserting word  Table and Excel Worksheet 
A table of data can convey useful information on a slide.  
 
To insert a able: 

1. Click the Insert Table Button on the Standard toolbar. 
2. Click and drag the mouse pointer across the cells to indicate the rows and columns 

you want. 
3. Release the mouse button, Power Point inserts a special object into your slide. 
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To create the contents of your table:   
1. Select the area in which you want to add text, or press Tab to move the insertion point 

from left to right across the cells in the table. 
2. Use the Up and Down arrow key to move from one row to another. 
3. Use the standard editing conventions to enter and edit the text in the table. 
4. To deselect the Table or Worksheet, click on any blank area outside the table or the 

gray are that surrounds the slide.  
5. You can make changes to a table by double click inside the table.  

 
Inserting Excel Worksheet: 
 The great thing about the Microsoft Office Suite is the fluid interaction of each 
application type. By embedding the Excel document into your presentation or document you 
can use it to make a point more effectively with numbers or even graphs. 

First let’s take a look at easily embedding a new blank Excel document.  Open up the 
PowerPoint presentation (or Word document) to add the Excel worksheet, then Insert  
Object. 

In the Insert Object dialog box select Microsoft Office Excel Worksheet and click on OK. 
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Now you can start entering data into the new Excel worksheet.  You will notice that 
all of the Excel controls will now be shown in the Ribbon.  This can come in very handy 
when you need to create a new worksheet within presentation quickly. 

 

After embedding the file you can work to adjust the slide for the presentation and also 
continue to work on the Excel sheet. 

 
8.4.2 Adding Clip Art Pictures  
 Clip art a collection of graphics files. Inserting a Clip Art drawing is one of the 
best way to enhance a slide show. Using this artwork in your presentation can help you make 
a point, add humour or simply make the presentation visually more interesting to the viewers. 
Power Point is supplied with a library of Clip Art. 
 
To add Clip Art Pictures: 

1. Select the slide into which you want to insert the Clip Art. 
2. Select the Picture option from the Insert menu. 
3. Select the Clip Art option from the Picture submenu. If your slide contains a Clip Art 

placeholder, double-click on it. The Microsoft Clip Gallery dialog box is displayed as 
shown in the following figure. 

4. The Insert menu, selecting the Browse button displays the Insert slides from the files 
dialog box. This allows you to browse through other presentation and select slides 
from those presentation sets. 

 
Deleting Slides  

To delete the slide, mark the slide to be deleted and select the slide to be deleted and 
select the Delete Slide option from the Edit menu. You can select the Slide in the Slide Sorter 
View and press the Delete Key to delete a slide. 
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8.4.3 Inserting Other Objects  
To insert a new file another application: 

1. Display the Power Point slide into which you want to insert an object 
2. Select the Object option from the Insert menu. The insert Object dialog box is 

displayed as shown in figure. 

 
3. Select to create new option from the dialog box  
4. If you want to display the object as an icon then select the display as icon option. 
5. From the object type list displays the type of file you can insert you’re your slide. 
6. From the object type list, select the type of object you want to insert.  
7. Click on the OK button, this closes the Insert object dialog box and the window or 

the appropriate application opens on the top of the Power Point window. 
8. To use the application for the cases in which you select an item, Power Point 

inserts the item and closes the application. In case you create a new file, return to 
Power Point by select the Exit option and Return to (file name) command from the 
open application file menu. The Applicator window closes and the file you crated 
is inserted into the current Power Point slide. 

9. Click on any blank area of the slide of the gray area surrounding to be deselect the 
object. 
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To insert an existing file from another application 

When you insert an existing file from another application, the file is inserted to the Power 
Point directly; Power Point does not open the application which is used to create a file. If you 
want to modify the file, you must open the application by double clicking on the object after 
it is inserted into your Power Point slide, to insert an existing file from another application. 
 

1. Display the Power Point slide into which you want to insert an object. 
2. Select the Object option from the Insert menu. The Insert Object dialog box is 

displayed as shown in previous figure. Select the Create from file option. The new 
insert object dialog box is displayed as shown in figure. 

3. If you know the name of the file, type the complete path name in the File Box. If 
not, click on the Browse button, which displays the browse dialog box with the 
directory tree.  

4. Select the correct file name and click on the OK button. The selected file name 
appears in the file box. 

5. If you want to display the object as icon, them select the Display as icon option 
6. Click on the OK button 
7. Click on any blank area of the slide or the gray area surrounding the slide to 

deselect the inserted object. 
 

8.4.4 Resizing & Scaling an Object: 
The resize handles that appear at he corners of an object enable you to resize the 

object in two dimensions. When you click on the resize handle in the upper right corner of an 
object, you can change the height or width of the object by dragging the handle in any 
direction. If you want to maintain an object’s height-to-width ratio, hold down the Shift key 
as you drag any corner’s resize handle. If you want to resize the object in two dimensions 
simultaneously, from the center of the object outward, hold down the Ctrl key as you drag 
any coroner handle. By holding both the Shift and Ctrl keys as you drag a corner handle, you 
can maintain an objects height-to-width ratio and resize from the center outward. 
Scaling is another way of resizing an object. Scaling enables you to specify an object’s size 
by percentage.  
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To scale an object: 
1. Select the object for scaling. 
2. Select the auto shape option from the Format menu. Following format AutoShape 

dialog box is displayed. 
3. Select the size tab from the Format AutoShape dialog box. 

4. In the Height and Width boxes, enter a number greater than 100 to enlarge the 
object or a number smaller than 100 to reduce the object  

5. Select the Lock aspect ratio check box to keep the height or width intact. 
6. Click on the Preview button to preview the object  
7. Click on the OK button. 

Power Point determines the scale for a picture by selecting the Best Scale for slide show 
option in the Size tab of the Format AutoShape dialog box. 
 
8.5 Presentation of Slides:  
 

8.5.1 Viewing a Presentation:  
 

Power Point offers several ways to view a presentation. Each view has a particular 
purpose and advantage. The quickest way to select a view is to click on the View buttons 
located all the bottom left corner of the Power Point window as shown in Figure. You can 
also select the View option from the view menu. 
 
Zooming In & Out: 

Regardless of the view you select, Power Point displays the Presentation at a present 
percentage of its full size. The percentage Power Point uses varies, depending on your video 
driver, the screen resolution you use and the size of your monitor. Power Point use a different 
zoom for percentage for each view. 
 
To Specify The Zoom Percentage: 

1. Select the Zoom option from the view menu. A zoom dialog box is displayed as 
shown in previous figure.  

2. Select the percentage. 
3. Click on the OK button. 
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You can also select the zoom option from the Zoom Control drop-down list from the standard 
toolbar. 
 
Normal View 

The Slide view is used to create and edit slides, this is the default view when your first 
open Power Point. The Slide view displays individual slides in the current Power Point 
window. In this view, all the menus and toolbars are available for use, to display the Slide 
view. Select the Slide option from the View menu. 
 

 
 
Slide Sorter View: 
 

The Slide Sorter view gives you a miniature picture of each slide as shown in given 
figure. You can use this view to select and drag slides from one position to another within the 
slide show. The slide number appears near the bottom-right corner of each slide. When the 
presentation output is intended to be a slide shown and you have added the display duration 
by rehearsing the presentation, the amount of the time each slide is displayed during the slide 
shown appears near the bottom-left corner of each slide. 
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To select a slide in Slide Sorter view, use the arrow keys to highlight the slide or click 
on the slide your want to select a bold outline surrounds the select slide. 
 

 
 
Notes Page View: 

The notes Page view is used to enter notes forth sides within a presentation as shown 
in the figure given below. Each Notes Page includes an image of the associated slide. Below 
that, there is an area where you can enter any text. Notes Pages act as a script for the 
presentation. You can write out the information you want to include about each of the slides. 
It can hold as much text as you can fit on one page. To display a Notes Page view, Select the 
Notes Page option from the view menu. 
 

 
 
Slide Show View: 

The Slide Show view displays the slide full screen, when you use this view, the Power 
Point windows is not visible and each slide occupies the complete screen areas as shown in 
figure. This view helps you to check the final sizes, colours, animation, transitions between 
slides, sounds and other controls. To display the slide show view, select the show option from 
the view menu. 

 
8.5.2 Choosing a Set up for Presentation: 

You can display a presentation as an on-screen slide show, as 35mm slides, as 
overheads or as some other type of printed output. You can also specify other properties of 
presentation, of presentation and Power Point adjusts the presentation to best suit you 
selections. 
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To select a set-up for slide notes, handouts and outlines 
 
1) Open the presentation for which you want to specify a set-up 
2) Select the Page Setup option form the File menu. The page Setup dialog box is 

displayed as shown in Figure. 
 

 
 

3) Select an appropriate option from Slides sized for drop-down list. 
4) Enter a number other that 1 in the Number slides from box. 
5) To change the print orientation for slides, Notes, handouts or an outline, select either 

the Portrait or the Landscape option. When you select Portrait, the slide is taller than it 
is wide and landscape creates slides that are wider than they are tall. 
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8.5.3 Printing Slides & Handouts: 
To print a presentation: 

1. Open the presentation you want to print. 
2. Select the Print option from the File print dialog box is displayed as shown in 

Figure. The current printer is displayed at the top dialog box. 
3. Select from different options and Click on OK button to close the Print dialog box 

and print the active presentation. 
 

 
 

Making Setting in the Print Dialog Box: 
Once your printer is set up, Power Point allows you to print any component of a 

presentation: slides, notes, pages handouts and an outline. To print a component, select the 
Print option from the File the File menu to display the Print dialog box as shown in above 
figure. In this dialog box, you can select the component you want to print, the number of 
copies, the specific pages to print and other printing options.   

 
Printing Different Kinds of Output: 

The Print what option of the print dialog box controls which type of output you want for 
your presentation. There are few variables to keep in mind, depending on whether you have 
chosen to print a slide, an outline, a notes page or a handout. When you are printing slides, 
the print range area of the Print dialog box gives you a number of printing options- you can 
print only the current slide, all slides, the slides selected in the presentation or a range of 
slides that you specify. 

 
 If you select notes pages in the print what select of the print dialog box, you will print 

a reduced slide at the top of the page and speaker’s notes at the bottom of the page. 
Since Notes pages print one slide per page, you follow the same basic steps for 
printing slides. 

 If you select Handouts in the Print what selection of the Print dialog box, Power Point 
lets you print by using one of three different layout styles: two, three or six slides per 
page. To print select handout pages, it is not necessary to determine on which page a 
slide will print. You need to specify the slide number- set in the Slide Setup dialog 
box- that you want to print in the Slide box. 

 You can print a presentation in outline view also.  
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8.6 Slide Show: 
One of the most effective ways to present on screen show is on the computer screen, 

the entire screen area is used, and Power Point’s title bar, menu and toolbars are cleared from 
the screen. 

An on-screen slide show offers several slide show offers several advantages over 
transparencies or 35m slides:  

 It helps you to easily move around the presentation 
 It makes other information available during the presentation, for example, you can 

open other computer programs, to get additional data or you can link to a World Wide 
Web site. 

 It enables you to utilize multimedia effects, such as animation and video clips. 
 It allows you to annotate your slides as you give your presentation. 

 
8.6.1 Running A Slide Show : 
 
To run a slide show from within Power Point: 
1) Open the presentation for which you want to run the slide show. 
2) Select any view such as slide, outline slide sorter, notes page or slide show views. 
3) Select the setup shown option from the slide show menu. The setup show dialog box 

is displayed as shown in figure. 

 
 
4) In the Slides area of the dialog box, select all enter a range of slides.  
5) In the Advance slides area, select manually or select using timings, if present. 
6) For a continuously looping presentation, activate the loop continuously until ‘Esc’ 

check box.  
7) To have your presentation appear filling the entire screen, select either presented by a 

speaker (full screen) or Browsed at a kiosk (full screen) check box. 
8) If you have added narration or animations to your presentation and do not wish to use 

these sounds and videos files when you run the slide show, select shown without 
narration or show without animation check boxes. 

 
You can also run a slide show by click king on the slide show view option of the view 
buttons.  
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8.6.2 Setting Transitions & Slide Timings  
 

If you want to add more visual interest to your presentation, you can specify transition 
style between slides. The transition style determines how one slide is removed from the 
screen and the next and the next one is presented. 
 

1. Display the presentation in slide sorter view. 
2. Select the slide for which you want to set timings and transitions options. For 

multiple slides, select the slides as group. 
3. Select the slide transition option from the slide show menu. The slide transition 

dialog box is displayed as shown in Figure. 
4. Select an appropriate transition style from the Effect drop-down list. 
5. Select the appropriate speed option. 
6. Select one of the options of the Advance area to set time between the two slides. 

When the set times expires, the next slide is displayed. 
7. If you want to add sound, select an appropriate option from the sound drop-down 

list. Select the loop until next sound option, if you like to continuously loop the 
sound. 

8. Click on the Apply button to apply to the current slide only or apply to button to 
apply to all the slides in the presentation. 
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8.6.3 Automating a Slide Show  
You can select to advance to successive slides automatically during your presentation 

and you can set slide timings to control advancement to successive slides. You can also set 
slide timings as you rehearse a presentation. 
 
To automate a slide show: 
 

1) Select the Rehears Timings option from the Slide Show menu. The Rehearsal 
dialog box is displayed as shown in Figure. 

2) When you are ready to advance to the next slide, click on the arrow button on the 
Rehearsal dialog box. 

 
3) Alternatively, press Enter or press Page Down. 
4) Repeat Step 2 until all slides are shown. 
 

 
A message is displayed informing you of the total time for new slide timings. Select yes to 
record the new timings or select No to ignore the new timings and retain the previous 
timings. 

 
Check Your Progress: 
 

1) What is a presentation template? 
2) How to do create a blank presentation? 
3) How do you specify the zoom percentage? 

 
8.7 Summary: 
 
 The order in which slides are displayed can be altered by using the Slide Sorter View.  
 Power Point has all the editing functions you need to create an effective presentation.  
 Changing the look of a presentation is simple and easy with colour scheme and 

colours and line styles.  
 Templates determine the colour scheme, frame, font size and type and other 

characteristics that alter a slides appearance. 
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Chapter 9 
 

Antivirus Technology 
9.0 Introduction 
9.1 Virus 
9.2 Program/File infector virus or parasitic virus 
9.3 Antivirus software 
9.4 Data Backup and Recovery Tools 
9.5 Recovery tools 
9.6 Hacker and Cracker 
9.7 Summary 
9.8 Model Answers 

9.0  Introduction: 
Over the years, the use of computers has become widespread in areas such as business, 

government, defense, and even at home. This means that large amounts of vital and sensitive data 
are increasingly being processed and stored in computers. Data security has, thus, assumed great 
importance. In this chapter, we will discuss the various threats to the integrity, confidentiality, and 
availability of data and what can be done to combat them. 

 
9.1 Virus: 

A computer virus is a program that attaches itself to other programs in order to alter their 
behavior, often in a harmful way. A computer virus must enter a 'host' program in order to 
activate itself. Almost all viruses are attached to an executable file. A computer system is infected 
when the user runs or opens the host program. Sharing infecting files (e.g., over a network, through 
infected floppy disks/CD-ROMs, and through e-mail) spreads a computer virus from one computer 
system to another, mostly unknowingly. Different types of virus are described below 

 
Did you know? 

The term 'computer virus' was first defined by Fred Cohen in 1983 
 

9.2  Program/File infector virus or parasitic virus:  

This type of virus infects executable code files such as .exe, .com, .drv, .dll, .bin, .ovl, and 
.sys. It becomes active when the infected file is executed. 

 
Macro virus:  

A macro is a set of commands written by the user to be executed later, a macro virus uses 
the macro language for its program. Documents created using Microsoft Office applications 
such as MS Word, MS Excel, and MS Access, which use macro language, often get infected 
by this type of virus. 

Multipartite virus:  

This type of virus infects computer systems and spreads itself in multiple ways. 
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Polymorphic virus:  

This type of virus changes its code when it passes to another computer system, which 
makes it difficult for an antivirus program to detect it. 

Stealth virus:  

This type of virus uses various techniques to avoid detection by the user and/or 
antivirus programs. 

Worm: 
A computer worm is a program capable of reproducing and spreading itself to 

another computer system, usually by means of a computer network. It spreads without any 
human action. Computer worms usually do not cause direct damage to the programs and 
files in the computer system. However, they consume large amount of computer memory 
and/or network bandwidth, thus slowing down the computer and making it almost 
impossible for the user to work on it 

 
Trojan horse: 

A Trojan horse is a program that appears useful at first, but is actually programmed to 
pi the user's data or access rights (e.g., passwords) to someone else. Trojan horses do not re-
produce by infecting other files or by self-replicating like viruses and worms, respectively. 
When a Trojan horse is activated, it typically causes a change in the existing desktop icons or 
creates new ones. It may also delete some important system files. Its main aim is to steal 
sensitive information stored on the infected computer. 

9.3  Antivirus software: 
An antivirus software is a program designed to detect and remove malicious 

virus i.e., viruses, worms, and Trojan horses. The following is necessary in order for an 
antivirus program to be effective. 
• It needs to run in the background at all times. 

• It should be kept updated so it recognizes new versions of malicious programs. 
• It should have the capability to scan e-mail attachments and files as they are loaded 

from the Internet. 

• The user should run full disk scans periodically. 
Some examples of antivirus software are McAfee Virus Scan, Norton Antivirus. Kaspersky 
Anti-Virus. 
 
Spyware and Malware: 

Spyware is a computer program that secretly gathers information about the user and 
relays it to advertisers or other interested parties. It is also called spy-bot or tracking 
software. Spyware is often installed without the user's consent when 

• the user downloads something from the Internet or 
• When the user clicks some option in a popup window that appears while browsing. 
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Spyware can also consume a lot of computer memory, making the computer very 
slow and difficult to work with it. 

Malware (malicious software) is any program designed to infiltrate (and harm) a 
computer without the user's consent. It includes computer viruses, worms, Trojan horses, and 
spy-ware. Malware is not the same as defective software, which has a legitimate purpose but 
contains harmful errors. 

 
Precautions against malware: 

Run an antivirus program/a program specially designed to detect and remove spyware 
(e.g., Windows Defender) at least once a week and every time you have been doing a lot of 
web surfing. It will scan your hard drives and registry and give you a list of malware on your 
system. You can then quarantine or remove these programs. You should also avoid using 
pirated software/downloading and running executable files from unreliable sources to protect 
your computer from malware. 

Spam 
Spam refers to any unsolicited, unwanted e-mail. It may carry advertisements or serve 

as a means of spreading malware such as viruses and worms. 
 

Disadvantages of spam: 

 It wastes the user's time ( in reading unwanted e-mail). 
 It wastes network bandwidth. 
 It may be used to spread malware. 

 

Avoiding spam: 

Some of the ways of avoiding spam are given below. 

 Do not give your e-mail address to unknown persons/enter the same at unreliable 
websites. 

 Use the spam filter of your e-mail program to block unwanted e-mails. 
Delete spam mails without reading them 

9.4 Data Backup and Recovery Tools:   
Data backup means to make copies of data in a removable, long-term storage device. 

It allows the data to be stored in another location and, when required, an individual file or a 
set of files can be restored to a computer system. The additional copies are called backups. 

 
Why is backup required? 

Data loss can occur as a result of file corruption, fire, theft, hard disk crash, etc. If you 
regularly make backup copies of files on your hard disk and keep them at a separate place. 
You can get the lost data back if anything happens to the original files on your computer. 

 

 



151 
 

What to back up and where? 

Any file of folder containing important information should be kept as back-up. The 
following are some storage devices that can be used to back up your files: external hard 
drive. CD. DVD, and USB Plash drive. 

How to back up files? 

Files can be backed up by simply copying and pasting them or by using the built-in 
backup utility in Windows 2000. To use the backup utility in Windows, do the following. 

1. Click Start ► Programs ► Accessories ►System Tools ►Backup 
2. Microsoft Backup dialog box will appear. Select the option Create a new backup 

job and click OK  
3. Backup Wizard window appears. You can either back up everything on your com-

puter or specific drives, folders and files. Select the correct option, click Next, and 
follow the instructions of the wizard 

Some more backup software are EASEUS Todo Backup, Autobackup, TaskZip, Compara-
tor, Rapid Backup Beta I, and Backup4all. 

How to protect backup files? 
Here are some suggestions to protect your backup files. 
  The backup files should be protected with a password. 
  The backup files should be placed away from a computer having original files. 
 You should make more than one copy and place them at separate places. 

 
9.5  Recovery tools 

If data is not backed up properly and lost due to any reason, it can be recovered using 
recovery software. A few examples of data recovery software are R-Data Recovery Studio 
5.0, Restorer Ultimate Data Recovery 5, R-Undelete 4.0, Virtual Lab Data Recovery 
Software, and PC Inspector File Recovery. 

Backup methods 

The four backup methods are full backup, incremental backup, differential backup, 
mirror backup, and Online backup. There are three factors that help in deciding which 
method to choose. 

• The storage capacity of the backup media. 
• The period of lime available for backup. 
• The level of urgency when a file is restored. 

1. Full backup method:  
In this method, the entire data on the hard disk is copied. It is done on a weekly or 

monthly basis. Each full backup contains the entire copy of the data. 
2. Incremental backup method:  

In this method, only the files that have modified since the last full backup are copied. 
Backup levels are used to distinguish between different types of backups. A level 0 is a full 
backup. A level 1 incremental means backing up everything that has modified since the last 
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level 0. A level 2 incremental means backing up everything that has modified since the last 
level 1, and so on. 
 

3. Differential backup method:  

In this method, all files that have modified since the last full backup are copied. 
Backup levels are used to distinguish between different types of backups. A level 0 is a full 
backup. A level I differential means backing up everything that has modified since the last 
level 0. A level 2 differential means backing up everything that has modified since the level 0 
and so on. 

4. Mirror backup method: 
 In this method, selected files and folders are copied without any compression. It 
keeps all the individual files separate in the destination. That is, the destination becomes a 
mirror of the source. 

 
5. Online backup 

Online backup refers to the copying of data (files, folders, or the entire contents of a 
hard disk) to some other computer on the Internet for online storage. The other computer 
acts as a remote backup. If you lose any file from the original computer, you can connect to 
the computer on the Internet and restore that file. Examples of online backup software are 
Back2zip 2.0 beta and Sync Back. 

9.6 Hacker and Cracker: 
Hacker is a term used for a computer enthusiast, i.e., a person who enjoys learning 

programming languages and computer systems and can often be considered an expert on the 
subject.  

Cracker is a term used to refer to an individual who gains unauthorized access a 
computer system for the purpose of stealing and corrupting data.  
 
Information Security Provisions in E-commerce 

The information security system in e-commerce should meet the following 
requirements. 

Privacy:  

No unauthorized person should be able to access the information. 

Authentication of sender and recipient: 
 Both sender and recipient must prove their identities to each other. 

Integrity and non-repudiation:  
The information must not be tampered with and there should be a proof that the 

information is intact. 
Secure Sockets Layer (SSL) is a protocol used for secure data transmission across the 

network. It is an integrated part of most web browsers and web servers. It plays a very 
important role in the e-commerce activity on the web.   SSL makes use of the following. 
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Public and private key encryption:  
Privacy of information is handled by encryption. Encryption is the process of 

modifying data so that unauthorized users cannot read it. Decryption is a process of 
converting encrypted data into a human-readable format. This method solves the problem by 
creating a set of two different keys called a key pair. While one of the two keys is used to 
encrypt the data, the other can be used to decrypt it. The two keys in a key pair are as 
follows. 

Private key:  

Only the owner knows a private key. 

Public key: 

 It is distributed to any user who requests it. 

Digital certificate:  
A digital certificate is a kind of digital code or credential that authenticates the 

identity of the server. It is signed by an independent, recognized, and mutually trusted third 
party to ensure its validity. The signer of the digital certificate is known as Certificate 
Authority (CA). Some examples of Certificate Authority are Verisign, digicert, COMODO, 
Entrust, and GlobalSign. A digital certificate typically includes the following information 
regarding its owner and CA that issues it. 

• The name of the owner, its e-mail address, and URL of the web server using the cer-
tificate. 

• The owner's public key. The public key can be used to encrypt sensitive information for 
the certificate holder. 

• The name of the CA that issues the certificate. 
• A serial number 
• The validity period of the certificate (a start and an end date). 
• The digital signature of CA, so that any tampering with the contents is easily detected. 

 

Example of an e-commerce transaction: 

Suppose Alina wants to buy a portable music player online. 

1. Alina's computer is connected to the Internet, She opens the web browser Internet Ex-
plorer and types the address www.ebay.com in the address bar and presses ENTER. 

2. The web server responds by sending Alina's computer its digital certificate, which in-
cludes its public key 

3. The web browser verifies the digital certificate of the web server. Basically, it checks 
the digital signature  to CA and expiration date. If any abnormalities are found, a 
dialog box will pop up with an alert. Otherwise, it proceeds with the secure 
connection. 

4. The browser will generate a one-Lime, unique session key. It encrypts the session key 
with the public key and sends it to the web server. 

5. The web server decrypts the encrypted session key using the private key and gets the 
session key. Mow, both have a copy of the session key. 

6. Both parties, Alina's web browser computer and the web server, identify each other. 
Any further communication is confidential and sample proof. 
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When Alina chooses the desired product and proceeds to buy it, the following is ob-
served. 

 The URL of the website now starts with https: instead of http 
 A lock icon appears after the address bar of the browser, as shown in the 

following figure, indicating that the browser is now in secure mode. When the 
browser is running in normal mode, this icon does not appear. 

 
MEMORY BYTES 

 Viruses are of five types; program/file infector virus, macro virus, multipartite 
virus, polymorphic virus, and stealth virus. 

 A virus attaches itself to an executable file and infects the computer when this file 
is run. 

 A computer worm can spread without human action. 
 A Trojan horse does not reproduce by infecting other files (like viruses) or by self 

replicating (like worms). 
 Antivirus software can be used to detect and remove malicious programs such as 

viruses, worms, and Trojan horses. 

 Viruses, worms, Trojan horses, and spyware are examples of malware. 
 Files can be backed up by simply copying and pasting them or by using the built-

in backup utility in Windows XP. 
 The four backup methods are full backup, incremental backup, differential 

backup, 
and mirror backup. 

 The information security system in e-commerce should meet the following 
requirements: privacy, authentication of sender and recipient, and integrity and 
non-repudiation. 

 SSL makes use of public and private key encryption and digital certificates 
 

9.7 Summary: 
o A program that attaches itself to other programs in order to alter their 

behavior, often in a harmful way 
o A program capable of reproducing and spreading itself to another computer 

system, usually by means of a computer network 
o A program that appears useful at first, but is actually programmed to pass the 

user's data or access rights to someone else 
o A program designed to detect and remove malicious programs, i.e., viruses, 

worms, and Trojan horses 
o Computer program that secretly gathers information about the user and relays 

it to advertisers or other interested parties 
o A computer enthusiast, i.e., a person who enjoys learning programming 

languages and computer systems and can often be considered an expert on the 
subject 

o An individual who gains unauthorized access to a computer system for the 
purpose of stealing and corrupting data 

o The process of modifying data so that unauthorized users cannot read it 
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Try yourself? 
1. How is a virus different from a worm? 
2. What is necessary in order for antivirus software to be effective? 
3. What is spam? List its disadvantages and the methods by which one can avoid it. 
4. Why is backup required? How can backup files be protected? 
5. Explain the four backup methods. 
6. Differentiate between hacker and cracker. 
7. What are the requirements of security in e-commerce? 
8. What information does a digital certificate include? 
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MODEL ANSWER CHAPTER WISE 
 
Chapter – I Knowing Computer 
Model Answers 

1. CPU 
2. Memory 
3. Mouse 
4. Random Access Memory 
5. 1024 Kilobytes 

 
Chapter - 2 Operating Computer Using GUI Based Operating System  
Model Answers 
Answer 1 Control paned holds a group of tools that help to change the Software and 
Hardware settings. 
Answer 2 Recycle bin is an area which usually holds deleted files until it reaches a user 
configurable percentage of a disk’s capacity. At that point it discards them. It can be open up 
to restore something which had been thrown away earlier. 
Answer 3 Right click on the blank area in desktop and choose properties. With the help of 
screen saver tab one can set the desires screen saver, Set the timing, assign a password for the 
screen saver to protect your files. To change the settings of the screen save you can use the 
settings options. 
Answer 4   

1. In the window explorer, select New Option from File menu. 
2. Select Folder option from the submenu. 
3. Type a name for the new folder and then press enter. 

Answer 5 Character map is used to insert special characters into a document. 
Answer 6 Disk Defragmenter is used to rearrange files and unused space on the disk. 
 
Chapter-03 Understanding word processing 
Model Answers: 

1. See Section 3.2.1 
2. See section 3.4.6 
3. It provides shortcuts for menu commands. 
4. See Section 3.4.1  
5. See Section 3.3.2 

 
Chapter-04 Using Spread sheet 
Model Answers: 

1. Status line 
2. Range  
3. Range function 
4. Cell address 
5. Control panel 
6. Value 
7. Operating Mode 
8. Formula  
9. Active Cell 

 
Chapter 5 Communication using the Internet 
Model Answers 
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Answer1 The topologies used in LAN are Bus, Ring, Star 
Answer 2 refer 5.2.1 
Answer 3 refer to 5.3.3 

 
Chapter  06 Www and Web Browser 
Model Answers 
Answer 1. A website is one or more web pages that relate to a common theme, such as a 
person, business, organization, or a subject, such as sports. 
Answer 2. Browsing Software like Internet Explorer or Netscape can be used to access 
valuable information present in the computers worldwide. 
Answer 3.  Refer  to 6.6.1 
 
Chapter 7 Communication and collaboration 
7.7 Model Answers 
1. See Section 7.3.4 
2. See Section 7.3.6 
 
Chapter-08 Making Small Presentations 
Model Answers: 
Answer 1:Power Point offers a variety of ways to create a new presentation. You can create 
the presentation that contains no colours or style when predefined slide and title masters. 
Colour schemes and graphics elements are saved in a presentation file; it is called a 
presentation template. A presentation template includes masters with preformatted fonts and 
styles. 
Answer 2:To create a blank presentation: 
 Select the New option from the File menu. A new presentation dialog box is 

displayed. 
 Select the General tab an double click on the Blank Presentation icon  
 Enter the file name. 
 Create Presentation 
 Click on the Save button. 

Answer 3:To specify the zoom percentage: 
 Select the zoom option from the view menu. 
 Select the percentage 
 Click on the OK button 

 
Chapter 9 Antivirus Technology 
Model Answer 

1. Please refer 9.1 and 9.2   
2. Please refer 9.3  
3. Please refer 9.3  
4. Please refer 9.4 
5. Please refer 9.5 
6. Please refer 9.6 
7. Please refer 9.6 
8. Please refer 9.6 
9. Please refer 9.6 

 
 




